
ADAM ENGST 

. 
. . 

FOR WINDOWS & MACINTOSH 



VISUAL QUICKSTART GUIDE 

... 

Eudora 
FOR WINDOWS & MACINTOSH 

Adam C. Engst 

0 Peachpit Press 



Visual QuickStart Guide 

Eudora for Windows & Macintosh 
Adam C. Engst 

Peachpit Press 
1249 Eighth Street 
Berkeley, CA 94710 
(510) 548-4393 
(510) 548-5991 (fax) 

Find us on the World Wide Web at: http://www.peachpit.com/ 

Peachpit Press is a division of Addison Wesley Longman 

Copyright© 1997 by Adam C. Engst 

Cover design: The Visual Group 

Notice of rights 
All rights reserved. No part of this book may be reproduced or transmitted in any form or 
by any means, electronic, mechanical, photocopying, recording, or otherwise, without 
prior written permission of the publisher. For more information on getting permission 
for reprints and excerpts, contactTrish Booth at Peachpit Press. 

Notice of UabiUty 
The information in this book is distributed on an "As is" basis, without warranty. While 
every precaution has been taken in the preparation of this book, neither the author nor 
Peachpit Press shall have any liability to any person or entity with respect to any loss or 
damage caused or alleged to be caused directly or indirectly by the instructions contained 
in this book or by the computer software and hardware products described herein. 

Trademarks 
Eudora is a registered trademark and Eudora Pro and Eudora Light are trademarks of 
QUALCOMM Incorporated. 

Throughout this book trademarked names are used. Rather than put a trademark symbol 
in every occurrence of a trademarked name, we state we are using the names only in an 
editorial fashion and to the benefit of the trademark owner with no intention of infringe
ment of the copyright. 

ISBN: 0-201-69663-0 

0 9 8 7 6 5 4 3 2 

Printed and bound in the United States of America 

0 Printed on recycled paper 



Dedication 
To my grandparents, Bernard and Estelle 
Deutsch, for whom I set up an elderly . 
Macintosh SE/30 with Eudora Light when I 
was starting this book. Since then, they've 
become email aficionados, communicating 
regularly via email with the rest of our family. 

About the author 
Adam Engst is the editor and publisher of 
TidBITS, one of the oldest and largest Internet
based newsletters, distributed every week to 
hundreds of thousands of readers. He has 
written and co-authored numerous Internet 
books and magazine articles, including the 
best-selling Internet Starter Kit series. In addi
tion, he has collaborated on several Internet 
educational videos and has appeared on a 
variety of nationally broadcast television and 
radio programs. He has yet to be turned into 
an action figure. 

Adam graduated from Cornell University 
with a double major in Hypertextual Fiction 
and Classics. He lives on a mountain in the 
Pacific Northwest with his wife Tonya and a 
dedicated Internet connection. 

Please send any comments regarding this 
book to Adam at: eudora-vqs@tidbits.com 

Other books 
by Adam Engst 
The Official AT&.T WorldNetWeb Discovery Guide 

Internet Starter Kit for Macintosh, 4th Edition 

Internet Starter Kit for Wmdows 9 5 

Simply Amazing Internet for Macintosh 

Internet Starter Kit for Windows, 2nd Edition 

Internet Explorer Kit for Macintosh 



Acknowledgements 
No computer book is the work of a single person 
these days, and I had able assistance from numer
ous people while working on this book. Some of 
the most helpful were: 

Tanya Engst, who is not only my wonderful wife, 
but also a great copy editor. 

Nancy Davis, my editor at Peachpit, who made 
great comments and was utterly relaxed. 

David Rogelberg of Studio B, my agent, who made 
this book a reality. 

Steve Domer, for writing Eudora. 

Pete Resnick, Gary Nash, john Noerenberg, and 
everyone else at Qualcomm for answering ques
tions about current and future versions of Eudora. 

Colophon 
I wrote this book using the following pieces 
of software: 

• The Macintosh and Windows versions of 
Eudora Light and Eudora Pro (of course!) 

• QuarkXPress 3.32 (the page layout beast) 

• Snapz Pro 1.0.1 and Snagit/ 3 2 4. 0 (for Mac 
and Windows screenshots) 

• clip 2 gif 0.7. 2 (for screenshot conversions) 

In terms of hardware, I rely on: 

• A Power Macintosh 85 00 I 15 0 with a pair 
of 20-inch color monitors (he who dies 
with the most pixels wins) 

• A no-name Pentium 150 running Windows 
9 5 (it works) 

• A dedicated 5 6K frame relay connection to 
the Internet (watch out, they're addictive) 

People 
Book Design: Adam Engst 

Editor: Nancy Davis 

Copy Editor: Tonya Engst 

Index: Rebecca Plunkett 



TABLE OF CONTENTS 
Introduction 

Chapter 1: Eudora Basics 

xi 

1 
Hardware and software requirements ........... 2 
Getting Eudora ............................ 3 
Installing Eudora . . . . . . . . . . . . . . . . . . . . . . . . . . . 4 
Launching and quitting Eudora ................ 6 
Configuring Eudora ........................ 7 
Configuring Eudora for multiple people ......... 8 
Configuring Eudora Pro for multiple accounts . . . 1 0 
RAM requirements . . . . . . . . . . . . . . . . . . . . . . . . 11 
Official help resources . . . . . . . . . . . . . . . . . . . . . 1 2 
Unofficial help resources . . . . . . . . . . . . . . . . . . . 13 
Email glossary . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14 

Chapter 2: Creating Messages 17 
Creating a new message . . . . . . . . . . . . . . . . . . . . 18 
Replying to a message. . . . . . . . . . . . . . . . . . . . . . 19 
Replying to part of a message ................ 2 0 
Replymg to all recipients .................... 21 
Forwarding a message ...................... 2 2 
Redirecting a message ...................... 2 3 
Sending a message again .................... 24 
Using the recipient list ..................... 25 
Turbo redirecting a message ................. 2 6 
Creating a stationery message ................ 2 7 
Creating a new message using stationery ....... 2 8 
Replying to a message using stationery ......... 2 9 

Chapter 3: Writing Messages 31 
Addressing messages ....................... 3 2 
Choosing a personality ..................... 3 3 
Entering a subject ......................... 34 
Text selection and navigation . . . . . . . . . . . . . . . . 3 5 
Entering text . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3 6 
Editing text . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3 7 
About message plug-ins .................... 3 8 
Spell checking ............................ 3 9 
Spell checking options . . . . . . . . . . . . . . . . . . . . . 41 

v 

~ > • ... 
lit 

0 ... 
a z 
~ 
lit z 

= 



I!! z 
Ill .... z 
8 ... 
0 
Ill .... 
Ill 
-~ .... 

Table of Contents 

vi 

Formatting text ........................... 4 2 
Changing the font ......................... 43 
Changing font styles ....................... 44 
Changing font colors ...................... 45 
Changing font sizes ........................ 46 
Changingjustification ...................... 47 
Changing indents ......................... 48 
About signatures .......................... 49 
Creating and using signatures ................ 50 
Custom signatures ......................... 51 
Editing signatures . . . . . . . . . . . . . . . . . . . . . . . .. 52 
About attachments ........................ 53 
Attaching files via dialog box ................ 54 
Attaching files via drag-and-drop ............. 55 
Attachment formats ....................... 56 
Outgoing message tool bar menus ............. 57 
Outgoing message tool bar buttons ............ 58 
Pure Voice plug-in ......................... 59 
PGP plug-in .............................. 60 

Chapter 4: Sending and Receiving Messages 61 
Sending queued messages ................... 6 2 
Sending messages immediately ............... 63 
Sending messages at a later date or time ........ 64 
Preventing a message from being sent ......... 65 
Checking for incoming messages ............. 66 
Checking for incoming messages periodically ... 6 7 
About messages left on the server ............. 68 
Leaving mail on the server .................. 69 
Retrieving only small messages ............... 7 0 
Special mail transfer options . . . . . . . . . . . ...... 71 

Chapter s: Working with Messages 73 
Selecting messages ........................ 7 4 
Opening messages ......................... 7 5 
Changing message priority .................. 7 6 
Changing message labels .................... 7 7 
Changing message status .................... 7 8 
Changing message personality ............... 7 9 
Changing message text ..................... 80 
Revealing boring headers ................... 81 
Navigating within messages ................. 82 
Navigating between messages ................ 83 
Visiting URLs ............................ 84 
Deleting messages ......................... 8 5 



Table of Contents 

Transferring messages to mailboxes ........... 86 
Opening attachments ...................... 8 7 
Moving attachments ....................... 88 
Deleting attachments ....................... 8 9 
Saving messages .......................... 9 0 
Printing messages . . . . . . . . . . . . . . . . . . . . . . . . . 91 

Chapter 6: Working with Mailboxes 93 
Opening mailboxes ........................ 94 
Sorting messages in a mailbox ............... 9 5 

. Different types of sorts ..................... 96 
Creating mailboxes ........................ 9 7 
Transferring messages into mailboxes .......... 98 
Creating a mailbox during a message transfer .... 99 
Creating mailbox folders using menus ........ 100 
Creating mailbox folders in 

the Mailboxes window . . . . . . . . . . . . . . . . 1 0 1 
Opening and closing mailbox folders ......... 1 02 
Renaming mailboxes and mailbox folders ..... 103 
Reorganizing mailboxes and folders . . . . . . . . . . 1 04 
Deleting mailboxes and mailbox folders ....... 1 OS 
Compacting mailboxes .................... 1 06 
Eudora and aliases . . . . . . . . . . . . . . . . . . . . . . . . 1 0 7 
Being a pack rat .......................... 108 
Taking out the trash ...................... 109 

Chapter 7: Working with Filters 111 
Creating filters . . . . . . . . . . . . . . . . . . . . . . . . . . 11 2 
Selecting messages to filter . . . . . . . . . . . . . . . . . 113 
Header lines . . . . . . . . . . . . . . . . . . . . . . . . . . . . 114 
Contains menu . . . . . . . . . . . . . . . . . . . . . . . . . . 115 
Filter actions . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11 6 
Activating filters . . . . . . . . . . . . . . . . . . . . . . . . . 11 7 
Filter ideas . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11 8 
Finding filters . . . . . . . . . . . . . . . . . . . . . . . . . . . 11 9 
Modifying filters . . . . . . . . . . . . . . . . . . . . . . . . . 1 2 0 
Reordering fllters . . . . . . . . . . . . . . . . . . . . . . . . 1 2 1 
Deleting filters . . . . . . . . . . . . . . . . . . . . . . . . . . 1 2 2 

Chapter 8: Finding and Searching 123 
Finding text in a message .................. 124 
Se¥ching for text in a mailbox. . . . . . . . . . . . . . 1 2 6 
Searching for text in a mailbox folder. . . . . . . . . 1 2 7 
Searching in multiple mailboxes ............. 128 
Searching for text in message summaries ...... 13 0 
Searching tips and tricks . . . . . . . . . . . . . . . . . . . 13 1 

vii 



Table of Contents 

viii 

Chapter 9: Working with the Address Book 133 
Creating nicknames for individuals ........... 134 
Creating group nicknames ................. 13 5 
Nickname tips. . . . . . . . . . . . . . . . . . . . . . . . . . . 13 6 
Using the Address Book window ...... ~ ..... 13 7 
Adding nicknames to messages .............. 13 8 
Multiple nicknames files ................... 13 9 
Finding nicknames ....................... 140 
Modifying nicknames. . . . . . . . . . . . . . . . . . . . . 141 
Managing your recipient list ................ 142 
Deleting nicknames . . . . . . . . . . . . . . . . . . . . . . 143 

. Chapter 10: Working with the Toolbar 145 
Turning the toolbar on and off. . . . . . . . . . . . . . 146 
Tool bar settings. . . . . . . . . . . . . . . . . . . . . . . . . . 14 7 
Default toolbar functions . . . . . . . . . . . . . . . . . . 148 
Adding a button to the toolbar . . . . . . . . . . . . . . 149 
Button ideas . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15 1 
Moving toolbar buttons . . . . . . . . . . . . . . . . . . . 15 2 
Deleting toolbar buttons ................... 153 
Changing button functions ................. 154 

Chapter 11: Using Directory Services 155 
Setting up Ph and Finger. . . . . . . . . . . . . . . . . . . 15 6 
Selecting another Ph server . . . . . . . . . . . . . . . . . 1 57 
Searching a Ph server . . . . . . . . . . . . . . . . . . . . . 15 8 
Using the results of a Ph search ............. 159 
Searching a Finger server . . . . . . . . . . . . . . . . . . 160 
Online directories on the Web . . . . . . . . . . . . . . 161 

Chapter 12: Working with Settings/Options 163 
Getting Started . . . . . . . . . . . . . . . . . . . . . . . . . . 1 64 
Personal Information . . . . . . . . . . . . . . . . . . . . . 165 
Hosts .................................. 166 
Checking Mail. . . . . . . . . . . . . . . . . . . . . . . . . . . 167 
Sending Mail ............................ 168 
Attachments . . . . . . . . . . . . . . . . . . . . . . . . . . . . 169 
Fonts & Display . . . . . . . . . . . . . . . . . . . . . . . . . . 1 7 0 
Toolbar . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1 7 1 
Eudora Labels/Labels . . . . . . . . . . . . . . . . . . . . . 1 7 2 
Getting Attention . . . . . . . . . . . . . . . . . . . . . . . . 1 7 3 
Extra Warnings . . . . . . . . . . . . . . . . . . . . . . . . . . 1 7 4 
Replying . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1 7 5 
OT /PPP and MacSUP I Advanced Network .... 17 6 
MovingAround .......................... 177 



Table of Contents 

Miscellaneous . . . . . . . . . . . . . . . . . . . . . . . . . . . 1 7 8 
Settings Icons . . . . . . . . . . . . . . . . . . . . . . . . . . . 1 7 9 
Mailbox Columns ........................ 180 
Styled Text . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 181 
Personalities and Personality Extras. . . . . . . . . . . I 8 2 
Spell Checking .......................... 183 

Index 185 

Keyboard Shortcuts 

ix 

~-

= ... 
Ill 

0 
11ft 

s 
z 

= z .... 
1ft 



• 

INTRODUCTION 
Welcome to the Visual QuickS tart Guide for 
Eudora, one of the most popular and power
ful Internet email programs. Some eighteen 
million Internet users, myself included, rely 
on Eudora every day. 

If you're getting started with Eudora, this 
book will provide you with the information 
you need to become a fluent Eudora user. 

Or, perhaps you're a Eudora fan already and 
want to make the most of Eudora. If so, you 
won't be disappointed. Eudora has a lot of 
power under the hood, and this book brings 
it to the surface. 

What is Eudora? 
Eudora is an email client program. It enables 
you to write and send email, and to receive 
and read email. Eudora has numerous other 
features that enhance these basic capabilities. 

More important, Eudora uses standard 
Internet methods of transferring mail, called 
SMTP and POP (check the email glossary in 
Chapter 1, "Eudora Basics," for definitions). 
As a user, you need not care about specific 
protocols; what you should realize is ~hat you 
can use Eudora with almost any Internet ser
vice provider and many corporate networks. 
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Introduction 

About Eudora ... 
Eudora was the brainchild of a programmer 
named Steve Dorner, then working at the 
University of Illinois at Urbana-Champaign. 
Early versions of Eudora were free from the 
University of Illinois, but in 1992, Steve 
joined Qualcomm, a large company primarily 
focused on wireless communications. At 
Qualcomm, Steve continued to enhance 
Eudora. Qualcomm soon created two ver
sions, Eudora light and Eudora Pro. 

Eudora light is essentially a stripped-down 
version of Eudora Pro, but for many people, 
Eudora light offers sufficient power and flex
ibility. The other significant difference is that 
Eudora light is completely free, whereas 
Qualcomm sells Eudora Pro for prices 
ranging from $50 to $90, depending on the 
vendor. 

Most people start with Eudora light because 
it's good and it's free. After a while, if you 
receive a lot of email, you start to think that 
the additional features in Eudora Pro would 
be handy, which is how Qualcomm entices 
people to upgrade to the commercial version. 

The current versions of Eudora are 3.1 on the 
Mac and 3. 0 on Windows (see Figure 1 
through Figure 4 for the About Eudora dialog 
boxes), and those are the versions I cover in 
this book. However, Steve and the other pro
grammers working on Eudora are sensitive 
about making changes to a program that so 
many people use regularly, so I'm confident 
that the information in Litis book will apply 
to future versions of Eudora as well. 

II Tip 

• Steve Dorner named Eudora after the 
writer Eudora Welty, specilicilly because 
of her story "Why I live at the P.O." It's 
"Z>n the Web at http://www.torget.se/ artbinT 
art/ or_weltypostoff.html. ' 
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WINDOWS ONLY! 

Introduction 

Macintosh and 
Windows differences 
Eudora is one of the best oftoday's breed of 
programs that provide extremely similar 
interfaces and features in the Macintosh and 
Windows versions of the program. 

Unfortunately, human interface requirements 
on the Mac and Windows differ, so, in a few 
places, Eudora's programmers were forced to 
ttade consistency between the platforms for 
following the appropriate human interface 
guidelines for each platform. 

Deali.ng with differences 
• If there is no difference between the Mac 

and Windows versions of Eudora for a 
specific feature, I make no explicit com
ment either way. 

• If a dialog box, window, or settings panel 
simply has a different name on the differ
ent platforms, I separate the names with a 
slash, putting the Mac name first, as in 
"Open the Settings/Options dialog box." 

• If a difference is minor, I build it into the 
discussion, as in "Choose Filters from the 
Special menu {Mac) or Tools menu 
{Windows)." 

• If a difference is major, I either write sepa
rate steps for that task or devote separate 
pages to each platform, clearly marking 
each page with a "Macintosh Only!" or 
"Windows Only!" graphic. 

• I alternate between Mac and Windows 
screen shots throughout the book to illus
trate features appropriately. For brevity's 
sake, I don't label them explicitly-! 
assume Mac users can recognize a Mac 
screen shot and Windows users can recog
nize a Windows screen shot. 
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Introduction 

Eudora Light and 
Eudora Pro differences 
As I noted before, Eudora Light is essentially a 
stripped-down version of Eudora Pro. Many 
of the high-end features in Eudora Pro don't 
exist in Eudora Light or are present in a lim
ited fashion. 

Dealing with differences 
• When I refer to the program generically, I 

just call it Eudora. However, when I wish 
to distinguish between Eudora Light and 
Eudora Pro, I use the full specific name. 

• If there is no difference between Eudora 
Light and Eudora Pro for a specific feature, 
I make no explicit comment either way. 

• If Eudora Pro has some minor additional 
feature, such as a menu with an additional 
item or a unique shortcut, I either include 
a parenthetical, as in "(Pro only)," or 
write a separate tip or comment dis
cussing that feature. 

• When Eudora Pro offers a major feature 
that's not in Eudora Light, I devote a sepa
rate page to that feature, clearly marking 
the page with a "Eudora Pro Only!" 
graphic. 

• I use Eudora Pro, so all the screen shots in 
the book come from Eudora Pro. I believe 
it's better for Eudora Light users to see 
what they're missing than to confuse 
Eudora Pro users with shorter menus and 
other missing interface items. 

xiv 



The unnecessary details 
_.This 'book covers all the features of Eudora. 
: _that ypu;reJikelyto use in normal situa
·tic>~~ Itdoes not delve into the trUly ·geeky 
· ways in whl,ch you can customize Eudora 

usi:hgAppleScript (Mac), editing_ your 
Eudora Settings file using Apple's ResEdit 

· (Mac) or by editing your eudora.ini flle 
. · ;(W"mdows). 

·· ~~ (l4,fijtio~ flexibility can be useful, 
butfew Bit<l9ra users ever need it. Ifyou 
.,qo, mC>.t~ i¢'onnation is available from 

, -~~:\lll~filci~help ~esources listed in· 
·qhipt~.Ji~ .. 'fEjl(lo~ :Basics." 

Introduction 

How to use this book 
If you've never used a Visual QuickStart Guide 
from Peachpit Press (there are dozens of 
them, covering most major software packages 
and numerous other topics), I think you'll 
enjoy this book. 

Unlike more traditional computer books, 
Visual QuickStart Guides focus on specific 
tasks, with screen shots parallel to the tasks 
being explained so you can easily follow 
along. Most tasks are simple and take only a 
few steps and a single page. 

When a topic doesn't lend itself to step-by
step instructions, a Visual QuickStart Guide 
includes a clearly written list of possibilities 
rather than paragraph upon paragraph of 
explanatory text. 

You may want to read the book from front to 
back. This method is probably the best for 
beginners. I've organized both the chapters in 
the book and the topics within each chapter 
in the order you're likely to experience them. 
So, for instance, in the chapter about Eudora's 
Filters, I work through creating filters. activat
ing filters, ideas on using the filters you've 
created, finding filters, modifying filters, and 
deleting filters. 

Alternately, if you're more of an experienced 
Eudora user, open to the Table of Contents 
and look for the task you're interested in per
forming. Once you've used the book for a 
while, you can probably just flip through the 
pages of the appropriate chapter-I've found 
myself doing that with other Visual 
QuickStart Guides . 

XV 
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Introduction 

Why I wrote this book 
I was thrilled when Peachpit Press 
approached me about writing this book. I've 
written numerous books about the Internet 
before, but none about a specific program. 
The Internet is a huge topic to cover, whereas 
delving into the inner workings of a single 
program is rather a different task. 

And what a program! We all have our favorite 
programs, and Eudora ranks right up there 
for me. Eudora launches at startup on both 
my Mac and my PC, and it's always available, 
sending and receiving mail automatically 
throughout every working day. I receive 
between I 00 and 200 messages each day, and 
I send about 50 messages a day. In addition, I 
save a fair amount of my incoming mail and 
all outgoing messages, so I have over 200 
megabytes of stored messages covering the 
last few years of my life. 

In short, I rely heavily on Eudora. I've looked 
at numerous other email programs over the 
years, and nothing has come close to provid
ing Eudora's power and ease-of-use when 
dealing with that amount of mail. 

I hope my enthusiasm for Eudora comes 
through in this book, and even more impor
tant, I hope that you find this book an enjoy
able and useful adjunct to Eudora itsel£ Let's 
start exploring! 
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EUDORA BASICS 
In this chapter, I introduce some of the basics 
of Eudora and email that will help you make 
the best use of the rest of the book. 

We'lllook at the hardware and software 
requirements for using Eudora to ensure that 
you can run Eudora on your computer. In 
case you don't have the latest version of 
Eudora, I'll also explain how to get a copy. 

Once you have Eudora installed, we'll take a 
quick look at how you set up Eudora for basic 
use. The rest of the book e>.:plains how you 
use the program in much more depth, of 
course, but just in case, I'll show you where 
to find even more help on the Internet. 

Finally, so you don't become overwhelmed 
with the terminology, this chapter includes a 
short email glossary as well. 

Come then, and let's start exploring Eudora. 
Once you 've read this chapter, feel free to flip 
around in the book for the specific pieces of 
information that you need. · 



Chapter 1 

Hardware and 
software requirements 
Eudora has fairly · . 1 . mmuna hardware and soft-
ware requirements. 

Macintosh requirements 

• A Macintosh Plus or later model with 
high-density disk drive if you p~chas: 
Eudora Pro on floppy disk. 

• Macintosh System 7.0 or later. 

• An email account with an Internet service 
provider or one that's accessible via an 
Internet-capable network connection. 

• Some non-essential features of Eudora rely 
on additional software called Macintosh 
Drag and Drop. It was included in System 
7 Pro and all versions of the system soft
ware after System 7.5, but not in earlier 
versions of System 7. The easiest way to 
get drag-and-drop capabilities is to 
upgrade to the latest version of Apple's 
system software that's appropriate for 
your Mac. Consult your Apple dealer, but 
note that Mac OS 8 is appropriate for 
68040- and PowerPC-based Macs. 

Windows requirements 
• ffiM-compatible PC. 

• Microsoft Windows 9 5 or Windows NT 
3.51 or later for the 32-bit version of 
Eudora. You can use Microsoft Windows 
3.1 with the 16-bit version ofEudora, but 
it will look and act slightly differently 
from the 32-bit version covered here. 

'insock 1 .1 networking package (the 
-:rosoftTCP liP networking included in 

iows 95 is ideal). 

ill account with an Internet service 
·or one that's accessible via an 
~apable network connection. 
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Older Macintosh co~p-U®'S might be~ ... 
niilg System 6. If thai's true, and if . · · 
upgrading to System 7 i$n•t feasible (it : 
requires at least 4MB of RAM). you can 
download and use Budora 1.3.1 for free. 
n·s not nearly: as capable as current ver
sions of Eudora Light or Budora Pro. but 
·Eudora 1.3.1 works fine on ·those older 
machines, assuming that they can connect 
to the. Internet. If you do use Eudora 1.3 ~ 1. 
be aware that ttlany featul:'es c:liscu.ssed in 
this book won•t be availapl~ · 



EUDORA BASICS 
In this chapter, I introduce some of the basics 
of Eudora and email that ·will help you make 
the best use of the rest of the book. 

We'lllook at the hardware and software 
requirements for using Eudora to ensure that 
you can run Eudora on your computer. In 
case you don't have the latest version of 
Eudora, I'll also explain how to get a copy. 

Once you have Eudora installed, we'll take a 
quick look at how you set up Eudora for basic 
use. The rest of the book explains how you 
use the program in much more depth, of 
course, but just in case, I'll show you where 
to find even more help on the Internet. 

Finally, so you don't become overwhelmed 
with the terminology, this chapter includes a 
short email glossary as well. 

Come then, and let's start exploring Eudora. 
Once you've read this chapter, feel free to flip 
around in the book for the specific pieces of 
information that you need. 

1 
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Chapter 1 

Hardware and 
software requirements 
Eudora has fairly minimal hardware and soft
ware requirements. 

Macintosh requirements 
• A Macintosh Plus or later model, with a 

high-density disk drive if you purchase 
Eudora Pro on floppy disk. 

• Macintosh System 7. 0 or later. 

• An email account with an Internet service 
provider or one that's accessible via an 
Internet-capable network connection. 

• Some non-essential features of Eudora rely 
on additional software called Macintosh 
Drag and Drop. It was included in System 
7 Pro and all versions of the system soft
ware after System 7. 5, but not in earlier 
versions of System 7. The easiest way to 
get drag-and-drop capabilities is to 
upgrade to the latest version of Apple's 
system software that's appropriate for 
your Mac. Consult your Apple dealer, but 
note that Mac OS 8 is appropriate for 
68040- and PowerPC-based Macs. 

Windows requirements 

• IBM-compatible PC. 

• Microsoft Windows 9 5 or Windows NT 
3.51 or later for the 32-bit version of 
Eudora. You can use Microsoft Windows 
3.1 with the 16-bit version ofEudora, but 
it will look and act slighdy differendy 
from the 32-bit version covered here. 

• Winsock 1.1 networking package (the 
Microsoft TCP /IP networking included in 
Windows 9 5 is ideal). 

• An email account with an Internet service 
provider or one that's accessible via an 
Internet-capable network connection. 

2 

I :Macinto$h $yste• :6 . 
I : 

01~~ Macintosh computersnu.·~ ~~· 
Ding System 6. If that's true, mCi if ., 'l · · 
up~ding to System 7 isn't feaSible {i.t ' · 
req'9ll'es at least" 4 MB of RAM), you can 
d~oad and use Eudora 1.3.1. for free. 
-It's hot nearly-as· capable as current~
sio~ of Eudora Ught or Eudora Pro, but 
Euc~f?ra 1.3.1 works fine on those older: .. 
ma~hines, assuming that they~ CODJl,$ 

to ~ein.teniet. If you do use .EY.4ora:·t~a;t~ 
be p that many features disqwed m; 
tbis]hopk w:Pn"t be available,, t 

~ : 



~C! ~ ~.nt.~~"S.t ~xpo r ~ 
M ' ~ I ) ' 'if.~-:: ... :;: . 

• .,.. W!gcr.PJ?U¢•"" 
.... f.denUsJ;!Mwe!!IWtn'Rftw•rr 
,..,. fu<!m,D•!tlno op4 psbcrtpftwt:J&"'!¥*' 

•'). ~Qwwtuc!Jia 

Figure I You can download a copy of Eudora Light or 
a demo of Eudora Pro from the Eudora Web site. 

m 
About Balloon Help ••. 

Show Balloons 

About This Release 

Creating and Sending a Message 
Using Attachments 
Using Signatures 

Recefulng Messeges 
Responding to Messoges 
Chenglng Your Pnuword 

Deleting Messages 
Tn~nsferrlng Messages 
Using MallboHeS 
Filtering Messages 

Using the Address Book 

Shortcuts 
Sel ecting a UAL Helper 
About Eudora Pro 
More Help II II 
PureUolce Help 

Register Eudora .•. 
Insert Syst em t onflquratlon 

Figure 2 To request a copy of the Eudora Pro ordering 
program in the Mac version of Eudora Light, choose 
Purchasing Information from the Guide menu. 

Figure 3 To request a copy of the Eudora Pro ordering 
program in the Windows version of Eudora Light, 
choose Request Ordering Program from the Eudora 
Pro menu. 

Eudora Basics 

If you don't have the latest version of Eudora 
Light, or if you want to purchase Eudora Pro, 
there are several ways to get a copy. 

Methods of. getting Eudora Light 

• Using a Web browser, go to 
http: I I www.eudora.com/ (Figure 1), follow 
the links to the Eudora Light page, and 
then download a copy. 

• Using a Web browser or an FTP program, 
go to ftp: II ftp.eudora.com/ eudora/ eudoralight/ 
and navigate to the proper Mac or 
Windows folder, where you can down
load a copy. 

Methods of getting Eudora Pro 

• Using a Web browser, go to 
http://www.eudora.com/ and download a 
demo copy that works for 3 0 days. 

• Using a Web browser or an FTP program, 
go to ftp: II ftp.eudora.com/ eudora/ eudorapro/ 
and navigate to the proper Mac or 
Windows folder, where you can down
load a demo copy that works for 3 0 days. 

• If you have Eudora Light, you can request 
an ordering program that you can use to 
fill out an order. 

In the Mac version, choose Purchasing 
Information (Figure 2) from the Guide 
menu (it looks like a question mark). 

In the Windows version, choose Request 
Ordering Program (Figure 3) from the 
Eudora Pro menu. 

• Visit a software store that carries Eudora 
Pro (it might be hard to find in most gen
eral computer stores) or an online soft
ware vendor like Cyberian Outpost at 
http://www.cybout.com/ and buy a copy. 

3 



Chapter 1 

Installing Eudora 
Once you've downloaded or purchased a 
copy of Eudora, you must install it on your 
computer. For the most part, the installation 
process is self-documenting, so I won't dis
cuss every possible step here. 

To install Eudora 

1. Double-click the Eudora installer. 

The installer displays a splash screen, then 
a ReadMe screen, and finally the installa
tion window (Figure 4) . 

2. Select Full Eudora Pro or Full Eudora 
light, and click the Install button. 

The installer first warns you that you'll 
need to restart, then asks if you want to 
install a 680x0, PowerPC, or Universal 
version of Eudora (Figure 5) . 

3. If you use a Power Mac, I recommend you 
click either Power PC or Universal. If you 
use a 68000-based Macintosh, click either 
680x0 or Universal. If you think you'll 
switch between a 68000-based Mac and a 
Power Mac, click Universal. 

The installer presents you with a dialog 
box asking you where you want to store 
the program (Figure 6) . 

4. Select a location for Eudora and click the 
Install button. 

The installer copies all the necessary files 
to your hard disk, then displays a dialog 
box asking you to restart. 

5. Click Restart to restart your Mac. 
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When the Mac restarts, you're ready to use 
Eudora. 

lnstellthe followin g: 
ull rutlmd Pro i.l [!1 

Filler Conuerte r 
Tebles of Contents Conuerters 

Quit I ( tnstell J 

Figure 4 To install Eudora, click Full Eudora Pro 3.1 
(this line may look different for you-l'm installing the 
demo of Eudora Pro 3.1 here) and then click Install. 

D You are running on a PowerPC machine. Some 
appUcatlons to be Ins tolled can be run on both 
PowerPC end 680HO machines. 

Do you wont lo Install the larger Unluersol 
oppllcotlons or the smeller specific ones? 

I 680HO J I PowerPC I f("":u~n~lu~er~so~l '"ill 

Figure 5 The installer asks which version you want 
to install. Click the button that corresponds to your 
desired version. 

~ Folder File Orlue Options 

I ij! Desktop .... ( 

c::oAchllles 
c::oEphemera 
=Perseus 
c::oSisyphus 
c::>Tooster 

lnslall software Into folder: 

I Eudora Pro 3 . 1 Folder 

=Achilles 

Eject 

Oc• klop I 
New CJ I 

I Cancel 

( Install J 

Figure 6 The installer then asks where you want to 
store the Eudora program. Navigate to the desired 
location, then click the Install button. 
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Figure 7 The installer asks where you want to store 
the Eudora program. Either choose the default, or click 
the Browse button and navigate to the desired 
location.When you're done, click the Next button. 

Figure 8 The installer then asks which version of 
Eudora you want to install. If you use W indows 95 
or Windows NT, select the 32-bit version. If you use 
Windows 3.1, select the 16-bit version. Then click the 
Next button. 

Figure 9 Then, the installer presents a summary of 
what it will do. Click the Next button to start copying 
files to your hard disk. 

Eudora Basics 

Installing Eudora 
Once you've downloaded or purchased a 
copy of Eudora, you must install it on your 
computer. For the m ost part, the installation 
process is self-documenting, so I won't dis
cuss every possible step here. 

To install Eudora 

1. Double-click the Eudora installer. 

The installer displays a welcome screen, 
then a license screen, and finally the 
installation window, where it asks you to 
select a location for the Eudora program 
(Figure 7). 

2. If you don't want to store Eudora in the 
default location, click Browse, and select a 
location. Then click the Next button. 

The installer asks which version of Eudora 
you want to install (Figure 8). 

3. If you use Windows 9 5 or Windows NT, 
select the 32-bit version of Eudora and 
click Next. If you use Windows 3. I , select 
the 16-bit version of Eudora and click the 
Next button. 

The installer summarizes what you've 
asked it to do (Figure 9) . 

4. Click the Next button. 

The installer copies all necessary files to 
your hard disk, then displays a dialog box 
asking if you want to read the README 
file. 

5. Click Yes if you want to read the README 
file or No if you don't. Either way, the 
installation process is finished at that 
point. 

5 



Chapter 1 

Launching and 
quitting Eudora 
After you've installed Eudora, the next step is 
to launch the program. 

Launching Eudora (I) 

1. In the Macintosh Finder or the Windows 
desktop, fmd the Eudora icon (Figure 10 
and Figure 11). 

2. Double-dick the Eudora icon to launch 
Eudora. 

Launching Eudora (11-Windows) 

1. From the hierarchical Programs menu 
in the Start menu, choose Eudora 
(Figure 12). 

Quitting Eudora 

1. From the File menu, choose Quit (Mac) 
or Exit (Windows). 

Eudora quiiS, prompting you to send 
queued messages first if you have any 
waiting to go out. 

vTips 
• If you use a Macintosh, I encourage you to 

make an alias to Eudora and place it either 
in your Apple Menu Items folder (so it 
appears in your Apple menu) or on your 
desktop for easy access. 

• If you use Windows, I encourage you to 
make a shortcut to Eudora and place it on 
your desktop for easy access. 

• If you plan to use Eudora all the time, as I 
do, consider putting an alias (Mac) or a 
shortcut (Windows) to Eudora in your 
Startup Items folder (Mac) or your Start 
menu (Windows) . That way, Eudora will 
launch whenever you turn on your 
computer. 
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Figure I 0 To launch the Mac version of Eudora, 
double-dick the Eudora icon in the Finder. 

Figure I I To launch the Windows version of Eudora, 
double-dick the Eudora icon in the Windows desktop. 

Figure 12 Alternately, to launch Eudora in Windows, 
choose Eudora from the hierarchical Programs menu in 
the Start menu. 
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Figure 13 In the Getting Started settings panel, enter 
your real name, POP account, and return address in the 
appropriate fields. 

Figure 14 In the Checking Mail settings panel, check 
the "Send on check" and Save password checkboxes. 

Settings 

~ Gtttftt St.-1M II itt urn llddnn (H crifferent from POP eccount): 
1--•ttdbitt.tOin I 

il!lPw_,l..,""' Dorntln to tdd to u!!•Uned Mma: 

~ ...... I I 
11& _ .... SMTPSt,....r 

I•Htttdbitt.co,. I 
O lmmecfittttend C8]Se:nd onched:: 

~~~ AttJd'mtntl 
~ftxcurlvq..otu 

~ ExPtnd nlcknemn lmme¢1atelv 

A rentt& Obp'-.1 D Autom~liall~o~ rc:eto or1Q1nel mellboX 

Je ........... Stltlonerv: I .... I 
Opttons vhen not u:tlbQ tlttloner\1: 

::l Toolwr ti Sfgnttvre: I Stt nderd I 
C!1:l Ml;r '* Quoted-Prtntab1e ~Wordvnp 

~ 
181Kttpcoptesofottqotnqnll 

00 I Cancel) OK 

Figure IS In the Sending Mail settings panel, uncheck 
the Immediate send checkbox. 

Eudora Basics 

Configuring Eudora 
Now you must enter the minimal infor
mation required to send and receive mail. 
Eudora has many other settings; here I 
cover the essential ones for getting started. 
(See Chapter 12, "Working with Settings/Options") 

To configure Eudora 

1. From the Special menu (Mac) or Tools 
menu (Windows) , choose Settings (Mac) 
or Options (Windows). 

Eudora opens the Settings/ Options dialog 
box with the Getting Started settings panel 
selected (Figure 13). 

2. In the Getting Started settings panel; enter 
your real name in the Real name field, 
then enter your POP account in the POP 
account field, and finally, enter your 
return address in the Return address field. 
Make sure that theTCP/IP button (Mac) 
orWinsock button (Windows) is selected. 

Your Internet service provider or network 
administrator must provide you with your 
POP account and return address. 

3. If your Internet service provider or net
work administrator has directed you to 
enter an SMTP server, switch to the Hosts 
panel and enter the SMTP server in the 
SMTP server field. 

4. Switch to the Checking Mail panel and 
check the "Send on check" and Save pass
word checkboxes (Figure 14). 

5. Switch to the Sending Mail panel, and 
uncheck the Immediate send checkbox 
(Figure 15). 

6. Click the OK button to save your changes. 

-r~m~F~ 
#~,7l£i7 

P?--~ ~/#'. __ L' 

~(l~, 



Chapter 1 

Configuring Eudora 
for multiple people 
What if you and your sweetie share a com
puter but don't want to share an email 
address?You can each create a personal 
Eudora Folder with its own settings. 

To configure 
Eudora for two people 

1. Quit Eudora if it's running. Then, in the 
Finder, open the System Folder and select 
the Eudora Folder. 

2 . From the File menu, choose Duplicate. 

The Finder makes a duplicate of the 
Eudora Folder, called Eudora Folder copy. 

3 . Rename the copy to start with your first 
name, as in Adam's Eudora Folder. 

4. Open the original Eudora Folder. Inside it 
is a file called Eudora Settings. Select that 
file, and from the File menu, choose Make 
Alias to make an alias, called Eudora 
Settings alias. 

5. Rename the alias with your sweetie's 
name, as in Tonya's Email , and move it to 
the desktop. 

6. Repeat steps 4 and 5 with the second 
Eudora Folder. Rename the second Eudora 
Settings file with your name, as in Adam's 
Email (Figure 16). 

7. Double-dick the flrst alias you created to 
launch Eudora. 

8. Configure Eudora with your sweetie's 
email account and settings as discussed on 
the previous page. 

9. Double-dick the second alias you. created 
to launch Eudora~ and repeat step & with. 
your email account cu:d·settings. .. 
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Figure 16 The eventual goal in setting up Eudora for 
two people is to end up with two Eudora Folders, and 
differendy named aliases to the Eudora Settings files 
within those Eudora Folders. Note that here I haven't 
yet moved the aliases to the desktop, and if you don't 
want them on the desktop they can go anywhere else 
that's easily accessed. 

f 

Multiple people using Eudora 

These steps walk you through creating two 

Eudora Folders, each with its own Eudora 
Settings file. You must launch Eudora by 
do~ble-clicking the aliases to those Eudora 
Set~gs files. If you launch Eudora by 
dofble-clicking the program, it loads the 
Eudora Settings file in the folder called 
Eudora Folder in the System Folder. 

Think of those Eudora Settings files as 
Eudora documents. When you double
click the alias to one, you're launching 
Eudora and loading those settings. It's just 
like double-clicking a spreadsheet docu
ment to launch the spreadsheet program 
and open the document. 
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Figure 17 First, create two shortcuts to the Eudora 
application, one fo r each person. 

Figure 18 After you've created two folders, one for 
each person, edit the Target field in the Shortcut 
properties to point at the new folders you've created. 

Multiple people using Eudora 

These steps walk you through creating two 
Eudora Folders, each with completely sep
arate settings and mailboxes. You must 
launch Eudora by double-clicking the 
shortcuts, or else Eudora won't load the 
proper settings. 

Eudora Basics 

Configuring Eudora 
for multiple people 
What if you and your sweetie share a com
puter but don't want to share an email 
address? You can each create a personal 
Eudora Folder with its own settings. 

To configure 
Eudora for two people 

1. In the Windows 9 5 desktop, right-click 
the Eudora program, and from the 
pop-up menu, choose Create Shortcut to 
create a shortcut to Eudora (Figure 17). 

2. Move the shortcut to the desktop and 
rename it with your sweetie's first name, 
as in Tonya's Email. 

3. Repeat steps I and 2, but rename the sec
ond shortcut with your first name, as in 

Adam's Email. 

4. In the C: window, create two folders with 
your first names, as in Tonya's Eudora 
Folder and Adam's Eudora Folder. 

5. Right-click your sweetie's shortcu t, and 
choose Properties from the pop~ up menu. 

6. Click the Shortcut tab, and in the Target 
field, type a space, and then the path to 
your sweetie's folder, as in C:\Tonya's 
Eudora Folder (Figure 18). 

7. Repeat steps 5 and 6 with your shortcut 
and folder. 

8. Double-click your sweetie's shortcut to 
launch Eudora. 

9. Configure Eudora with your sweetie's 
email account as discussed previously. 

10. Quit Eudora. 

11. Double-dick the second shortcu t, and 
repeat step 9 with your email account 
and settings. 
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Chapter 1 

Configuring Eudora Pro 
for multiple accounts 
If you have multiple email accounts, you can 
configure Eudora Pro to work with all of 
them using personalities. 

To configure Eudora 
Pro for multiple accounts 

1. From the Special menu (Mac) or Tools 
menu (Windows). choose Settings (Mac) 
or Options (Windows) to open the 
Settings/Options dialog box. 

2. Click Personalities to display the 

"' 
Personalities settings panel (Figure 19). 

1- 3. Click the New button to create a new z 
::::» personality. 0 v v 4. Enter a name for the personality in the cc 
11.1 Pers. Name (Mac) or Personality _, 

(Windows) field. CL. 
~ _, 

5. Enter the personality's POP account, real ::::» 
~ name, and rerum address in the appropri-
Ill: ate fields. 
0 ....... 

0 6. Check the "Check mail on manual 
Ill: checks" (Mac) or "Check mail" 
0.. 

~ 
(Windows) checkbox. 

0 7. If necessary, in the Windows version, 
Q 
::::» enter the SMTP server in the SMTP 

&&.1 
server field. 

In the Mac version, switch to the 
Personality Extras panel and then enter 
the SMTP server in the SMTP server 
field (Figure 20). 

8. Make any other necessary configuration 
changes in the Personalities and 
Personality Extras (Mac) settings panels. 

9. Click OK to save your configuration for 
that personality. 
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Figure 19 To create a new pe rsonality, click the 
New button, then enter the necessary information in 
the various fields in the Personalities settings panel. 

~ ... , ... 
lt OTIPPP ..,.,.... 

-\> ........ ....... 
~ ,..,._ . ..__ 

~ .. ·--1!1 ..,. ..... .,. ...... 
~ Sb,J\tcll•xt 

~ PtrsOti~Htttf 

Settings 

::.:~:,:-:.- ~olit.tidlrits.com I 
Sttlfonerv· '-· ..:::-=--------'1 
SI9Ntvrt vl'lu b3t usii'IQ stattonerv. 

I Standard 

Figure 20 If you need to set a different SMTP server in 
the Mac version of Eudora Pro, click Pe rsonality Extras 
and 

1
enter it in the SMTP server field. 
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Figure 21 To determine Eudora's proper RAM 
allocation, choose About Eudora from the Apple menu. 
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Figure 22 Eudora opens the About Eudora dialog box. 
Notice that the last line tells you the current and 
minimum memory (RAM) sizes. 
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Figure 23 Bring up the Get Info window by selecting 
the Eudora icon and choosing Get Info from the 
File menu in the Finder. Then, enter the desired RAM 
allocation in the Preferred size field. 

Eudora Basics 

RAM requirements 
The Macintosh versions of Eudora come set 
to require a mere 700K of RAM by default. 
That's not very much, but it is enough for 
most situations. However, if you store a lot of 
messages in your In, Out, and Trash mail
boxes, Eudora's RAM requirements will 
increase. 

To determine RAM settings 

1. With Eudora as the frononost program, 
from the Apple menu, choose About 
Eudora (Figure 2 1). 

Eudora opens the About Eudora dialog 
box. At the bottom, Eudora displays the 
current memory setting and the mini

mum that's required (Figure 22) . 

2. If the two numbers are close (within 
I OOK), you should increase Eudora's RAM 
allocation. 

To increase 
Eudora's RAM allocation 

1. If necessary, quit Eudora, then, in the 
Finder, click the Eudora icon once to 
select it. 

2. From the File menu, choose Get Info 
QCmdl-1) . 

The Finder opens the Get Info window 
(Figure 23). 

3. Enter a new number in the Preferred Size 
field (in System 7.0 or 7 .0 .1, the field is 
called Current Size) . The number should 
be several hundred kilobytes larger than 
what was there before. So, if Eudora was 
set to 1700K, change it to 1900K. 

4. Close the Get Info window by choosing 
Close Window QCmdl-W) from the File 
menu or by clicking the Get Info win
dow's close box. 
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Chapter 1 

Official help resources 
Although this book provides all the infor
mation you need to use Eudora normally, 
special circumstances may send you looking 
for help further afield. 

Official resources for 
additional assistance 

• Eudora has good online help, accessible 
from the question mark-like Guide menu 
(Mac) or the Help window (Figure 24) 
available from the Help menu (Windows). 

• Even better, Eudora has great balloon help 
(Mac) and contextual help (Windows). 

To use balloon help in the Mac versions, 
choose Show Balloons from the Guide 
menu, then point at the item in question 
(Figure 25). 

To access contextual help in the Windows 
versions of Eudora, click the Contextual 
Help button at the right end of the tool
bar, then click the item about which you 
want more information. If you're in a dia
log box, click the question mark button in 
the right hand corner of the dialog, then 
click the item in question, or just right
click the item in question (Figure 26). 

• Eudora comes with a good manual, 
although Eudora Light users must down
load it separately from the program. 
The manual should always be your first 
resource (after this book, of course). 

• Qualcomm provides technical support 
information and answers to frequently 
asked questions on the Web at 
http: I /www.eudora.com/ techsupport/. 

tl Tip 

• In the Mac version of Eudora Pro, press 
the Help key to toggle balloon help on 
and off 
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Figure 24 To open the Help window in the Windows 
versions of Eudora. choose Topics from the Help menu. 
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3 .......... " 18JSt1p~over ~K 
• Attaotmtnts 0 Lnvt on$trver fer c:=J &up 

~~ fot~ts& DUplav 181 Send on ched: 

I! O&t•Dtsp~ 18JSeYe,..,....rd ] .............. 
181 Delete from 3llrver vhen e ~ tNfl is 
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unt wl'wntvw 

D 01/trl•o POP3 comm~~~nds f m.n is cbtckH. 

AuthentteeUon: ® P~r$ p 
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Figure 25 To use balloon help in the Mac versions of 
Eudo1ra, choose Show Balloons from the Guide menu, 
then 

1
point at the item in question. 

Figure 26 To use contextual help, either click the 
Contextual Help button, then the item in question, or, if 
you're in a dialog box, right-dick the item in question. 



Andrew Stan's (Unofficial) Eudora Site 

oc 
Figure 27 Andrew Starr's Unofficial Eudora Site 
contains numerous tips, tricks, and pieces of Eudora
related information. 

Figure 28 Pete Beim's Unofficial Eudora FAQs & Links 
site contains a vast amount of information about the 
Windows versions of Eudora. 

Eudora Basics 

Unofficial help resources 
As good as Qualcomm's official support is, it 
may not suffice for all questions. And at 
times, you may simply need to ask another 
Eudora user a question. Luckily, there are a 
number of unofficial sources of information 
about Eudora as well. 

Unofficial resources 
for additional assistance 

• Two newsgroups. comp.mail.eudora.m~and 
comp.mail.eudora.ms-windows, carry discus
sions about the Mac and Windows ver
sions of Eudora, respectively. Both are 
excellent places to ask specific questions. 
You need a Usenet newsreader to access 
these newsgroups. 

• Williams Students Online runs majljng_ 
lists for discussions of both the Mac and 
Windows versions of Eudora. 
To subscribe to the Mac mailing list, send 
§ail to majordomo@wso.williams.edu and put_ 
s~ubscribe eudora-mac in the message b.Q9.y. 

To subscribe to the Windows mailing list, 
send email to majordomo@wso.williams.edu 
and enter subscribe eudora-win in the mes
sage body. 

• Andrew Starr's Unofficial Eudora Sitt; 
(Figure 27) offers numerous tips, tricks, 
and pieces of Eudora-related information, 
along with links to Eudora resources. 

http: II www.amherst.edu/ - atstarr/eudora/ 
~ 

• Pete Beim's Unofficial Eudora FAQs & 
Links site (Figure 28) contains a vast 
amount of information about the 
Windows versions of Eudora. 

http:/ /www.cs.nwu .edu/ -beim/ eudora/ 

• I've created a Web page containing 
additional Eudora information useful to 
readers of this book. 

http:/ I www.tidbits.com/ eudora/ 
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Chapter 1 

Email glossary 
I can't avoid the jargon inherent in talking 
about email-these words are the only ones 
we have. But, I can provide definitions so you 
can read this book knowing that information. 

AppleDouble: AppleDouble is the best 
method of encoding flle attachments in the 
Mac versions of Eudora such that they can be 
transferred via email\ Always try AppleDouble 
first. (See Chapter 3, "Writing Messages") 

AppleSingle: AppleSingle is a less commonly 
used method of encoding flle attachments in 
the Mac versions of Eudora such that they can 
be transferred via email. Use AppleSingle for 
sending Mac-specific files to other Mac users. 
(See Chapter 3, "Writing Messages") 

attachment: An attachment is a file that you 
send with a message, much as you might· 
attach a newspaper clipping to a letter with a 
paperclip. (See Chapter 3, "Writing Messages") 

• BinHex: BinHex is an older method of -
encoding file attachments such that they ?11 
be transferred via email. Use BinHex when 
sending files to Mac users who have old email 
programs. (See Chapter 3, "Writing Messages") 

body: The body of a message contains the 
primary content of the message. (See Chapter 3, 
"Writing Messages") ·· 

bounce: A message bounces when it is 
returned because it could not be delivered as 
addressed. (See Chapter 2, "Creating Messages") . 

dial-up connection: A dial-up connection is 
an Internet connection that you make using a 
modem to connect to an Internet service 
provider. (See Chapter 12, "Working with 
Settings/ Options") 

domain name: A domain name is the part of 
the email address after the @ character. In my 
address, ace@tidbits.com, tidbits.com is the 
domain name. {See Chapter 3, "Writing Messages~) 
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email address: An email address is the unique 
address that identifies each Internet user. 

Email addresses are composed of a username, 
the @ character, and a domain name. 
(See Chapter 3, "Writing Messages") 

encoding: Encoding is the process of convert
ing attachments in such a way that they can 
travel through email without being damaged, 
much as you put letters in envelopes to pro
tect them. (See Chapter 3, "Writing Messages") 

filter: A filter is a set of rules and related 
actions that Eudora applies to messages. (See 
Chapter 7, "Working with Filters") 

finding: In Eudora's parlance, finding is the 
process of searching for text in a single mes
sage. (See Chapter 8, "Finding and Searching") 

Finger: Finger is an Internet service like Ph 
that enables you to look up information 
about people. (See Chapter 11, "Using Directory 
Services") 

forward: You forward incoming messages 
when you wish to send them to someone else 
but have them come from you. Forwarding is 
like taking a letter from one person, putting it 
in another envelope, and sending it to 
another person. (See Chapter 2, "Creating Messages") 

hanging indent: A paragraph of text with a 
hanging indent has the frrst line at the left 
and all following lines indented to the right. 
(See Chapter 3, "Writing Messages") 

header: The header of an email message 
contains the information necessary to deliver 
the message. Think of the message header as 
the outside of an envelope, containing an 
address, a return address, and the postmark. 
(See Chapter 4, "Sending and Receiving Messages") 

helper application: A helper application is a 
program Eudora relies on for tasks, like view
ing a Web page, that Eudora can't do itsel£ 
(See Chapter 5, "Working with Messages") 



Internet Config: Internet Config is a free 
program for the Macintosh that helps 
centralize Internet preferences. Eudora can 
optionally work with Internet Config. 
(See Chapter 5, "Working with Messages") 

kilobyte: A kilobyte is a unit of measurement 
equal to 1,024 bytes or characters. (See Chapter 
4, "Sending and Receiving Messages") 

match string: In the context of filters, a 
match string is the text you want the filter to 
look for in message headers. (See Chapter 7, 
"Working with Filters") 

message plug-ins: A message plug-in is a 
file that extends Eudora's text-editing func
tionality. (See Chapter 3, "Writing Messages") 

message summary: A message summary 
is a line in a Eudora mailbox that includes 
the sender's name, the message date, and the 
message subject, with other information. 
(See Chapter 5, "Working with Messages") 

MIME: MIME stands for Multi-purpose 
Internet Mail Extension and in the Windows 
versions of Eudora is the best method of 
encoding file attachments for transfer via 
email. (See Chapter 3, "Writing Messages") 

nickname: A nickname is an easily typed and 
remembered name that replaces one or more 
email addresses. A nickname for me might be 
"Adam", which would replace ace@tidbits.com. 
The Windows versions of Eudora call nick
names "address book entries." (See Chapter 9, 
"Working with the Address Book") 

nicknames files: A nicknames file is a file that 
contains nicknames in Eudora Pro. (See Chapter 
9, "Working with the Address Book") 

personality: A personality is a group of set
tings in Eudora Pro. Personalities are useful 
for working with multiple email accounts. 
(See Chapter 1, "Eudora Basics," Chapter 2, "Creating 
Messages," and Chapter I 2, "Working with 
Settings/ Options") 

Eudora Basics 

Ph: Ph is an Internet service like Finger that 
enables you to look up information about 
people. (See Chapter 11, "Using Directory Services") 

POP: POP stands for Post Office Protocol and 
is the primary method that email programs 
like Eudora use to retrieve incoming Internet 
email messages. (See Chapter 4, "Sending and 
Receiving Messages") 

POP account: A POP account is essentially the 
electronic mailbox where your incoming 
email sits until you retrieve it with Eudora. 
The POP account is composed of a username, 
an @ character, and the domain name of 
your POP server. POP accounts look like email 
addresses. (See Chapter 1, "Eudom Basics" and Chapter 
12, "Working with Settings/Options") 

POP server: A POP server is a program that 
rnns on an Internet computer and sends your 
incoming messages when you check mail. 
(See Chapter 4, "Sending and Receiving Messages") 

queue: When you queue a message, you set it 
to send at a later time. (See Chapter 4, "Sending and 
Receiving Messages") 

quote: When replying to a message, Eudora 
automatically quotes the original text by 
putting a > character before each line. 
(See Chapter 2, "Creating Messages") 

recipient list: The recipient list is a list of 
nicknames that appears in the hierarchical 
Insert Recipient, New Message To, Forward 
To, and Redirect To menus. (See Chapter 2, 
"Creating Messages" and Chapter 9, "Working with the 
Address Book") 

redirect: You redirect incoming messages 
when you want to send them to someone 
else but have them appear to come from the 
original sender. Redirecting is like putting a 
letter back in its original envelope, affixing a 
sticker with someone else's address over your 
address, and sending it again. (See Chapter 2, 
"Creating Messages") 
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reply: You reply to a message when you want 
to respond to it. (See Chapter 2, "Creating Messages") 

return address: The return address is the 
address that everyone sees on mail from you. 
It's also the address to which their replies will 
be sent. (See Chapter I, "Eudora Basics" and Chapter 
12, "Working with Settings/Options") 

Rot 13: Rot 13 is a simple method of encod
ing text to prevent prying eyes from reading 
it. (See Chapter 3, "Writing Messages") 

search term: The search term is the text that 
you want to find when finding or searching. 
(See Chapter 8, "Finding and Searching") 

searching: In Eudora's parlance, searching is 
the process of searching for text in multiple 
messages. (See Chapter 8, "Finding and Searching") 

signature: The signature contains personal 
information that appears at the bottom 
of every message you send. (See Chapter 3, 
"Writing Messages") 

SMTP: SMTP stands for Simple Mail Transfer 
Protocol and is the primary method that email 
programs like Eudora use to send messages. 
(See Chapter 4, "Sending and Receiving Messages") 

SMTP server: An SMTP server is a program 
that runs on an Internet computer and 
accepts your outgoing messages when you 
send mail. SMTP servers also transfer mail 
between one another on the Internet to 
move messages to their eventual destinations. 
(See Chapter 1, "Eudora Basics," Chapter 4, "Sending 
and Receiving Messages," and Chapter 12. "Working 
with Settings/Options") 

spam: Sp¥D. also known as unsolicited com
mercial email, is email messages from people 
you don't know, advertising products or ser
vices you don't want, often in a fraudulent 
manner. Spam is a blight on Internet email. 
(See Chapter 5, "Working with Messages") 
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spammer: A spammer is someone who sends 
spam messages to tens or hundreds of thou
sands of recipients. (See Chapter 5, "Working with 
Messages") 

starting point: The starting point for a search 
is the message with which Eudora starts 
searching. (See Chapter 8, "Finding and Searching") 

stationery: Stationery is previously composed 
outgoing messages you can use when creating 
messages. (See Chapter 2, "Creating Messages") 

URL: URL stands for Uniform Resource 
Locator and is pronounced "You Are Ell." 
URLs identify Internet resources such as Web 
pages. (See Chapter 5, "Working with Messages") 

username: A username is the part of the 
email address before the @ character. In my 
address, ace@tidbits.com, ace is the username. 
(See Chapter 3, "Writing Messages") 

Uuencode: Uuencode is an older method 
of encoding file attachments such that they 
can be transferred via email. Use Uuencode 
when sending Mac documents or PC files 
to PC users who have old email programs. 
(See Chapter 3, "Writing Messages") 



CREATING MESSAGES 
One of the most common activities in Eudora 
is message creation. It might seem like a triv
ial topic, and in fact it is extremely easy, but 
newcomers may not realize the many ways 
messages can be created in Eudora. 

You'll definitely want to create new messages 
to friends, and I guarantee that you will often 
want to reply to messages you receive. But 
what about the less common situations? 
Maybe a colleague sent a joke that you 
absolutely must forward to your college 
roommate. Perhaps you received a m essage 
that would be best handled by someone else 
in your department. What if you need to send 
a piece of boilerplate text to everyone who 
writes to your company requesting general 
information? 

In each of these cases, you could use basic 
tools to create a new message with the appro
priate content. Instead, you should take 
advantage of Eudora's power and flexibility in 
creating new messages, as you'll see in this 
chapter. 
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Chapter 2 

Creating a new message 
A new blank message is the easiest and most 
obvious way to create a new piece of email. 

To create a new message 
1. From the Message menu, choose New 

Message OCmd~N/ICtrl ~N) (Figure 1). 

A new outgoing message window appears, 
with the cursor in the To line of the header 
and the From line filled in with your name 
and email address (Figure 2). 

2. Type the nickname or the email address of 
the recipient in the To line. 

3. Press Tab, or click in the Subject line, then 
type the subject of your message. 

4. Press Tab three more times, or click in the 
body area of the message, then type your 
message (Figure 3). 

5. Click the Queue button OCmd~E/ICtrl ~E) 
to queue your message for later sending. 

V' Tip 
• When you're working on a long, compli

cated, or important message, you might 
want to save your message periodically 
while writing. To do that, choose Save 
0 Cmd ~S/1 Ctri)-S) from the File menu 
whenever you like. 

Persqnalltles 
:Eudora PrO has a neW' feature th~t~bles . 
you to send and receive mail' from-lt).Ul~-· 
ple email accounts. This feature is· great.for 
those of us with more than account. 

In the Mac screen shots to the right the 
pop-up menu in the From line controls 
which personality the-message comes 
from. In the Wmdows version of Eudora 
Pro, you choose personalities through a 
dialog box instead of a pop~ up menu. 
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Figure I To create a new outgoing message, choose 
New Message from the Message menu. 

cNo Retllllnb 5:33PM •0700. cNo SUb rub 

Dll!IIID .... "lil ..,. ~ • ~ 
I ,...._ ~~~:B.llilll~~!Ef!f~~iM: 

To: ,_, ·-c. ~~· ·-t•eu•--• 1.-•,_t- I 
toA>Joct: 

Cc: 
kc: x_,.t-u· 

Figure l A new outgoing message window contains a 
filled-in From line, but has the rest of the window blank. 

l"w fln•shed -.. edl t pass,. .o i\ ·• ~ hrn ... Let•• 90 for the ..... Anding 
.. tup \Odav. 

~--·- ~ Ill 

Figure 3 Once you fill in the To and Subject lines for 
your message, note how the title bar of the window 
changes. Click the Queue button to send your message. 
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Figure 4 To reply to a message that you are either 
reading or have selected in a mailbox window, choose 
Reply from the Message menu. 

T.Q: Geoff Du."lcan <gecffltidbits.co:e> 
f"roa: '"Ad e.. c. ~nqst" <aceftidbit •. cca> 

S~ject: Jle: newer redirect :~cript 
~c : 

ll.cc : 

•tt-ac:bed: 

At ~O:Z6 AI'C 6 /23/ '!H -01'00 , you wrote: 
>Here's a pointer to a redirect script . . . 

> 
> <http: //waymac. com/toola/redirect.w. server. al..t. hqx> 

>cool .•• 

X 

>gd .!] 
Figure 5 Eudora automatically fills in the To, From, and 
Subject lines in a reply. and quotes the original message 
for you to edit. 

you wrote: 
>Hero• a a pointer to a redirect script.,. 

Thank:~ Geoff. I'll ~mag it, generate the redirect tor 
the seec-ch onqine, and \.lploed ••• Che ek 
<ht.tp: //www. tidbits.com/sea rch/> later today . . . 

cheers •• • - Adam 

Figure 6 Edit the body of the message so it's clear 
what you're replying to. Keep quotes to a minimum. 

Creating Messages 

Replying to a message 
Although you're certain to want to create 
plenty of new messages to people using New 
Message, it's far more likely that you'll want 
to reply to a message that you've received. 

To reply to a message 

1. Open or select an incoming message, then 
choose Reply (ICmd)-R/ICtrl )-R) from the 
Message menu (Figure 4). 

Alternately, in the Windows versions of 
Eudora, open or select an incoming mes
sage, then right-click it and choose Reply 
from the pop-up menu that appears. 

Eudora creates a new outgoing message, 
but this time fills in the To line, the From 
line, and the Subject line. 

The body of the original message is 
quoted (Figure 5) and, in the Mac ver
sions of Eudora, selected. 

You can either delete the original text 
entirely or edit it if desired. 

2. Type your message, and if you wish edit 
the original message to respond to specific 
points (Figure 6) . 

3 . When you 're done, click the Queue but
ton (I Cmd)-E/ICtrl )-E) to queue your reply 
for later delivery. 

V'Tip 

• When you're working on a long, compli
cated, or important reply, you may want 
to save your message periodically while 
writing. To do so, from the File menu, 
choose Save QCmd)-S/ICtrl )-S) whenever 
you like. 
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Chapter 2 

Replying to 
part of a message 
What if you want to reply to a message and 
respond to a specific point in the original 
without editing the quoted text manually? 

To reply to part of a message 

1. With an incoming message window 
open, select some text (Figure 7). 

2. Holding Shift down, choose Reply 
Quoting Selection (ICmdHShift~R) from 
the Message menu (Figure 8). 

A new outgoing message window 
appears, with the To, From, and Subject 
lines filled in appropriately, and with just 
the selected text quoted in the body of the 
message. 

3. Make any additional edits you wish, and 
type your reply (Figure 9). 

4 . When you're done, click the Queue but
ton (I Cmdl-E) to queue your message for 
later delivery. 

VTips 

• If the menu item says Reply instead of 
Reply Quoting Selection, you didn't hold 
the Shift key down before clicking the 
menu. 

• If you wish to include the headers of a 
message in a reply, you must specifically 
select them; Eudora never includes head
ers otherwise. Just select the headers along 
with any other desired text, then hold 
down Shift and use Reply Quoting 
Selection to create the reply message. 
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Figure 7 Select some text in an incoming message 
window. 
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Figure 8 Hold down Shift and select Reply Quoting 
Selection from the Message menu. 
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Figure 9 Note that only the selected text is quoted in 
the reply. Make any additional edits and type your 
message before queuing it up for delivery. 
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Figure I Oa/ I Ob From the Message menu, either hold 
down Option and choose Reply To All (Mac) or just 
choose Reply to All (Windows). 
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Figure I I Note that there are two recipients in the To 
line, thanks to using Reply To All. 

Reply To All by default 
If you're truly foolhardy, you can change a 
setting in the Replying settings panel of 
the Settings/Options dialog box to make 
Reply to All be the default. I strongly rec
ommend that you do not do this--sooner 
or later you'll send a reply to someone 
who shouldn't have seen it, and you'll 
regret it. Believe me on this. 

Creating Messages 

Replying to all recipients 
Often, when you receive a message, it will 
have been sent to multiple people. For safety's 
sake, Eudora by default only replies to the 
sender, but you can address your reply to all 
of the other recipients. 

To reply to all recipients 

1. In the Mac versions of Eudora, open or 
select an incoming message with multiple 
recipients. Then hold down Option and 
choose ReplyToAll 0CmdHOption ~R) 
(Figure 1 Oa) . 

In the Windows versions of Eudora, make 
sure you have an incoming message win

dow open or a m essage selected in a mail
box and choose Reply to All from the 
Message menu (Figure lOb) or right-click 
the message and choose Reply to All from 
the pop-up menu that appears. 

Eudora creates a new outgoing message 
window with all the recipients in the To 
line (Figure 11). The From line, Subject 
line, and body of the message are filled 
out as they would be for any reply. 

2 . Type your reply, and if you wish to 
remove a recipient from the To line, do so 
by selecting it and pressing Delete. 

3 . When you're done, click the Queue 
button (ICmd~E/@!ill-E) to queue your 
message for later delivery. 

V' Tips 

• If the menu item in the Mac versions of 
Eudora says Reply rather than Reply To All, 
you didn 't hold the Option key down 
before clicking the menu. 

• In the Mac versions of Eudora, select some 
text, then hold down Shift and choose 
Reply Quoting Selection To All to quote 
the selected text and address the reply to 
all recipients. 
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Forwarding a message 
If someone sends you a message that you 
feel another person should see, you can use 
Eudora's Forward command to send them 
a copy. 

To forward a message 

1. Open or select an incoming message, then 
choose Forward from the Message menu 
(Figure 12). 

Alternately, in the Windows versions of 
Eudora, open a message, right-click it, and 
choose Forward from the pop-up menu 
that appears. 

Eudora creates a new outgoing message 
window, with the From and Subject lines 
filled in and the original message quoted 
in the body. The cursor should be in the To 
line (Figure 13). 

2. In the To line, enter the nickname or the 
email address of the person to whom you 
wish to forward the message. 

3. If you wish to add a comment to the mes
sage or edit part of it, go ahead and do so 
(Figure 14). 

4. When you're done, click the Queue 
button 0Cm4E/@!ill-E) to queue the 
message for later delivery. 

t/ Tips 

• If you don't want to quote the original 
message that you're forwarding, in the 
Mac versions of Eudora, hold down 
Option when you choose Forward. 
Eudora creates the forwarded message the 
same, but does not include the quote 
character before each line. 

• A forwarded message always includes the 
headers of the original message. The only 
way to eliminate headers from forwarded 
messages is to remove them manually. 
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Figure 12 To forward a message that you are either 
reading or have selected, choose Forward from the 
Message menu. 

l'ro•: .. Adam C. 
S~joct: P.o: VireuolPC 

st.c: 
ll.oo: 

Attached: 

>X- Bonder: tonya8odeli e. tidbi ta. com 
>Date: Mon, 23 Jun 1997 13:27:42 -0700 
>To: aco9tidbits. com 
>P'rom: Tonya Engse <tonya9tidbite.c:o:r.> 
>8ubjoct: R.o : VirtualPC 
> 
>(No n~u,d to reply, just ehat Glenn is hot eo trot 
>on the Virtu•l PC review ... -e) 

Figure 13 Eudora creates a new outgoing message 
with the cursor in the To line and the body of the 
message quoted. 

cheers. . . -Adam 

>Prom: Tanya !'!n.g:~t <tonya9tidbits . eom> 
>8ubjoet: R.o: VictualPC 
> 
>(No need eo reply, just ehot Glenn is hot to trot 
>on the Virtual PC review ... -t) 

Figure 14 Enter the email address of the recipient in 
the To line, and add any comments you may have to the 
message body. 
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Figure I 5 To redirect a message that you are either 
reading or have selected, choose Redirect from the 
Message menu. 
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Figure 16 Eudora creates a new outgoing message 
with the original message in the body and the cursor in 
the To line. 

to.!!..Y._o• tldblts.com 7;25 PM - 0100 nol~g_~_.~tl 
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QltOff f<JIIbtlle . eo. Tlcll llS Tec:PYILCGI [dltr, g.offtlldbl h ~-

Figure 17 Enter a recipient in the To line and if you 
want put a brief explanation in the message body. 

Redirecting etiquette 

It's considered extremely bad manners to 
edit an original message that you're redi
recting. Put a short parenthetical at the top 
of the message explaining why you're 
redirecting if necessary. but don't change 
the original text if you can avoid it. 

Creating Messages 

Redirecting a message 
Imagine the situation. You receive a message 
that should really go to a colleague, since it's 
not your problem. You could forward the 
message to your colleague, but if your col
league replies the reply will come back to you 
by default. A better solution is Eudora's 
Redirect feature, which sends the original 
message to your colleague, but keeps the 
original sender the same so replies go back to 
that person and not to you. It's one of my 
favorite features in Eudora. 

To redirect a message 

1. Open or select an incoming message, then 
choose Redirect from the Message menu 
(Figure 15). 

Alternately. in the Windows versions of 
Eudora, open a message, right-click it, and 
choose Redirect from the pop-up menu 
that appears. 

Eudora creates a new outgoing message 
with the From and Subject lines filled in 
and the original message in the body. The 
From line is slightly modified with the 
parenthetical phrase "(by way of)" and 
your name and email address, so the even
tual recipient knows the message was 
redirected (Figure 16) . 

The cursor should be in the To line. 

2. Type the nickname or email address of the 
recipient. 

3. If you wish to add a note to the top of the 
original message, explaining why you're 
passing the buck, do so (Figure 17). 

4. When you're done, click the Queue 
button ([Cmd)-E/ @ill-E) to queue the 
message for later delivery. 
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Sending a message again 
Eudora's Send Again command is extremely 
useful but somewhat subtle. Say you send a 
message to a friend, and later hear that the 
friend lost all his email and wants another 
copy of your message. Or, perhaps a message 
you sent bounces because you typed the 
email address incorrectly. 

To send a message again 

1. Open or select either a saved outgoing 
message from your Out box or an incom
ing bounce message that you've received 
(Figure 18). 

2. From the Message menu, choose Send 
Again (Figure 19). 

Eudora creates a new outgoing message, 
filled in exactly the same way your 
original message was, with the same To, 
From, and Subject lines, and the same 
message body. 

3. Make any necessary changes, such as fix
ing an incorrect email address, or adding 
an important detail to the body of the 
message that you'd previously forgotten 
(Figure 20). 

4. When you're done, click the Queue 
button QCmd~E/Ietrt ~E) to queue the 
message for later delivery. 

t/nps 
• You can use Send Again on messages 

you've received, but Eudora will put your 
address in the To line (since the message 
was originally sent to you). Change the 
address to send the message normally. 

• When you use Send Again with a message 
you've sent that's bounced back, your sig
nature appears in the new message. Don't 
delete it since Eudora won't add a new 
signature. 

!mil POstmoster$ollellll.tldblts.com.3:57 PM 6/24/9? ·O.Ilndelloeroble t llllili 

F,...: Poo-~llo.tldblto.
To: ~etti~lt..ce~~t 
Dolo: Tuo, 24 .bl 11197 15:31:!18 -o700 
lob)oct: lhlo11-lo 11atl 

The follwlng ~could not~ sent bec:ause the OCidren "tonvltldblt•.COII" 
- rojootod 1>11 ,_, 'tldblto.o .. ·. 
D u..,. t~tleit•.eoa not kno.n 

-··!Msont- foil----

-•-: ,,..,. 1204.57.157.101 1>11 -llo.tldbl\0.- •lilt 
ESnTP <E.-.a lnt.mo\ 11all '"""'" 1.1.2>; Tuo, 24 .bl 11191' 15:31:!10 -o700 
X--: -llo.tldblto.-
~ld: <u031028ZIGf.s:I~0486111204.57. 157.101> 
111-.lon: 1.0 
Content-T...,_: teMt/pla:tn~ chcrset••us-oJCII• 
Dolo: Tuo, 24 Jun 11191' 1:1:33:30 -o100 
To: ~\ldblts.-
Fro.: ·-C. ~~· <-tl<lt>l\o.o .. > 
s..bj .. t: ~···to--
cr., T-, I f-t to toll.,... . .._ .,....,.. updcotlng tho·- -lno 
l""'>lala fllo, II"" '- to toll Applo 0.9. to Aol- l""'>loto fi"'O tho 
S.ttinoa ..,., (In ott.- ...-cis, vau can't do It vlo t:.. "-b). 

-.... ... .-
-c. ~t. Tldlll1'11 £<11\or- -\ldblto.-- lnf.,.\l<lt>l\0.

,.._... to so- c..cn QAHtton. via Mall cat foq-ackllltldblt..a. 
01"' via the Wlb at (b.\lP" (lm Slslrita ml.Rsbi«BB.bJAJ.• 

Internet Stcrtr Kl t for l"bc:intosh, 4th (dl tlan no. CNallable ~ 
·~ll!n "*"' mn(.l&J.• Iii 

Figure 18 Open a bounce or a message you've sent 
previously. Note that in this bounce, I mistyped Tonya's 
email address, forgetting the a in tonya@tidbits.com. 

ll!ll1'tla 
New Message .N 
Reply •R 
Forw11rd 
Redirect 

New Me11oge To • ForwerdTo • Redirect To • 
New Messege With • Reply With • 
Al1<1th Ootument ... lCH 
Htto1h • Quout> ror Oell11cry JC[ 

Chon go • 
Delete •o 

Figure 19 To send this message again, choose Send 
Again from the Message menu. 

~ tonV~HttlclflltMam. 5:49PM ·D70D. Uplletes to saOJ'dlpeaa·WZ!IIiiiJ 
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I - ![5;D~IiliDD-I!.III!IIim!D!I!!III 

....!:~ =~~~\~-u""''"·-· •-·-"' I ~ 
.... , .. ,, ~ ... ta ·-Cc: 

_, 
X -fit-to: 

Ch, T01yt, 1 f-t to toll-·.._.,....,.. updcotlft9 tho.-_,,.. 
\elplole , .... vau ...,. to tell #bple •·9· to f'llocat f.-plat• free u. 
letUnp ..., On othW' eordl, vou CGI"''' t dO 1\ via the Yilb) 

-.. ... -
-C. Engot, Tldlll1'11 Editor- -tl<lt>lto.-- lnf.,.tl<lt>l\0.

~ \o--. COMOn ~tiON via -.all a\ f~tl«tlta.coa 
or vlo the (.WI at cnssg· ,,_ "*"' 'P'"ttn'f"P..b.W.• 

lnt.rnet S\clrtr IClt fer f'tlclnto.h, •u. Edition noll owllcOie tft 
•bUa· 1 /ne '•*' '' rm11M1~ ~ 

Figure 20 In the new outgoing message, fix the error 
in the address if you're resending a bounce, or make any 
other necessary changes. 
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Figure 21 To create a new message using the recipient 
list, choose a nickname from the New Message To menu. 
The Forward To and Redirect To menus contain the 
same list of recipients. 

mhaOIIdblts.com 4:40 PM -o1ao cNo Sub.lecb 

Oll!JiiJ oltl1 -1f} ~ .IQ} !A [ Queue l 
I -"~ ·~C£fElB/ :~i :.a.·:~·: IE:·• i~ ~~·I·B['1\'1l/~; 

To: lllhaltldbtts .coe Q 
F~: -~e. En;~t· (ocettldblts.eo-, ! • .oo.l~t •• I 

Sobjoet: I 
Cc: 

llc:c: 
X-At~u: 

Figure 22 Eudora creates a new outgoing message 
window and puts the cursor in the Subject line. If you 
used Forward To or Redirect To, the rest of the message 
would be filled in for you. 

mhootldlllts.ccm 4:40 PM -0100, aus1ne11 cordi 

Oll!JiiJ .... "'liD .;§. .IQl ~ ~ 
I -- IC5i!DCB!]3IftiZD!IIiiA!JI!I!I!I~[I] 

,,.!:~ ~i~·:~~ •aeettldbHI.CM) I..OO.Inar'lt •• I f-
St.bjecl: Buslnesa cards 

Cc· 
llc:c: 

X-Att-u: 

lollat cb vou thir*. of the ,.... buslnal ccrd:l: Jon . ...,.s:h did fOt" us? 

ci>Hrs ..• -

Figure 23 Fill in the Subject line, and enter your 
message. If you used Forward To or Redirect To, this 
step wouldn't be necessary. 

Creating Messages 

Using the recipient list 
In each of the previous examples of creating 
messages, you've either typed a nickname or 
email address to address the message or 
replied to an existing message. A faster 
method of creating new messages uses 
Eudora's recipient list, to which you can add 
people whenever you create a nickname. (See 
Chapter 9, "Working with the Address Book") 

To address a message using the 
recipient list 

1. Choose a recipient from the recipient list, 
which you access from the hierarchical 
New Message menu in the Message menu 
(Figure 21). Or, open or select an incom
ing message and choose a recipient from 
the hierarchical Forward to or Redirect To 
menus in the Message menu 

Eudora creates a new outgoing message 
window, with the From and, if you chose 
Forward To or Redirect To, Subject lines 
filled in. The nickname you chose is in the 
To line, and the body of the message 
includes the original message if you chose 
Forward To or Redirect To (Figure 22). 

2. Enter your message or add a comment if 
you wish (Figure 2 3). 

3. When you're done, click the Queue 
button QCmdl-E/ICtrll-E) to queue the 
message for later delivery. 
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Turbo redirecting 
a message 
Some people find themselves in the position 
of an email mailroom clerk-they receive lots 
of email that must be distributed to the 
appropriate people. For that, Eudora's Turbo 
Redirect feature is perfect. 

To turbo redirect a message 

1. With an incoming message window open 
or a message selected in a mailbox 
(Figure 24), hold down Option (Mac) or 
Shift (Windows) and choose a nickname 
from the Redirect To hierarchical menu. 
On the Mac, the menu item changes to 
Turbo RedirectTo (Figure 25) . 

Eudora creates a new outgoing message 
window addressed to the nickname you 
chose, with the From and Subject lines 
filled in, and the original message in the 
body. 

Eudora then queues the message for later 
delivery (Figure 26), and moves the orig
inal message to the Trash mailbox. 

V' Tips 

• Turbo redirecting a message offers no 
chance to add a comment to the top of 
the original message. To do so after the 
fact, open the Out mailbox, open the 
queued message, make your changes, and 
queue the outgoing message again. 

• You can set Turbo Redirect to be the 
default for both the Mac and Windows 
versions of Eudora in the Miscellaneous 
settings panel of the Settings/Options dia
log box, but the menu item won't change 
in the Windows versions. 

• Be careful with Turbo Redirect-you can 
easily redirect a message to the wrong 
person without realizing. 

rrornron • 

Figure 24 To turbo redirect a message, open an 
incoming message window or select a message in a 
mailbox, as I've done here. 

New Message IICN 
Reply To All IICR 
Forward 
Redirect 
Send Rgeln 
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editors 

New MesSDge With ~ GO 
Reply To All With ~ ' 
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Attach Document ... >lll H Info-Mac 
Rttech ~ J eff 
Change Queueing ... :.! E Mark 
Change ~ Molt 

Mom 
Delete IIC O Press Releoses 

staff 
Steue 
Tonya 

Figure 25 Hold down O ption (Mac) or Shift 
(Windows) and choose a nickname from the Turbo 
Redirect To menu (Mac) or the Redirect To menu 
(Windows). · 

.. 

Fi~ure 26 Eudora responds by queuing the redirected 
me~sage in the O ut box, shown here, and moving the 
original message to the Trash mailbox. 



T.D: Tonya, Geoff~ Jeff, Mark 
F'rom: "Ade.m C. l!:ng~t,. <acc8tidbit~.com> 

S!dhjoct: Web ~te.ti:st.ic~ uplooded 
Q.c: 

ztcc: 
Atte.chod: 

Hey everyone, 

J: ' ve uploaded the Web log ono.ly:si~ for thi3 rnoneh. 
Check out the detaill!!l at: 

http: I /www. tidbitl!!l . com/ about/stat:~. html 

cheers ... -Adam 

Figure 27 To create a new stationery message, choose 
New Message from the File menu, and fi ll in all the 
desired parts of the message. 

Cllc<lt&ail C1r .. ll 

trm.. C1rM' 
.... iltl'ft,tlow 

~~ 

Qstt ClrloQ 

Figure 28 After you create your message exactly 
as you want it to appear; choose Save As from the 
File menu. 

Figure 29 Enter a file name for your stationery 
message, click the Stationery checkbox, and then click 
the Save button to save your stationery message. 
(In the Mac version of Eudora Pro, click the Go to 
Stationery Folder button before clicking Save.) 

Creating Messages 

Creating a 
stationery message 
If you need ro send rhe same message over 
and over again, or if you need ro reply ro 
numerous messages wirh me same informa
rion, Eudora Pro's srationery is extremely 
useful. 

To create a stationery message 

1. Choose New Message (ICmd l-N/(Ctrl l-N) 
from rhe Message menu. 

Eudora creares a new outgoing message 
wim the From line filled in. 

2. Fill in me To, Cc, and Bee lines wim recip
ients you always want ro receive email 
messages created wirh me stationery. 

3. Fill in me Subject line if you want all mes
sages created with me srationery (0 have 
mat Subject line. 

4. In the body of the message, enter me rexr 
you want to appear in each message cre
ared wim me stationery (Figure 2 7). 

5. From me File menu, choose Save As 
(Figure 28). 

6. Name the message (if you entered a 
Subject line, that's me default name) . 

7. Check me Stationery checkbox 
(Figure 29), and on the Mac, click the Go 
To Stationery Folder button. 

8. Click me Save butron to save your 
stationery message. 

VTip 

• To change an existing stationery message, 
choose ir from me hierarchical New 
Message Wim menu in the Message menu. 
Make any changes and save ir according to 
steps 5 through 8 above, replacing the 
previous file when prompted. 
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Creating a new 
message using stationery 
I create new messages with stationery when
ever I send the same piece of rote email to a 
number of different people over time (such 
as messages asking for permission to include 
a shareware utility on a book's CD-ROM, for 
instance). 

To create a new 
message using stationery 

1. From the New Message With hierarchical 
menu in the Message menu, choose the 
piece of stationery you wish to use 
(Figure 30). 

Eudora creates a new outgoing message 
that looks exacdy like the stationery mes
sage you created (Figure 31). 

2. Enter a recipient if necessary, fill in any 
other missing information, and edit the 
message if necessary. 

3. When you're done, click the Queue 
button OCmdl-E/ICtrll-E) to queue the 
message for later delivery. 

t/Tips 

• In the Windows version of Eudora Pro, 
you can also hold down Shift when you 
choose New Message (@!!0-IShlft~M) 
to choose a piece of stationery for the 
new message. 

• You can also create a new message 
using stationery by double-clicking the 
stationery file to open it. 

• Eudora puts the cursor at the most 
appropriate place in the new outgoing 
message, depending on the contents 
of the stationery. 

• I often edit my boilerplate messages each 
time so they don't sound canned. 
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Figure 30 To create a new message using stationery, 
choose a stationery message from the New Message 
With hierarchical menu in the Message menu. 

ElJitanuaotldblls.com. aeaffotldlllts.cam effeott. Web staUstlcs UIJIII!lil 

Oll!J@ ~ "'lfD 4t» .;Q) 88 .I Queue I 
- ~~l~JZDD!m!II!I!I!I~[IJ 

To: =~~t!~· -frttlcl>IU..c:oe, jeffdtldbltoo.c:oe, I:!J 
Fr0111: •fkia C. En;st• c~tJdblb.COII, I..OO.I...ant» I 

$o.objoct: Utb statls\leo ...,,_ 
Cc: 

Bee:: 
X-flttoc-..to: ..... 
....., ....,..won•, 
I·.,. '-Oioadocl 11>0 Web 109 analvsls for thl• _,th. O.CO. out 11>0 clotall• at: 

~.U,rn t idbi lt £2'/.Qa!dli.W1I.....b1ll 

cn.r •... -~ 

Figure 31 Eudora creates a new outgoing message 
that looks exactly like your stationery message. Make 
any changes you want, and click the Queue button to 
queue the message for later delivery. 
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Figure 32 To reply to a message using stationery, first 
open or select an incoming message, such as this piece 
of spam (unsolicited commercial email). 
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Figure 33 From the hierarchical Reply With menu 
in the Message menu, choose the piece of stationery 
you want to use in your reply. 
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Fig ure 34 Eudora creates a new outgoing message 
that looks like your stationery with the addition of the 
recipient's address and body text from the original 
message. Make any changes you want, and click the 
Queue button to queue your message for later delivery. 

Creating Messages 

Replying to a message 
using stationery 
Stationery is a godsend for people who get 
the same questions over and over again in 
email. Just create a piece of stationery with 
the appropriate answer and use Eudora Pro's 
Reply With command to reply to incoming 
questions with the stationery message. 

To reply to a 
message using stationery 

1. Open or select the message you want to 
reply to (Figure 32), and then choose a 
stationery message from the Reply With 
hierarchical menu in the Message menu 
(Figure 33) . 

Eudora creates a new outgoing message 
that's addressed to the original sender and 
includes not only the original message, 
but also all the details from the stationery 
message. 

2. Fill in any missing information, and edit 
the message if necessary (Figure 34) . 

3. When you're done, click the Queue 
button dCmdl-E/@ill-E) to queue the 
message for later delivery. 

V' Tips 

• In the Mac version of Eudora Pro, you 
can use the modifier keys that work with 
Reply when you're using Reply With. If 
you hold down Shift with a portion of an 
original message selected, Reply With 
changes to Reply Quoting Selection With. 
If you hold down Option, Reply With 
changes to Reply To All With. And, both 
Shift and Option change Reply With to 
Reply Quoting Selection To All With. 

• In the Windows version, you can also hold 
down Shift when you choose Reply to 
select a piece of stationery for the reply. 
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WRITING MESSAGES 
In the previous chapter, I glossed over the 
many different ways you can add content to a 
message after you've created it. I did so in 

part because although an email message looks 
simple, those looks can be deceiving, espe
cially in a program as powerful and flexible 
as Eudora. 

When you look at Eudora closely, you realize 
there are all sorts of ways you can add con
tent to an email message, and those ways 
aren't always obvious. 

For instance, you must address every message, 
then you must give it a subject. Almost every 
message has a message body, and Eudora has a 
capable text entry environment that has some 
features you might not have noticed, includ
ing formatting options in Eudora Pro. 

The possibilities for adding content don't end 
there. Eudora enables you to create multiple 
signatures that it automatically appends to 
every message you send, and you can also 
attach files to messages. Finally, you can set a 
variety of message options that affect how 
your message is sent or how the recipient 
sees it. 

In short, there are tons of neat things you can 
do when writing email messages-read on 
for the details, arranged as you'll experience 
them in each message. 
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Chapter 3 

Addressing messages 
Every time you send a message, you must 
address it. There are a number of different 
ways of adding email addresses to one of the 
three address lines in an outgoing message, 
the To line, the Cc line, and the Bee line 
(Figure 1). 

Methods of addressing messages 

• Type an email address in one of the three 
address lines. Separate multiple addresses 
with commas. 

• Type a nickname in an address line. 
Separate multiple nicknames with 
commas. 

• Reply to a message. (See Chapter 2, "Creating 
Messages") 

• Use the recipient hst with New Message 
To, Forward To, or Redirect To. (See Chapter 
2, "Creating Messages") 

• Type the first part of a nickname (enough 
to make it unique among your nick
names) and then choose Finish Address 
Book Entry (ICmdi-.IICtrll-.) from the Edit 
menu to complete the nickname. Hold 
down Option (Mac) or Shift (Windows) 
to Finish And Expand Address Book Entry 
(ICmdHOption~.IICtrl HShittl-.), which fin
ishes the nickname and replaces it with 
the corresponding email address. 

• Place the cursor in any one of the three 
address lines and choose a nickname from 
the Insert Recipient hierarchical menu in 
the Edit menu. Hold down Option (Mac) 
or Shift (Windows) to Insert And Expand 
Recipient, which inserts the nickname 
and replaces it with its corresponding 
email address. 
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• In the Address Book (ICmdi-L!ICtrii-L), 
select one or more nicknames, and click 
one of the To, Cc, or Bee buttons to add 
them to the appropriate line in either the 
current outgoing message or a new out
going message. 

• Drag a nickname from the Address Book 
to one of the three address lines. 

• Drag an address from another message. 

f'xoa : "Ada:a C. !!!ngst" <acc9tidbit:s.ccm> 

SWJjaot: Meeting to talk abo~Jt. archive laad!l 
~c : Geoff . Jeff, tnha9tidbit:~.cOJQ 

D.cc: 
Attached : 

Figure I You can enter email addresses or nicknames 
in the To. Cc, or Bee lines. Separate multiple recipients 
with commas. 

Multiple Recipients Tips 

When you enter multiple recipients using 
any of the methods mentioned (and you 
qm mix and match all of the methods), 
make sure to separate recipients with com
rbas. This is particularly true when you 
drag a nickname or address into one of the 
three address lines, because Eudora won't 
insert the commas for you, which can be 
cbnfusing. 

Also, when selecting multiple nicknames 
~ the Address Book, hold down Command 
(Mac) or Control (Windows) to select 

~
I ultiple nicknames. Hold down Shift on 
oth platforms to select a range of nick
ames. 
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personality from the personality pop-up menu, which is 
set to Dominant by default. 
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Figure 3 After you choose the alternate personality, 
notice how the From address has changed. 

Figure 4 Hold down Shift and create a new message 
however you wish to bring up the Message Options 
dialog. Choose a personality from the Personality pop
up menu, and then click OK to finish creating the 
outgoing message. 

Writing Messages 

Choosing a personality 
Eudora Pro enables you to send and receive 
mail from multiple Internet email accounts. 
This is useful, for instance, if you have a work 
address and a personal address and wish to 
handle them on a single computer. 

After you've addressed a message, you may 
want to set it to come from one of your alter
nate email addresses. (See Chapter I, "Eudom Basics" 
and Chapter 12, "Working with Settings/ Options" for 
information on personalities) 

To choose a personality (Mac) 

1. Create a new outgoing message however 
you wish. (See Chapter 2, "Creating Messages") 

2. Click the personality pop-up menu 
(Figure 2) in the From line and choose an 
alternate personality. 

Notice how the email address in the From 
line changes (Figure 3) . If you set a dif
ferent name when creating the personal
ity, the name would change too. 

To choose a personality (Windows) 

1. Hold down Shift and create a new 
outgoing message however you wish. 
(See Chapter 2, "Creating Messages") 

Eudora Pro displays the Message Options 
dialog (Figure 4) . 

2. From the Personality pop-up menu, 
choose a personality, then click the OK 
button to create the outgoing message. 

Notice how the email address in the From 
line changes (Figure 3) . If you set a dif
ferent name when creating the personal
ity, the name would change too. 

V'Tip 

• Keep in mind that personalities can have 
different return addresses that control 
where replies are directed. 
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Chapter 3 

Entering a subject 
After addressing your message and perhaps 
choosing a personality, you should always 
enter something in the Subject line. If you're 
replying to, forwarding, or redirecting a mes-
sage, it will be filled in for you, but even in 
these cases you may want to change the 
Subject line to be more appropriate. Here are 
some things to consider when choosing what 
to put in the Subject line. 

Things to consider with subjects 

• Keep the subject short . 

Not all email programs .display long sub-
jects, and even if they do, you want to 
make your point quickly. 

• Make the subject clear and specific . 

Clarity should be a given, but in practice 
it's all too rare. Subject lines like "General 
stuff" or "Things to do" aren't useful. You 
want the recipients to have a good idea of 
what will be discussed in the message 
from the Subject line alone, and after they 

ei~ 
have read the message, the Subject line 
should act as a reminder as to the contents 

'&~~: 
of the message. 

··~· ::», 
Ut· • Don't type in ALL CAPITAlS or use excla-

'iiC mation points if possible. ... 
$: This piece of advice may seem odd, but I 
2' offer it because of the prevalence of spam 
Ill 
J!oi (unsolicited commercial email) on the :z-
Ill Internet today. Most spam messages use 

uppercase in their Subject lines and throw 
in an exclamation point or five to indicate 
how important they are. If you do the 
same, some recipients may not even read 
your message, thinking it to be spam. 

• If an existing subject in a reply isn't 
appropriate, change it. 

Never fear to make a subject better fit the 
contents of a message. Everyone benefits. 
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We neod to get - :soon to talk about the 
archive lead s ~•-.:. will be generated automat ically 
i n our logo graphic. 

cheers ... -AdU"o 

Figure 5 Double-click a word to select the entire 
word. Double-click and drag to select by word. 

TQ: Tony• 
f'roa : '"Ad&a C. Engs t'" <ece lt.idbit s .cc=> 

Subject : Me eting t o talk about arc hiv e leed a 
'-o: Geoff , Jef f. aha8tidbl.ts.com 

l.oo : 

chee rs ... -A.ch m 

Figure 6 Triple-click on a paragraph to select the 
entire paragraph. Triple-click and drag to select by 
paragraph. 

Writing Messages 

Text selection 
and navigation 
I assume you know the basics of using the 
mouse, but you may not realize the more 
subtle methods Eudora provides for selecting 
and navigating through the text that you type. 

Methods of selecting 
and navigating through text 

• To insert the cursor where the mouse 
pointer is pointing, single-click the 
mouse. 

• To select the word (or email address in 
outgoing message window header lines) 
under the cursor (Figure 5), double-click 
the mouse. To select by word, double-click 
and drag. 

• To select the entire paragraph under the 
cursor (Figure 6), triple-click the mouse. 

In incoming mail, the lines have hard 
returns at the end, so a triple-click selects 
the line instead of the paragraph. To select 
by paragraph, triple-click and drag. 

• To move the cursor a word left or right, 
hold down Option (Mac) or Control 
(Windows) and press the left or right 
arrow key . 

• To move the cursor to the beginning or 
end of the paragraph, hold down Option 
(Mac) or Control (Windows) and press 
the up or down arrow key. 

• On the Mac, to move to the top or bottom 
of the message, hold down Command and 
press the up or down arrow key. To move 
to the beginning or end of the current 
line, hold down Command and press the 
left or right arrow key. 

• To select text instead of navigating, com
bine any of the previous three keyboard 
navigation methods with the Shift key. 
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Chapter 3 

Entering text 
I assume that you've figured out the basics of 
entering text (fingers on the keyboard, press 
down), but Eudora supports a number of 
somewhat unusual methods of getting text 
into the body of a message that you might 
not know. 

Methods of entering text 

• Copy selected text (using the Copy 
command QCmdi-C/@!ill-C) in any appli
cation) and paste it into a Eudora message 
by choosing Paste QCmdi-V /@ill-Y) from 
the Edit menu. 

• To paste·text as a quotation (as though 
you were replying to the text), choose 
Paste As Quotation QCmd~' ! @ill-') from 
the Edit menu (Figure 7) . 

• Select text in any other drag-aware appli
cation and drag it into your outgoing 
message window. 

• To insert an entire text me in a message, 
choose Attach Document (Mac) or Attach 
File (Windows) from the Message menu. 
Select the document you want to insert, 
and on the Mac click the Insert button 
(Figure 8) . In Windows, click the Open 
button, but then turn off the Text as 
Attachment button in the outgoing mes
sage header (Figure 9). The me won't 
appear in the body of the message, but 
that's how the recipient will see it. 

V' Tips 
• In Eudora Pro only, hold down Shift 

QCmdi-IShittl-V /ICtri 1-!Shift~V) when past
ing to remove text styles. 

• Dragging is difficult unless both windows 
are visible. It's often easier to use Copy 
and Paste. 

Undo Typing 

Cut 
Copy 
Paste 

Clear 

Te Ht 

Select All 
Wrap Selection 

xz 

X H 
XC 
x u 

xn 

Finish Address Book Entry X, 
Insert Recipient ~ 

Message Plug-Ins 
Add Ward Serulce ... 
CheckS ellln 

Figure 7 To paste text as a quotation, copy it, then 
choose Paste As Quotation from the Edit menu. 
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( Cancel 

Gill Damn Spam. l .nce 
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~/27197-~:03 PM, TEXT, NISI, ~2~+950<l b\1\os 

Figure 8 To insert a text file into a message in the Mac 
versions of Eudora, choose Attach File, select the file, 
and then click the Insert button. 

Text as Attachment button 

C: \ Program l"iles\Z!:udore 

W• need to get t ogether :~con t o talk. about the &r:chive 
leede t.hat. vill be generated autmutically in our logo 
graphic. 

cheers ... -Adam 

Figure 9 To insert a text file into a message in the 
Windows versions of Eudora, attach the file normally, 
but turn off the Text as Attachment button in the 
message window's toolbar. 



Figure I 0 To insert hard returns in a piece of selected 
text, choose Wrap Selection from the Edit menu. 

IIIII 
Undo Transfer to Trash •z 
CUI •• 
Copy tt Unwrap ac 
Peste au 
hUe AI Qeotatlon .. 
Clear 

TtNt ~ 

Selec t All •• 
Ffnhh & [ttpand Addreu Book Entry X, 
Insert & br:pond Recipient ~ 

Mes10ge Plug-Ins ~ 
Add Word Service ... 
Check Spelll_!!g_ 

Figure I I To remove returns from a piece of selected 
text, hold down Option on the Mac and choose 
Unwrap Selection from the Edit menu. 

IIIII 
Undo Pestl •z 
Cui •• 
,. ... •• 
Peste Is Quotation .. 
Clear 

TIM I ~ 

Sttect lUI •• 
unwrap Selection 
Finish It £Mpend Addreu Book £ntrJ X, 
tnur1 & (Mpend Redplent ~ 

Meuage Plug· lns ~ 
Add Word Service ... 
Check Soelllnq 

Figure 12 In the Mac versions of Eudora, you can copy 
a paragraph of text and remove the returns with a 
single action-just hold down O ption and choose 
Copy & Unwrap from the Edit menu. 

Writing Messages 

Editing text 
Eudora honors all the standard editing com
mands on the Mac and in Windows, such as 
Cut, Copy, Paste, Clear, Undo, and Select All, 
which are all located in the Edit menu. 
Eudora also has several less common editing 
tools that you might find useful. 

Tools for editing text 

• To insert hard returns (what you get in 
text when you press Return or Enter) at 
the end of each line in normal paragraph 
of text, select the text and choose Wrap 
Selection from the Edit menu (Figure 10). 

• To remove hard returns from the end of 
every line in an incoming message, select 
the text, and on the Mac, hold down 
Option and choose Unwrap Selection 
from the Edit menu (Figurell) . ln 
Windows, hold down Shift and choose 
Wrap Selection from the Edit menu. 

• To paste a paragraph of unwrapped text 
into another message or application, select 
the text, hold down Option, and select 
Copy & Unwrap (Figure 12) from the 
Edit menu QCmdHOption~C). This only 
works on the Mac. 

II Tips 

'" 0 

3 
z 
G\ 
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• When trying to unwrap quoted text, the ~ 
Mac versions of Eudora remove the> -4 

characters. The Windows versions don't 
remove the > characters, but they also 
won't unwrap quoted paragraphs . 

• In the Mac versions of Eudora, hold down 
Shift and choose Copy Without Styles 
from the Edit menu to copy text without 
style information. Also, hold down Shift 
and Option to change Copy to Copy 
Without Styles & Unwrap. 
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Chapter 3 

About message plug-ins 
Eudora comes with several message plug-ins, 
which are files that extend Eudora's text
editing functionality. The Mac (Figure 13) 
and Windows (Figure 14) have slightly dif
ferent sets of plug-ins, so I note that below. To 
use a plug-in, select some text and choose the 
plug-in from the Message Plug-ins hierarchi
cal menu in the Edit menu. 

Message plug-ins 

• Rotl3 Text (Mac only) encodes and 
decodes text. 

• Tabs to Spaces (Mac only) replaces all tabs 
with a visually equivalent number of 
spaces . . 

• Spaces to Tabs (Mac only) replaces all 
instances of multiple spaces with a single 
tab character. 

• Sort (Windows only) sorts the selected 
lines in alphabetical order. 

• Unwrap Text (Windows only) removes 
hard returns from the selected lines. It is 
equivalent to holding down Shift and 
choosing Wrap Selection from the Edit 
menu. 

• Upper Case changes the selected letters to 
uppercase. 

• Lower Case changes the selected letters to 
lowercase. 

• Toggle Case (Windows only) changes the 
case of each selected letter, changing A to 
a, for instance, and b to B. 

• Word Caps (Mac)/Word Case 
(Windows) capitalizes each word in the 
selection. 

• Sentence Caps (Mac)/Sentence Case 
(Windows) capitalizes the first word in 
each selected sentence. 

IIIII 
Undo Paste •• 
Cut ·" Copy • c 
Paste •u 
Paste Rs Quotation .. 
( 11181" 

TeMI • 
Select fill •• Wrap Seletllon 
Finish Rddren Book Entry X, 
Insert Redplent • 

Rotl3 TIIMI 
Add Word Serulce _. Te.bs to Spans 
Chac.t SoeiUnq Spaces to Tabs 

Upper Case 
lower Ceaa 
Word Ceps 
Sentence Caps 

Figure 13 To apply a message plug-in to selected text 
in the Mac versions of Eudora, choose it from the 
hierarchical Message Plug-ins menu in the Edit menu. 

Figure 14 To apply a message plug-in to selected text 
in the Windows versions of Eudora, choose it from the 
hierarchical Message Plug-ins menu in the Edit menu. 

Rot13 

Rot 13 is a rather interesting, if simple, 
method of encoding text to prevent prying 
eyb. Each letter is assigned a number from 
1 to 26. Then, each number has 13 added 
to it, and if the result would be larger than 
26, it wraps around. 

So, A= 1 and Z = 26. When 13 is added to 
each, you get 14 and 1 3 (because any 
number over 26 wraps around).Then, the 
results are converted back into letters. That 
turns the 14 into an N and the 13 into an 
M. Here's an example of what it looks like: 

The fox ate popcorn. (Normal text) 

Gur sbk ngr cbcpbea. (Rot 13 text) 



Use the Skip buttons to 
skip properly spelled 
unknown words. 

Writing Messages 

Spell checking 
It would be great if we could all spell cor
rectly, but some of our brains just don't 
understand the arbitrary rules of English 
spelling. Eudora Pro for both the Mac and 
Windows comes with an integrated spelling 
checker. The Check Spelling dialog boxes are 
quite different, so flip to the next page for the 
Windows version. 

To check spelling 

1. Create an outgoing message however you 
like to get some text to check. (See Chapter 
2, "Creating Messages") 

2. From the Edit menu choose Check 
Spelling QCmdH) to bring up the Word 
Services window (Figure 1 5) . 

3. Click the Replace or Replace All buttons to 
replace a misspelled word with the 
selected word from the suggestions, or 
click the Skip or Skip All buttons to ignore 
a properly spelled unknown word. 

When the entire message has been 
checked, the dialog box disappears. The list of suggested 

replacements appears 
here, sorted alphabetically 
or by best guess. Oick a 
word in the list of 
suggestions to place it in 
the Replace with ~eld. 

The word being checked 
appears here. Click it to move 
it to the Replace with ~eld. 

The Replace with ~eld contains the suggested 
replacement for the unknown word. 

Use the Replace buttons to replace the word being 
checked with the word in the Replace with ~eld. 

ften•••••H- Use the Add button to add the word being d1ecked to the 
~~~~~;;;;;!![~ ___ _:__:i~r__j~~:., dictionary, or the Remove button to remove the Replace 

Figure I 5 Use the controls in the Word Services 
window to skip properly spelled words, replace 
incorrectly spelled words, and add words to your user 
dictionary. 

with word from the dictionary. When checked, the Quick 
checkboxes eliminate con~rmation prompts. 

The word being checked is seleaed in this preview pane, 
so you can see the context in which it's being used. 
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Chapter 3 

Spell checking 
It would be great if we could all spell cor
rectly, but some of our brains just don't 
understand the arbitrary rules of English 
spelling. Eudora Pro for both the Mac and 
Windows comes with an integrated spelling 
checker. The Check Spelling dialog boxes are 
quite different, so flip back to the previous 
page for a look at the Mac version. 

To check spelling 

1. Create an outgoing message however you 
like to get some text to check. (See Chapter 
2, "Creating Messages") 

2. From the Edit menu choose Check 
Spelling @!ill-6) to bring up the Check 
Spelling dialog box (Figure 16). 

3. Click the Change or Change all buttons to 
replace a misspelled word with the 
selected word from the suggestions, or 
click the Ignore or Ignore all buttons to 
ignore a properly spelled unknown word. 

When the message has been checked, the 
dialog box disappears. 

The suggested 
replacement word 
appears in the 

The word being 
checked appears here. 

Change To field. --+----"-·aw~i.;;t 
_.~~~-

The list of suggestions 
appears here. -----;:---'--..,.::..;,t=~ 

Oick the Options :-=-~fJE~~:f.: 
button to display the L.-.:..__;_..:..;_..:.....;:...:...!;::lL!:Ciirlliill 

Use the Ignore buttons 
to ignore properly 
spelled unknown words. 

Spelling Options 
dialog box. 

Figure 16 Use the controls in the Check Spelling dialog box 
to ignore properly spelled unknown words, change incorrecdy 
spelled words, and modify the dictionary. 
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Use the Change buttons to 
replace incorrect words with the 
ward in the Change To field. 

Use the Add button to add 
unknown words to the dictionary. 

Oick the Edit dictionary button 
to open the dictionary for editing. 



Question Wilen: 
181 A word Is uncapttallzed folloWing a period. 
181 Proper nouns are uncaplta!lzed. 
181 Words appear to to be repeated. 
0 There Is only one space alter a period 
181 There is a space before punctua tion. 
181 There are extra spaces between words. 
181 An ·a· is before a vowel or ·an· before a consonant. 

Operational preferences: 
0 Treat hyphenated-words as two words. 
181 Allow botll numbers and letters In words. 
0 View guesses Instead of alphabetic first. 
0 HTML Checking - Ignore between brackets: -.,-
0 Make a copy or disk documents til at are checked. 
0 Quit alter an Apple Events Word Services spellcheck.. 

I OK II 

Figure 17 Use the checkboxes in the Preferences 
dialog box to control how spelling checks are 
performed. 

Figure 18 Use the checkboxes in the Spelling Options 
dialog box to control how spelling checks are 
performed. 

Writing Messages 

Spell checking options 
Although the defaults should work fine in 
almost all cases, you can change a nwnber of 
settings in both the Mac and Windows ver
sions of Eudora's spelling checker. 

To change preferences 
in the Mac spelling checker 

1. When the spell checking window is 
showing, choose Preferences from the File 
menu to display the Preferences dialog 
box (Figure 17). 

2. To change a setting, check its checkbox to 
turn it on or uncheck the checkbox to 
turn it off 

3. When you're done, click the OK button to 
save your changes. 

To change preferences in 
the Windows spelling checker 

1. In the Check Spelling dialog box, click the 
Options button to display the Spelling 
Options dialog box (Figure 18). 

2. To change a setting, check its checkbox to 
turn it on or uncheck the checkbox to 
turn it off 

3. When you're done, click the OK button to 
save your changes. 
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Chapter 3 

Formatting text 
Eudora Pro enables you to use foms, fom 
styles, fom sizes, and font colors. You can also 
format your messages wilh indents. If you 
paste or drag styled text in from anomer 
message or application, Eudora Pro interprets 
it properly. 

These features can make your email much 
more attractive, and lhey're definitely useful 
in some situations. I cover me various possi
bilities in me next few pages. 

However, I caution you against using styled 
text in your email much. There are several 
problems. 

Problems with styled text 

• Styled text is not guaranteed to display 
properly or at all for your recipient unless 
he or she also uses a recent version of 
Eudora, and not even always men, 
depending on what fonts he or she has 
installed. (Figure 19). 

• Styled text makes quoting in replies more 
awkward, because Eudora doesn't use me 
> character to indicate quoted text 
(Figure 20). Instead, Eudora marks 
quoted text wilh black bars, which, 
£hough effective, can get ugly when mere 
are too many in a message. 

• Applying styles to an email message can 
be a waste of time, especially on short 
messages. I personally send and receive 
way too much email to spend valuable 
time fussing wilh how it looks. 

tl Tip 

• If you don't plan to format text in m es
sages much, you can turn off me format
ting tool bar in me Styled Text settings 
panel of me Mac version of Eudora Pro. 
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Figure 19 This message was almost unreadable on 
my Mac. Although it wasn't sent with Eudora Pro, 
it shows how styled text can be difficult to read when 
interpreted differently than was intended. 
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Figure 20 This message shows how Eudora quotes 
when styled text has been used. With a single quote like 
this, it's not too bad, but when you get a message full of 
back and forth bits of quoted text, it gets ugly fast. 



Mttstl• rlvg·tfts 
ldll Ufonll Strvkt

'-""=•<,_t_,s,.,.,o•:1•"-• --~ smolf 
"'Normtl ... 

uorvttg 
Mondo 

~liS ant UltroloiCSCondon• H 
IFutwtM .. uy 

1-----l l tl-tlk t 
Morglns 10 Juluro II .. VlfObllqut 

~~Co~lo~< !!!!~ lmptU Joonnt MT 
..lot nnt MT IM ld 
.,IOtnno MT Sm ld 
L Futuro light 

; Utnos Blotlr 
Llthos Bolo 
llthoaENtrttlght 
llthotllght 
llthoshgulor 
tOfuturo llg htObllque 
Htlt · IOid 

Figure 21 To change the font in the Mac version of 
Eudora Pro, select some text, and choose a font from 
the hierarchical Font menu in the hierarchical Text 
menu in the Edit menu. 

Figure 22 To style text in the Windows version of 
Eudora Pro, select some text, choose Font from the 
hierarchical Text menu in the Edit menu. and then make 
font, style, and color choices in the Font dialog box. 

The pop.up font menu in 
the formatting too/bar. 

I 
Jl ....... - .... ICED~~IKIA!J[!J!I!J~~ I 
Figure 23 In the Mac version of Eudora Pro, you can 
also select some text and choose a font from the pop
up font menu in the formatting toolbar, if it's showing. 

Writing Messages 

Changing the font 
You can use any of the fonts installed on your 
computer in email. Beware that if your recipi
ents don't have the same font, the m essage 
won't look the same, even if their email pro
grams can display styled text. 

To change the font (Mac) 

1. Select some text, and from the hierarchi
cal Font menu in the hierarchical Text 
menu in the Edit menu, choose a font 
(Figure 21). 

To change the font (Windows) 

1. Select some text, and from the hierarchi
cal Text menu in the Edit menu, choose 
Font to display Eudora's Font dialog box 
(Figure 22). 

2. Select a font from the Font scrolling list. 
If you wish to assign a font style as well, 
select one from the Font style scrolling 
list. To assign a color to the selection, 
choose one from the Color pop-up menu. 

3. When you're done, click OK to save your 
changes (or Cancel to forget them). 

V'Tips 

• Try to choose common fonts if you're 
going to change the font so it's more 
likely that your recipient will see the mes
sage as you intended. 

• In the Mac version of Eudora Pro, you can 
also choose a font from the formatting 
tool bar (Figure 23). 
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Chapter 3 

Changing font styles 
I think it's more effective to change font 
styles than to mess with different fonts. 
Judiciously used font styles like bold can add 
emphasis to messages without taking much 
time to create. And, if the recipient can't see 
the bold, it's no great loss. 

To change font styles 

1. Select some t~xt, and from the hierarchical 
Text menu (Figure 24) in the Edit menu, 
choose Plain, Bold (!Cmd~B/@ill-B), 
Italic (!CmdH/ ICtrl l-1), or Underline 
Q Cmd ~U / @ill-U) . 

Alternately, select some text and click one 
of the font style buttons on the formatting 
toolbar (Figure 25 and Figure 26) . 

V' Tips 

• To remove formatting, select the text and 
click the Clear Formatting button on the 
formatting toolbar or, in the Windows 
version of Eudora Pro, choose Clear 
Formatting from the hierarchical Text 
m enu in the Edit menu. 

• In the Mac version of Eudora Pro, to 
remove font and size information as well 
as styles, hold down Option when you 
click the d ear Formatting button. 

Undo Style Change 

Cut 
Copy 
Paste 
Paste As Quotation 
Clear 

xz 

X H 
ICC 
IIC U 
•• 

lPHI "'Plain 
1-- --------i Bold 

IIC T 
IIC B 
IIC I 
IIC U 

Select All 811 R 
Wrap Selection 
~lnlsh Address Book Entry 811, 1--------l 
Insert Recipient ~ IJ" Left 

Message Plug-Ins 
Add Word serulce ... 
CheckS ellln 

~ Center 
~ ~ Right 

small 
"'Normal 

Big 
Uery Big 
Mondo 

Margins 
Color 
Font 

.... rormattln Toolbar 

Figure 24 To change the font style, select some text 
and from the hierarchical Text menu in the Edit menu, 
choose the appropriate font style. 

Click the Clear 
Formatting button to 

Click the B, l, or U remove font styles. 
buttons to apply Option-dick the Clear 
bold, italic, or Formatting button to 
underline formatting remove font and size 
to the selected text information as well. 

i ----· ~~c:~~uhl~Jd~m:~gjjj~· I 
Figure 25 In the Mac version of Eudora Pro, use the 
formatting toolbar to apply or clear styles. 

Click the B,l, or U buttons 
to apply bold, italic, or 

~::(:;~~~r:;:ng to 

Click the Clear 
Formatting button 
to remove font styles. 

Figure 26 In the Windows version of Eudora Pro, use 
the formatting toolbar to apply or clear styles. 
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Figure 27 To change the color of selected text. choose 
a color from the hierarchical Color menu in the 
hierarchical Text menu in the Edit menu. 

Choose o color from 
the color pop-up menu. 

II ... _, I~IEZllD~I!l!I!II!!E!IDIII I 
Figure 28 In the Mac version of Eudora Pro, choose a 
color from the color pop-up menu to change the color 
of selected text. 

Choose a color from the 
color pop-up menu. 

Figure 29 In the Windows version of Eudora Pro, 
choose a color from the color pop-up menu to change 
the color of selected text. 

Writing Messages 

Changing font colors 
You can assign one of either five (Mac) or 
sixteen (Windows) colors to text in your 
messages. Keep in mind that your recipient 
may not have a color monitor or may be 
color-blind. 

To be honest, I can't think of a good general 
example for when you might want to use 
colored text. I'm sure there are plenty of spe
cific situations where it's useful, though, and 
you'll recognize them when they happen. 

To change font colors 

1. Select some text, and from the Color 
hierarchical menu in the Text hierarchical 
menu in the Edit menu, choose a color 
(Figure 27). 

Alternately, select some text and choose 
a color from the color pop-up menu on 
the formatting tool bar (Figure 28 and 
Figure 29). 
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Chapter 3 

Changing font sizes 
You may be used to font sizes being mea
sured in points. For instance, this is 1 0 point 
text. However, in Eudora Pro, font sizes are 
ambiguous. The Mac version offers five differ
ent sizes: Small, Normal, Big, Very Big, and 
Mondo. The Windows version provides nine 
unnamed sizes-the only commands avail
able are Smaller and Bigger, which you 
choose multiple times to move through the 
various sizes. 

To change font sizes in 
the Mac version of Eudora Pro 

1. Select some text, and from the hierarchi
cal Text menu in the Edit menu, choose a 
size (Figure 30). 

Alternately, select some text and choose a 
size from the font size pop-up menu 
(Figure 31 ) on the formatting tool bar. 

As yet another alternative, select some text 
and click the Bigger or Smaller buttons on 
the formatting toolbar. 

To change font sizes in the 
Windows version of Eudora Pro 

1. Select some text, and from the hierarchi
cal Text menu in the Edit menu, choose 
Smaller to reduce the font size or Bigger 
to increase it (Figure 3 2). 

Alternately, select some text and click the 
Bigger or Smaller buttons on the format
ting toolbar. 

V'Tip 

• If you receive a message that has the font 
size set too small to read, click the pencil 
icon in the message window to enable 
editing, select the miniature text, and 
increase its size to one that's readable. 

IDlllll 
Undo Style Change xz 
Cut X H 
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Pa•t e :lllU 
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Plain X T 
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Rdd Word Serulce ••• 
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Margins ~ 
Color ~ 
Font ~ 

,1Formott1ng Toolbar 

Figure 30 To change the font size in the Mac version 
of Eudora Pro, select some text and choose a font size 
from the hierarchical Text menu in the Edit menu. 

Use the Bigger or Smaller 
Choose a size from the buttons to increase or 
font size pop-up menu. decrease the text size. 

~ .. ,_. ....... w n:Jill~!m1llD~I!I!l!l~llll 
Figure 3 I In the Mac version of Eudora Pro, choose a 
size from the font size pop-up menu to change the size 
of selected text. Or, select some text and click the 
Bigger or Smaller buttons. 

Figure 32 To change the font size in the Windows 
version of Eudora Pro, select some text and choose 
Smaller or Bigger from the hierarchical Text menu in 
the Edit menu. 
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Figure ll To change the justification, select some text 
and from the hierarchical Text menu in the Edit menu, 
choose the desired justification. 

Select o justification by clicking 
the desired justification button. 

Figure 34 To use the formatting toolbar to change 
justification, select some text and click the desired 
justification button. In the Windows version of Eudora 
Pro, the button "presses in" to indicate the current 
justification setting. In the Mac version, the buttons 
don't change. 

Writing Messages 

Changing justification 
So far, all the formatting I've mentioned has 
been character formatting. Eudora Pro also 
provides minimal paragraph formatting via 
left, right, and center justification. 

To justify text 
1. Select some text, and from the hierarchi

cal Text menu in the Edit menu, choose 
one of the three possible justifications
Left, Center, or Right (Figure 33). 

Alternately, select some text and click 
one of the three justification buttons 
(Figure 34) on the formatting tool bar. 
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Chapter 3 

Changing indents 
Eudora Pro provides additional paragraph 
formatting via indents. The Mac version is 
limited to three levels of indents and three 
levels of hanging indents; the Windows ver
sion has no limitations. 

To modify indents 

1. Select some text, and from the hierarchi
cal Margins menu in the hierarchical Text 
me~u in the Edit menu, choose an indent 
level in the Mac version (Figure 35), or, 
in the Windows version, choose Indent In 

/ 

or Indent Out to increase or decrease the 
indent level (Figure 36). 

Alternately, select some text and click the 
increase or decrease indent buttons on the 
formatting toolbar (Figure 37) . 

To modify hanging indents 

1. Select some text, and from the Margins 
hierarchical menu in the Text hierarchical 
menu in the Edit menu, choose a hanging 
indent level in the Mac version or, in the 
Windows version, choose Hanging Indent 
In or Hanging Indent Out to increase or 
decrease the hanging indent level. 

Alternately, select some text and click the 
increase or decrease hanging indent but
tons on the formatting toolbar. 

V' Tip 

• To reset the indent or hanging indent to 
normal, choose Normal from the Margins 
hierarchical menu in the hierarchical Text 
menu in the Edit menu. Alternately, click 
the Clear Formatting button on the for
matting toolbar. 
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Figure 3 5 To increase the indent level of selected text 
in the Mac version of Eudora Pro, choose an indent 
level from the hierarchical Margins menu in the 
hierarchical Text menu in the Edit menu. 

Figure 36 To increase the indent level of selected text 
in th1e Windows version of Eudora Pro, choose an 
indeht level from the hierarchical Margins menu in the 
hier.irchical Text menu in the Edit menu. 

I 
Increase or decrease the hanging 
indent level by selecting some text 
and clicking either the increase or 
the decrease hanging indent buttons. 

Figure 37 To increase the hanging indent level of 
selected text, click the increase hanging indent button 
on the formatting tool bar. The decrease hanging indent 
button moves text back toward the left margin of 
the page. 
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Figure 38 My standard signature starts with two 
dashes, provides my name, title, email address, and links 
to some Web pages for various projects. It's a rather 
typical signature, although a little long. I change to a 
shorter signature fo r some mailing lists. 

Writing Messages 

About signatures 
It's common in email messages to include a 
signarure at the bottom (Figure 38). The sig
nature contains bits of personal information 
that you wish to include with each message. 

Possible signature items 

• Your full name, because it's not always 
clear from other parts of the message. 

• Your email address, because it's best to 
include it in case the headers of the mes
sage are munged or are confusing. 

• Your title or a description of your job, if 
you want people to know what you do. 

• A URl to your Web page or some other 
Internet resource. URLs are a bit ugly, so 
make sure the formatting works. 

• If you work on a product, a short pointer 
or advertisement for your product. We 
authors do this with our books. 

• Your phone number, but only if you want 
people calling you. I don't recommend it. 

• Your office number, if you want people in 
your organization to be able to find you 
or send you campus mail. 

• Your postal address, if you want people to 
know where you live or work. 

• A tremendously witty saying. Hey, why 
not? Just keep it short. 

vTips 
• Keep signatures short, preferably no more 

than four to six lines or so. Longer signa
rures may cause your m essages to be 
rejected by some mailing lists, and they're 
a waste of bandwidth no matter what. 

• I like starting my signarure with two 
dashes to make sure it's separate from the 
body of my message. 
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Chapter 3 

Creating and 
using signatures 
Eudora Light provides two possible signa
tures, your standard one and an alternate. 

To create a signature 

1. From the hierarchical Signatures menu in 
either the Special menu (Mac) or the Tools 
menu (Windows) choose either Standard 
or Alternate (Figure 39). 

Eudora opens a standard blank text editing 
window. 

2. Enter the signature (Figure 40). 

3. When you're done, choose Save 
QCmd)-S/@!ill-S) from the File menu to 
save your signature. 

4. From the File menu, choose Close 
0 Cmd )-W !@ill-W) or click the close box 
to close the signature window. 

To switch between signatures 

1. To switch between your signatures, 
choose one from the Signatures pop-up 
menu in the message window. On the 
Mac, it's the JH (John Hancock, get it?) 
button (Figure 41); in Windows, it's a 
normal pop-up menu (Figure42). 

tl Tips 

• If you close the signature window with
out saving first , Eudora prompts you to 

save before closing the window. 

• To see exactly what your signature looks 
like, send email to your own address. 

• Once you create a standard signature, 
Eudora automatically appends it to all 
outgoing messages unless you set it 
otherwise. 
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Figure 39 To create a signature, choose either 
Standard or Alternate from the hierarchical Signatures 
menu in the Special menu (Mac) o r Tools menu 
(Windows). 

Alternate 
Q 

Strlul1"19 t.o ore• again break six •l,..,te •llu for the: Sk . :ri: 

~ 
Figure 40 In the Signature window that appears, type 
your signature. When you're done,save the signature by 
choosing Save from the File menu. 

The signatures pop-up menu in the 
Mac version of Eudora looks like a 
button with a script JH on it 

ID~tru --~ 
Figure 4 1 To change signatures, choose one of your 
signatures from the signatures pop-up menu in the 
message window's toolbar. 

The signatures pop-up menu in 
the Windows version of Eudora 
is a normal pop-up menu. 

Figure 42 To change signatures, choose one of your 
signatures from the signatures pop-up menu in the 
message window's tool bar. 
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Figure 43 To create a custom signature in Eudora Pro, 
choose New from the hierarchical Signatures menu in 
the Special menu (Mac) or Tools menu (Windows). 

New Sl nature 

What do you wish to cell 117 
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Figure 44 Name your custom signature, then click the 
OK button. 

TidBITS Editor 
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Figure 45 Enter your signature in the text entry 
window that appears, and when you're done, save and 
close the window by choosing Save and then Close 
from the File menu. 

Writing Messages 

Custom signatures 
Eudora Pro provides the two standard signa
tures, but it also lets you create additional 
signatures, which can be helpful if you're the 
sort of person who wears many hats. 

To create custom signatures 

1. From the hierarchical Signatures menu 
in either the Special menu (Mac) or the 
Tools menu (Windows) choose New 
(Figure 43) . 

2. When prompted, enter a name for your 
custom signature (Figure 44) and click 
the OK button. 

Eudora opens a text editing window. 

3. Enter the signature (Figure 45). 

4. When you're done, choose Save 
a Cmd ~S/@!ill-S) from the File menu to 
save your signature, then choose Close 
a Cmd ~ W !@ill-W) from the File menu or 
click the dose box to dose the window. 

~/Tips 

• To del~te a custom signature in the 
Windows version of Eudora Pro, choose 
Delete from the hierarchical Signatures 
menu and select the signature to delete in 
the Delete dialog box. 

• Signatures are files stored in the Signature 
Folder (Mac) or Sigs (Windows) folder, 
located in your Eudora Folder. You can 
delete custom signatures by simply drag
ging them to the Trash on the Mac or the 
Recycle Bin in Windows. 

• You can attach specific signatures to per
sonalities in the Mac version of Eudora 
Pro. In the Personality Extras settings panel 
of the Settings/Options dialog box, 
choose an appropriate signature for each 
personality. (See Chapter I 2. "Working with 
Settings/ Options") 
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Chapter 3 

Editing signatures 
You'll undoubtedly want to change your sig
nature every now and then. I find that I tend 
to change mine when I'm travelling or on 
vacation so everyone realizes that I may not 
be as responsive as usual. 

To edit a signature 
1. From the hierarchical Signatures menu in 

either the Special menu (Mac) or the Tools 
menu (Windows) choose one of your sig
natures (Figure 46). 

Eudora opens a standard text editing win

dow with the text of the signature in it. 

2. Edit the signature (Figure 47). 

3 . When you're done, choose Save 
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Q Cmd l-S/1 Ctrl l-S) from the File menu to 
save your signature, then choose Close 
(I Cmd 1-W /I Ctrll-W) from the File menu or 
click the close box to close the window. 
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Em t Trash 

fi1 Standard 
fl. Alternate 

NBJJI,__ 

ifCISKM 

1ft Moderator 
~ JociOII\ ldotno 

Figure 46 To edit a signature, choose it from the 
hierarchical Signatures menu in the Special menu (Mac) 
or Tools menu (Windows). 
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Figure 47 Make any changes you want, and then save 
and ~lose the window by choosing Save and then Close 
frorrl the File menu. 



Writing Messages 

About attachments 
The standard ways of putting text in messages 
is fine for most messages, but sooner or later 
you'll need to send a file to a friend or col
league. Perhaps it's just a word processing 
document that could conceivably be pasted 
into a message, but what if it's a spreadsheet 
or page layout document that Eudora couldn't 
hope to display properly? And, more impor
tant, what if you want the recipient to be able 
to work on the file and return it intact? 

In this situation, you should take advantage of 
Eudora's attachment features. Any document 
on the Mac or the PC can be attached to an 
email message, much as you might use a 
paper-clip to attach a newspaper clipping to a 
normal paper letter. 

When your recipient receives the message, 
his or her email program (hopefully Eudora 
as well) saves the attachment to the hard 
disk, separate from the email message. At that 
point, it's a normal file such as could have 
been copied from a floppy disk. Of course, 
just as with any file that you might send on 
a floppy disk, the recipient must have a pro
gram that can read the file. If you send an 
Excel spreadsheet, but the recipient doesn't 
own Excel or have any other method of 
viewing the file, it's of no use. Check to make 
sure the recipient can open your file before 
sending. 

Attachments are a tremendously powerful 
tool, and one that I encourage you to use lib
erally. Whenever you're collaborating with 
someone on a project, consider if sending 
file attachments back and forth might ease 
the workload. 

In this section, I'll discuss how to add attach
ments to messages; later on we'lllook at how 
to deal with attachments you receive. 
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Chapter 3 

Attaching files 
via dialog box 
There are several methods of attaching files 
to outgoing messages. The most obvious 
method requires selecting the document in 
a file dialog box. 

To attach files via dialog box 

1. Create an outgoing message. (See Chapter 2, 
"Creating Messages") 

2. From the Message menu, choose Attach 
Document (Mac) or Attach File 
(Windows) 0Cmd~H/Ietrll-H) 
(Figure 48). 

3. In the file dialog box that appears, navi
gate to the file you want to attach, select 
it, and click the Attach (Mac) or Open 
(Windows) button (Figure 49). 

Eudora puts the name (and icon, in the 
Mac versions) of the attached file in 
the X-Attachments (Mac) or Attached 
(Windows) line in the header (Figure 50). 
Finish and queue the message as you 
would any other. 

To remove unwanted attachments 

1. Select the attachment by clicking it (you 
only have to insert the cursor in the name 
in the Windows versions of Eudora) . 

2. Press the Delete key to remove the attach
ment from the message (but not from the 
hard disk!) 

tl Tips 

• In the Windows versions of Eudora, you 
can choose Attach File to New Message 
from the Message menu if you don't 
already have an outgoing message open. 

• In the Mac versions of Eudora, you can 
also delete attachments by dragging them 
to the Trash can in the Finder. 
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Figure 48 To attach a file to an outgoing email 
message, choose Attach File (Windows) or Attach 
Document (Mac) from the Message menu. 

Figure 49 Select the file to attach and click the Open 
button (Windows) or the Attach button (Mac). 
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graphic. 

ehoor :J . .. - Adam. 

Figure SO The attachment shows up in the Attached 
line (Windows) or the X-Attachments line (Mac) in the 
header of the message. 
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Figure 5 I To create a new message and attach a file to 
it, drag the file onto the Eudora icon in either the 
Macintosh Finder or the Windows desktop. 
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Figure 52 Eudora creates a new message, attaches the 
file (and in the Mac versions of Eudora, puts the name 
of the file in the Subject line as well). 
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Figure 53 To attach a file to an existing outgoing 
message, drop the file's icon on the message window. 
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Figure 54 Eudora attaches files that you drop on a 
message window to that message. 

Writing Messages 

Attaching files 
via drag-and-drop 
An easier way of attaching files to messages 
involves using the mouse to drag the files 
onto Eudora's icon or onto a message 
window. 

To create a new 
message and attach a file 

1. From the Macintosh Finder or the 
Windows desktop, drag one or more files 
onto the icon for the Eudora program 
(Figure 51). 

Eudora creates a new outgoing message 
and attaches the file(s) to it (Figure 52) . 

To attach a file to an 
existing outgoing message 

1. Create a new outgoing message and fill it 
in. (See Chapter 2, "Creating Messages") 

2. From the Macintosh Finder or the 
Windows desktop, drag one or more files 
onto the outgoing message window 
(Figure 53) . 

Eudora attaches the file(s) to the outgoing 
message (Figure 54). 

V'Tips 

• It's easier to drag a file onto Eudora's icon 
if you put an alias (Mac) or a shortcut 
(Windows) to Eudora on your desktop. 

• If you have an outgoing message window 
open and drag a file onto Eudora, the Mac 
versions attach the file to that message, 
whereas the Windows versions attach the 
file to a new outgoing message. 

• In Windows, if'your outgoing m essage 
window is obscured, drag the file onto the 
Eudora icon on the Task bar and wait. 
Windows brings Eudora to the front so 
you can drop the file on the message. 
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Chapter 3 

Attachment formats 
Email attachments can't survive the journey 
to the recipient without being specially 
encoded. Think of them as needing envelopes. 
Unfortunately, there are several encoding 
formats (Figure 55a and Figure 55b), and 
you may have to choose a non-standard one 
to send attachments to old email programs 
successfully. 

Attachment encoding formats 

• Use AppleDouble (Mac)/MIME 
(Windows) for most messages. They are 
the best choice for other people using 
Eudora and for everyone using recent 
email programs. 

• Use AppleSingle (Mac only) for sending 
Mac-specific files (particularly applica
tions) to other Mac users. Try AppleDouble 
first. 

• Use BinHex for Mac users with old email 
programs. 

• Use Uuencode (all but Mac Eudora Light) 
when sending documents (never Mac 
applications) to people with old email 
programs, particularly on the PC. Mac files 
have two "forks," and Uuencode only 
sends the "data fork," which means that 
any Mac file with information in the 
"resource fork" will be destroyed in trans
mission. 

V' Tips 

• Always test with a small attachment before 
assuming that attachments will get 
through to a specific person. 

• When sending attachments to America 
Online users, send only one file per mes
sage or the later ones may be damaged. 

s6 

.,... G RppleDouble 

G RppleSingle 
:8: BlnHeH 

~ Uuencode Data Fork 

Figure 55a/55b Eudora offers a number of encoding 
formats for attachments. Generally stick with 
AppleDouble on the Mac and MIME in Windows, but be 
prepared to try another encoding format if your 
attachments arrive damaged in your recipient's mailbox. 

Attachment strategies 

H~e's how I figure out how to send 
attachments to someone for the first time. 

I 

1. First, I try AppleDouble or MIME. That 
usually works. 

2 Next, ifl'm sending to a Mac user, I try 
BinHex, and if I'm sending to a PC 
user, I try Uuencode. In particular, if 
my recipient uses the cc:Mail email 
program on the PC, Uuencode usually 
works, whereas BinHex works for 
cc:Mail on the Mac. 

3. If all else fails, I talk to my recipients to 
figure out precisely what they're using 
and what's going wrong, in the hope 
that will provide some clues about the 
next thing to try. 

Every now and then, attachments sim
ply don't work, and at that point, I try 

1 an alternate method of transferring the 
I files, such as FfP or the Web. 



Priority menu 
Signatures menu 

Encoding format menu 

Figure 56 Use the pop-up message option menus in 
the Mac version's message window tool bar to change 
message options. 

Priority menu 
Signatures menu 

Encoding format menu 

Figure 57 Use the pop-up message option menus in 
the Windows version's message window tool bar to 
change message options. 
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Figure 58 To change the priority of a message, choose 
the desired priority from the priority pop-up menu in 
the message window's toolbar. 
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Figure 59 To select a different signature for a specific 
message, choose the desired one from the signatures 
pop-up menu in the message window's toolbar. 

"'G RppleDouble 
d RppleSing le 
:~ BlnHeH 
~. Uuencode Onto Fork 

Figure 60 To change the attachment encoding format 
for a specific message and its attachment, choose the 
desired format from the encoding format pop-up menu 
in the message window's toolbar. 

Writing Messages 

Outgoing message 
toolbar menus 
Every outgoing message window has a tool
bar with several menus (Figure 56 and 
Figure 57) that control various options, 
including message priority, signature, and 
attachment format. 

To change message priority 

1. From the priority pop-up menu 
(Figure 58) in the message window tool
bar, choose the appropriate priority. 
(See Chapter 5, "Working with Messages") 

To select a signature 

1. From the signatures pop-up menu 
(Figure 59) in the message window tool
bar, choose the appropriate signature. 

To select an attachment format 

1. From the attachment encoding format 
pop-up menu (Figure 60) in the message 
window toolbar, choose the appropriate 
encoding format. 

II' Tips 

• Keep in mind that not all email programs 
honor your priority settings. 

• Eudora defaults to Normal priority for 
all email messages. Change priorities 
sparingly for best effect. 

• You can also change the message priority 
settings from the hierarchical Priority 
menu in the hierarchical Change menu in 
the Message menu. 

• Eudora defaults to AppleDouble (Mac) 
or MIME (Windows) for the attachment 
encoding format, but you can change the 
default in the Attachments settings panel 
of the Settings/ Options dialog box. 
(See Chapter 12, "Working with Settings/Options") 
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Chapter 3 

Outgoing message 
toolbar buttons 
Eudora lets you change other settings on a 
per-message basis by clicking buttons in the 
outgoing message window's toolbar. The Mac 
versions (Figure 61) consider these buttons 
On if they have a checkmark next to them. 
The Windows versions (Figure 62) display 
On by having the buttons "pressed in." 

Message option buttons 

• Quoted-Printable helps messages with 
long lines or special characters come 
through intact. Always leave it on. 

• Macintosh Info (Mac only) controls 
whether or not Eudora includes 
Macintosh resources and types in attach
m ents. Leave it on. 

• Word Wrap controls whether or not 
Eudora inserts returns at the end of every 
line when sending. Generally leave it on. 

• Keep Copies ensures that outgoing mes
sages remain in your Out box after they're 
sent. Leave it on for a record of your mail. 

• Return Receipt (Eudora Pro only), when 
on, asks the recipient to confirm receipt. It 
doesn't work with many email programs. 

• Text as Attachment (Windows only) 
sends text file attachments in message 
bodies, rather than as separate files. 

• Tabs in Body (Windows only) enables 
you to type tabs in messages. If it's off, the 
Tab key navigates in the header and body 
of the message. 

ss 

Quoted-Printable 

Macintosh Info 
Word Wrap 

Keep Copies 
Return Receipt 

Figure 61 The message option buttons in the Mac 
version's message window toolbar. Options are 
considered to be On when a checkmark appears next 
to the button. 

Quoted-Printable 
Text as Attachment 

Word Wrap 
Tabs in Body 

Keep Copies 
Return Receipt 

Figure 62 The message option buttons in the 
Windows version's message window toolbar. Options 
are considered to be On when the buttons look 
"pressed in," as does the QP button above. 

About return receipts 

Eudora Pro does return receipts "right." 
They're not nearly as simple as you might 
think. For instance, does a return receipt 
mean that the recipient has received the 
message, read the message, understood the 
message, or acted on the message? 

Because of this problem, Eudora Pro 
requires users to click a button on an 
inaorning message to acknowledge 
reqeipt. Eudora Pro then generates an 
automatic message noting that the user has 
diJplayed the message--nothing more, 

normg less. 



Figure 63 To record or play sounds with Pure Voice, 
you use the Pure Voice application. 
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Figure 64 To attach a voice recording to a new 
message, create an outgoing message, then choose 
Pure Voice from the hierarchical Attach menu in the 
Message menu. 

Writing Messages 

PureVoice plug-in 
Qualcomm recently began shipping Eudora 
with a plug-in called Pure Voice that enables 
you to add voice messages to your email as 
attachments. 

The Pure Voice application (Figure 63), 
which is what you use to record or play the 
voice messages, is completely separate from 
Eudora, except for the fact that you can attach 
a recording to a message by choosing 
PureVoice from the hierarchical Attach menu 
in the Message menu (Figure 64) . 

Pure Voice is simple to use and comes with 
extensive online help available from the 
Guide menu (Mac) or the Help menu 
(Windows) when you have the Pure Voice 
application active. 

Pure Voice has been available for a only short 
time, so it remains to be seen how people 
take to it. Here are a few thoughts about it, 
based on some early use. 

Thoughts about PureVoice 

• Technically, Pure Voice is extremely 
impressive. The sound quality is almost as 
good as normal telephones, and the file 
sizes are quite small. Usually, high quality 
audio is accompanied by huge flle sizes. 

• I found that using Pure Voice has the same 
feel as talking to an answering machine. 
My telephone manners kicked in instinc
tively, which seemed awkward, but there's 
no social convention for voice email yet. 

• Voice email isn't as flexible or useful as 
normal text email in many ways. You can't 
quote original text for context; you can't 
edit what you've said; you can't copy and 
paste text from the message; you can't 
search through voice email messages; and 
you can't refer back to only a portion of a 
message. But it's still a neat trick! 
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Chapter 3 

PGP plug-in 
Qualcomm has also just started shipping 
Eudora with a plug-in called PGP that enables 
you to encrypt, decrypt, sign, and verify 
messages. PGP stands for Pretty Good Privacy 
and is the name of the company that created 
the PGP plug-in and its related PGPkeys 
application. 

Entire books could be written about PGP and 
the field of cryptography, but suffice it to say 
that you can encrypt messages (Figure 65) so 
no one but the recipient can decrypt them 
(Figure 66) . PGP is considered "strong" 
encryption and cannot currently be broken. 
You can also use PGP to sign a message so the 
recipient can verify that you are the sender. 

It takes some work to understand how cryp
tography and PGP work, and I recommend 
you start with the online documentation that 
comes with PGP. It should answer your basic 
questions and show you how to use PGP in 
conjunction vdth Eudora. 

Thoughts about PGP 

• The PGP package that is integrated into 
Eudora is the easiest method I've seen for 
working with cryptographic software. 
Previous programs were extremely. diffi
cult to use, so much so that few people 
bothered. 

• Normal email is not guaranteed to be 
private, so something like PGP is the only 
way to be sure that no one but the recipi
ent vrui read a given message. 

• To use PGP's encryption, both you and 
your recipient must have PGP. Ask before 
sending encrypted messages to someone. 
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Figu re 65 To encrypt and sign a message, click the 
encryption and signing buttons in the outgoing message 
window's toolbar so they're checked (Mac) or pressed 
in (Windows). 
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Figure 66 To decrypt or verify an encrypted or signed 
message in the Windows versions of Eudora, click the 
decryption button in the toolbar. ln the Mac versions 
of Eudora, choose PGP DecryptNerify from the 
hierarchical Message Plug-ins menu in the Edit menu. 



SENDING AND 

RECEIVING MESSAGES 
In the last two chapters, we've looked at dif
ferent ways of creating messages and adding 
content to them. Throughout those chapters, 
when you finished creating a message, I said 
to queue the message for later delivery by 
clicking the Queue button. That marks the 
message as being ready to send when Eudora 
next sends messages. 

Eudora is happy to work when you're not 
connected to the Internet, but that means you 
need ways to send and receive messages once 
you connect to the Internet. And to reiterate, 
you must be connected to the Internet to send 
and receive messages. 

Eudora's Check Mail command is generally 
more than sufficient to send and receive mes
sages, as long as you set the option that has 
Eudora send queued messages when it checks 
for new incoming messages. However, Eudora 
offers numerous ways to send and receive 
messages that you can tailor to your needs. 

For instance, perhaps you want to send a 
message immediately, or send queued mes
sages without receiving incoming ones. Or, 
maybe you want Eudora to check for mail 
every few minutes. You can even have Eudora 
queue a message and send it automatically 
several days later. It's all up to you, so let's 
look at the details now. 
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Chapter 4 

Sending queued 
messages 
After you've created and queued one or more 
outgoing messages, you probably want to 
send them. In essence, this is like putting a 
bunch ofletters in your mailbox and then 
ringing a bell to have the mail carrier sud
denly arrive to pick up the letters. 

To send queued messages 

1. From the File menu, choose Send Queued 
Messages (!Cmd~-/@!ill-T) (Figure 1). 
If necessary, Eudora establishes an Internet 
connection, and then connects to your 
SMTP server and sends the queued mes
sages, providing a progress dialog box so 
you can see what's happening (Figure 2). 

II Tips 

• The keyboard shortcuts for this process 
are different between the Mac and 
Windows versions of Eudora because 
Eudora Pro on the Mac has to use I Cmd ~ T 
as the keyboard shortcut for Plain-it's a 
standard Macintosh keyboard shortcut. 

• Bear in mind that sending queued mes
sages does only that; it won't also check 
for new incoming message. For that, you 
must use the Check Mail command in the 
File menu. (See "Checking for incoming messages" 
in this chapter) 
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Figure I To send queued messages, choose Send 
Queued Messages from the File menu. 

Figure 2 Eudora displays a progress dialog box while 
sending queued messages to your SMTP server. 
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Figure 3 To send a message immediately, just queue 
it normally and choose Send Queued Messages from 
the File menu right after queueing the message. Simple, 
yet effective. 
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Figure 4 Alternately, choose Queueing from the 
hierarchical Change menu in the Message menu to 
bring up the Change Queueing dialog box. 

send mess~:~ge: 

®Right Now 

Q NBHt Time Queued MessDges Dre Sent 

0 On or Dfter: 
Time: [ltltlliQ 

DDte: 17/4/97 

QDon't Send 

( Cancel ) H OK D 

Figure 5 Make sure the Right Now radio button is 
selected and click the OK button to send your message 
(and all other queued messages) immediately. 

Sending and Receiving Messages 

Sending messages 
immediately 
Sometimes you may want a message to go 
out immediately after you've finished writing 
it. Although Eudora has a special feature for 
sending messages immediately (II below), it 
turns out to be easier to use the standard way 
of queueing and sending messages manually 
(I below). 

To send a message immediately (I) 

1. Create a new outgoing message. (See 
Chapter 2, "Creating Me5sages") 

2. Click the Queue button QCmd~E/ICtrl ~E). 

3. Immediately, choose Send Queued 
Messages 0 Cmd 1--II Ctrll-T) from the File 
menu to send your message, along with 
any other queued messages (Figure 3). 

To send a 
message immediately (II) 

1. Create a new outgoing message. (See 
Chapter 2, "Creating Messages") 

2. From the hierarchical Change menu 
in the Message menu, choose Queueing 
(Figure 4) to bring up the Change 
Queueing dialog box. 

Alternately. hold down Option (Mac) 
or Shift (Windows) and click the Queue 
button (ICmdi-JOptionl-E/ICtrl HShifti-E) 
to bring up the Change Queueing 
dialog box. 

3. Make sure the Right Now radio button is 
selected (it is by default) (Figure 5). 

4. Click the OK button to send the message, 
along with all other queued messages. 

II Tip 

• There's no way to send just one of several 
queued messages. 
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Sending messages 
at a later date or time 
Normally, you want outgoing messages to be 
sent either immediately or with the next 
batch of queued messages. Occasionally, how
ever, you may want a specific message to go 
out after a certain date or time. 

To send a message 
at a later date or time 

1. Create a new outgoing message. (See 
Chapter 2, "Creating Messages") 

2. From the hierarchical Change menu in the 
Message menu, choose Queueing to bring 
up the Change Queueing dialog box. 

Alternately, hold down Option (Mac) or 
Shift (Windows) and click the Queue but
ton (ICmd)-IOption~E/ICtrl HShift~E) to dis
play the Change Queueing dialog box. 

3. Select the On or after radio button and 
change the time and date fields as needed 
(Figure 6). 

4. Click the OK button to queue the message 
for later sending. 

Eudora saves the message in your Out box 
and marks it with aT in the message status 
column (Figure 7). Eudora sends the 
message the next time queued messages 
go out after the specified date and time. 

VTips 

• Eudora doesn't automatically send the 
message at the specified time; there must 
be some other action that causes queued 
messages to be sent (such as choosing 
Send Queued Messages from the File 
menu). 

• You can change the queueing for a post
poned message if you decide you want it 
to be delivered sooner. 

Change Queueing IEJ 

Figure 6 To send a message at a later date or time, 
choose Queueing from the hierarchical Change menu 
in the Message menu, select the On or after radio 
button, and enter the desired sending time and date. 

Figure 7 The last message in the Out box has aT in 
the status column at the very left. 

Email reminders 

I use Eudora's capability to send mail later 
to remind someone or even myself of 
something that must happen in several 
dah or weeks. If I sent the email too far 
ah~bad of time, the message might be lost 
or forgotten. Ensuring that the message 

ives shortly before the task must be 
peiformed works better. Of course, this 
only works with people who read email 
religiously. 
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Figure 8 To prevent a message from being sent, first 
choose Queueing from the hierarchical Change menu 
in the Message menu. 

Send message: 

0 Right Now 

0 NeKt Time Queued Messages are Sent 

0 On or after. 

Time: 

® Don' t Send 

Figure 9 In the Change Queueing dialog box, select 
the Don't Send radio button and click the OK button. 

... -

Figure I 0 Notice the last message in the Out box, 
which has a • in the status column at the very left. 

Sending and Receiving Messages 

Preventing a message 
from being sent 
Sometimes, when you're working on an espe
cially complicated or important message, you 
may want to save it without sending. That's 
easy-just choose Save (ICmdl-S/(Ctrll-S) from 
the File menu at any time. But what if you 
queue a message and then decide you don't 
want to send it the next time queued messages 
go out? 

To prevent a message from 
being sent 

1. Open or select the message you don't 
want to send. (See Chapter 5, "Working with 
Message() 

2. From the hierarchical Change menu in the 
Message menu, choose Queueing 
(Figure 8) to bring up the Change 
Queueing dialog box. 

Alternately, hold down Option (Mac) or 
Shift (Windows) and click the Queue but
ton acmdHOption~E/ICtrl HShift~E) to 
display the Change Queueing dialog box. 

3 . Select the Don't Send radio button 
(Figure 9) . 

4 . Click the OK button. 

Eudora saves the message in your Out box 
and marks it with a • in the message status 
column (Figure 10) . Eudora won't send 
the message next time queued messages 
go out. 

II Tips 

• To continue editing your message, 
double-click it in the Out box, or select it 
in the Out box and press Return/Enter. 

• When you do want to send your message, 
click the Queue button dCmdj-E/ @!ill-E) 
as you would normally. 
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Checking for 
incoming messages 
Enough on sending messages! How do you 
retrieve incoming messages that others have 
sent to you? Those incoming messages wait 
on your POP server until you connect to pick 
them up. 

To check for incoming messages 

1. From the File menu, choose Check Mail 
QCmd l-M/@jill-M) (Figure 11). 

If necessary, Eudora establishes an Internet 
connection, and then connects to your 
POP server and receives waiting messages. 
A progress dialog box shows you what's 
happening (Figure 12) . 

Eudora places incoming messages in 
your In box and then runs any filters 
you've created on the incoming messages. 
(See Chapter 7, "Working with Filters") 

II' Tip 

• I strongly recommend that you check 
the "Send on ch~ck" checkbox in the 
Checking Mail (Figure 15 on the next 
page) or Sending Mail settings panels. 
This will ensure that Eudora sends 
queued messages whenever you choose 
Check Mail. Otherwise, you can forget to 
send queued messages for some time. 
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Figure I I To check for incoming messages, choose 
Check Mail from the File menu. 

Figure 12 Eudora displays a progress dialog box while 
retrieving messages from your POP server. 
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Figure 13 To check for messages periodically, first 
open the Settings/Options dialog box by choosing 
Settings from the Special menu (Mac) or Options from 
the Tools menu (Windows). 
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Figure 14 The Settings/Options dialog box remembers 
your last choice of panels in the left-hand column but 
initially defaults to the Getting Started panel. Click 
Checking Mail to view the Checking Mail panel. 
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Figure I 5 Check the "Check for mail every X 
minutes" checkbox, and enter the number of minutes. I 
set Eudora to check for messages every two hours. 

Sending and Receiving Messages 

Checking for incoming 
messag~s periodically 
If you have a permanent Internet connection, 
or if you don't mind connecting to the 
Internet regularly, you can have Eudora check 
for messages on a periodic basis. 

To check for messages on a 
periodic basis 

1. From the Special menu (Mac) or Tools 
menu (Windows), choose Settings (Mac) 
(Figure 13) or Options (Windows) to 
bring up the Settings/Options dialog box 
(Figure 14) . 

2. Click Checking Mail in the left column to 
bring up the Checking Mail settings panel. 

3. Check the "Check for mail every X min
utes" checkbox and enter the nwnber of 
minutes between checks in the text-entry 
field (Figure 1 5) . 

From then on, Eudora checks for incom
ing messages on that schedule. 

V' Tips 

• Macintosh PowerBook users should check 
the "Don't check when using battery" 
checkbox to eliminate message checks 
when the PowerBook isn't plugged in. 

• To send queued messages during Eudora's 
automatic mail checks, check the "Send 
on check" checkbox in the Checking Mail 
or Sending Mail settings panels. 

• To prevent the Mac versions of Eudora 
from checking for new mail automatically 
when you launch Eudora, hold down Shift 
until Eudora finishes launching. 

• Setting Eudora to check for messages peri
odically can prevent disconnects if your 
Internet service provider disconnects you 
after only a short amount of idle time. 
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About messages 
left on the server 
Before I talk about some of Eudora's other 
mail checking features, let me explain more 
about how Eudora interacts with your POP 
server, where incoming messages wait to be 
retrieved. 

Normally, after Eudora retrieves a message 
from the server, it deletes the message from 
the server. However, that's not required, and 
there are several reasons why a message may 
remain on the server after Eudora has 
retrieved it. 

• You set Eudora to leave all messages on 
the server after retrieving them. 

• You set Eudora to skip messages over a 
certain size, and you've received one or 
more that are too large. 

• You asked Eudora Pro to retrieve only 
message headers. 

In any of these situations, Eudora checks old 
messages left on the server on each mail 
check to see what it should do with them, 
and after that retrieves any new messages that 
are waiting. Eudora can do one of three 
things with a message left on the server. 

• Continue to leave it on the server until 
something changes. 

• Retrieve the entire message, if only the 
first part had been retrieved previously 
and you asked Eudora to retrieve the 
entire thing. Eudora deletes the message 
from the server after retrieving it. 

• Delete the message from the server with
out retrieving it, either because you 
explicidy asked Eudora to do so, or 
because you had put the message in your 
Trash mailbox and emptied the Trash 
(with a specific setting turned on). 
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Figure 16 To leave messages on the server, first open 
the Settings/Options dialog box by choosing Options 
from the Tools menu (Windows) or Settings from the 
Special menu (Mac). 

Figure 17 The Settings/Options dialog box remembers 
your last choice of panels in the left-hand column, but 
initially defaults to the Getting Started panel. Click 
Checking Mail to view the Checking Mail panel. 
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Figure 18 Check the "Leave mail on server" and 
"Delete· from server after X days" checkboxes, and 
enter the number of days. 

Sending and Receiving Messages 

Leaving mail 
on the server 
Managing email that you access from two 
locations (say work and home) can be diffi
cult. To simplify the situation, leave the mail 
that you read at home on the server so that 
when you next check from work, the mail is 
downloaded again (and then deleted from the 
server). Then you can store or otherwise deal 
with work email at work. 

To check for new messages 
but leave them on the server 

1. From the Special menu (Mac) or Tools 
menu (Windows), choose Settings (Mac) 
or Options (Windows) (Figure 16) to 
bring up the Settings/Options dialog box 
(Figure 1 7) . 

2. Click Checking Mail in the left column to 
bring up the Checking Mail settings panel. 

3. In the Windows versions of Eudora, check 
the "Leave mail on server" and "Delete 
from server after X days" checkboxes and 
enter the number of days in the text-entry 
field (Figure 18). In the Mac versions, the 
"Leave on server for X days" checkbox 
performs both functions. 

From then on, when (and however) 
Eudora retrieves incoming messages, it 
won't delete them from the server until 
the specified number of days have passed. 

tl Tips 

• To delete messages left on the server, 
check the "Delete from server when emp
tied from Trash" checkbox. After reading 
the m essages, delete them, and choose 
Empty Trash from the Special menu. 

• To leave messages on the server forever in 
the Mac versions of Eudora, leave the 
number of days blank. 
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Retrieving only 
small messages 
People are sometimes inconsiderate in 
sending massive attachments in email, and 
waiting for Eudora to bring in a large attach
ment may be frustrating, especially over a 
slow Internet connection or when you're 
travelling. You can minimize this problem by 
skipping messages that are larger than you 
want to download. I skip messages over 40K 
while travelling and over 1 OOOK at home. 

To retrieve only small messages 

1. From the Special menu (Mac) or Tools 
menu (Windows), choose Settings (Mac) 
or Options (Windows) to bring up the 
Settings/ Options dialog box. 

2. Click Checking Mail in the left column to 
bring up the Checking Mail settings panel. 

3. Check the "Skip messages over X K" 
checkbox and enter in the text-entry field 
the maximum acceptable size for mes
sages, measured in kilobytes (Figure 19). 

From then on, Eudora retrieves only the 
headers and first few lines of too-large 
messages (Figure 20). 

To retrieve a large message 

1. In the message window that informs you 
of the too-large message, click the Fetch 
(down arrow) button (Figure 21) . 

2. From the File menu, choose Check Mail to 
ask Eudora to retrieve the entire message 
and delete it from the server afterwards. 

To delete a large message 

1. In the message window that informs you 
of the too-large message, click the trash 
can button (Figure 22) . 

2. From the File menu, choose Check Mail to 
ask Eudora to delete the message. 
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Figure 19 To retrieve only small messages, check the 
"Skip messages over X K" checkbox and enter the 
maximum acceptable size (in kilobytes) in the text
entry field. 
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Figure 20 Eudora displays the header and fi rst few 
lines I f the body of the message. 

Click the Fetch button and choose 
Check Mail to retrieve a large message. 
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Figure 21 To retrieve a large message for which you've 
received only the first bit, click the Fetch button and 
choose Check Mail from the File menu. 

Click the trash can button and choose 
Check Mail to delete a large message 
from the server without reading it 

~--, ........ ... , .. .. _ .. . 
Figure 22 To delete a large message from the server, 
click the trash can button and choose Check Mail from 
the File menu. 
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Figure 23 To bring up the Mail Transfer Options dialog 
box, hold down Option (Mac) or Shift (Windows) and 
choose Check Mail Specially (Mac) or Check Mail 
(Windows) from the File menu. 

Selea one or more of 
your personalities in this 
list to send or receive 
messages for the 
seleaed personalities. 

I 

These four options 
duplicate Eudora Pro's 
standard behaviors, but 
you con octivote any of 
them independently here. 
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Sending and Receiving Messages 

Special mail 
transfer options 
Eudora Pro users have even more options for 
sending and receiving messages. For the most 
part, these options are fairly esoteric, but in 
the right situation, they are invaluable. 

To use special 
mail transfer options 

1. In the Mac version of Eudora Pro, hold 
down Option and choose Check Mail 
Specially ([CmdHOption~M) from the File 
menu. In the Windows version of Eudora 
Pro, hold down Shift and choose Check 
MailQCtrl HShift~M) from the File menu 
(Figure 23). 

Eudora displays the Mail Transfer Options 
dialog box (Figure 24). The Windows ver
sion of the dialog box looks a bit different 
but contains the same options. 

2. Select the desired options and click the OK 
button to check mail with those options. 

tl Tip 
• Using the Option or Shift key to bring up 

the Mail Transfer Options dialog box also 
works with Send Queued Messages 
(ICmdJ-IOption~-/[Ctrl )-[Shift)-T) in the File 
menu (the Mac version changes to Send 
:tv):essages Specially). The only difference 
lies in the checkboxes that are selected by 
default. 
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Figure 24 The Mail Transfer Options dialog box 
provides numerous tweaky options for sending and 

few lines of messages. It's good for quick moil 
checks when lots of moil is wailing, but note thot 
filters don't operate on these messages. 

receiving messages. 
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WORKING 

WITH MESSAGES 
Ironically, the functions in Eudora that we've 
looked at so far aren't what you'll spend most 
of your time using. Most people receive much 
more mail than they send, and they spend 
much more time reading messages than cre
ating new ones or even replying to old ones. 

The ways you work with incoming messages 
is where Eudora streaks ahead of other email 
programs. The features may not seem unique, 
but with interfaces that you use so frequently, 
the devil is in the details. 

The sneaky ways that Eudora makes your life 
easier abound. For instance, deleting a mes
sage can immediately bring up either the next 
message in the mailbox or the next unread 
message. A single key (you'll have to read on 
to find out which one) scrolls the text in the 
current window, and then, when it reaches 
the bottom, takes you to the next message. 
Double-clicking a URL (Uniform Resource 
Locator, the address of a Web page or other 
Internet resource) launches your favorite Web 
browser and takes you there. Or, double
clicking an attachment icon opens the 
attachment in the appropriate program. 

I could go on for a long time, but let's save 
som ething for the rest of the. chapter. 
Onward, then! 
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Chapters 

Selecting messages 
Selecting messages is simple, but Eudora 
provides a variety of ways to do so. 

Methods of selecting messages 

• To select a single message, click a message 
summary in a mailbox (Figure 1). 

• To select a range of messages, click a mes
sage summary to select it, then hold down 
Shift and click another message summary 
in the same mailbox (Figure 2). 

• To select a set of messages even if they 
aren't next to one another, hold down 
Command (Mac) or Control (Windows) 
and click several message summaries in a 
mailbox (Figure 3) . 

• To select all messages in a mailbox whose 
contents of a column in the message sum
mary are the same, hold down Option 
(Mac) or Alt (Windows) and click a col
umn in a message summary (Figure 4). 
For instance, click the Sender column of a 
specific message summary to select all 
messages sent by that person. 

• In the Mac versions of Eudora, when a 
mailbox is sorted by Sender or Subject, 
type the first few characters of the sender's 
name or message subject to select that 
message. 

V' Tips 

• The Option/ All-clicking way of selecting 
messages is great for selecting all messages 
with the same subject, from the same 
sender, with the same priority, or so on. 

• When you Option/ Alt-click to select sim
ilar messages, the Mac versions move the 
selected messages together into a group in 
the mailbox. The Windows versions 
merely select all the similar messages. 
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Figure I To select a message, click its message 
summary. 

Figu're 2 To select a range of messages, click a message 
summary, hold down Shift, and click another message 
summary. 
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Figure 3 To select multiple noncontiguous messages, 
hold down Control (Windows) or Command (Mac) 
and click the desired message summaries. 
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Figure 4 To select all messages in a mailbox whose 
contents of a message summary column are the same, 
hold1down Alt (Windows) or Option (Mac) and click a 
column in a message summary. Here I've Alt-clicked the 
Subject column of a message to select all other 
messages with the same subject. 
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Figure 5 To open one or more selected messages, 
choose Open Selection from the File menu in the Mac 
versions of Eudora. 

Figure 6 You can set filters to open messages 
automatically. 
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Figure 7 Eudora can automatically open messages 
after you transfer, delete, or page past the current 
message. 

Working with Messages 

Opening messages 
Once you've selected one or more messages, 
you'll undoubtedly want to open them. 
Eudora provides numerous ways of opening 
messages-you'll probably use different ones 
in different situations. 

Methods of opening messages 

• Double-dick a message in a mailbox to 
open its message window. 

• Select a message, then press Return/Enter 
or the Spacebar to open it. 

• Select several messages, then press 
Return/Enter or the Spacebar, or double
click one of the selected messages to open 
all of them. 

• In the Mac versions of Eudora, select one 
or more messages, then choose Open 
Selection from the File menu (Figure 5) 
to open all the selected messages. 

• Set a filter to open messages that it 
matches (Figure 6). (See Chapter 7, "Working 
with Filters") 

• Set Eudora to open the next message or 
next unread messag~ after transferring, 
deleting, or paging past the end of the 
current message. This setting is in the 
Moving Around (Mac) (Figure 7) or 
Miscellaneous (Windows) settings panel. 
(See Chapter 12, "Working with Settings/ Options") 

V'Tip 

• You can switch berween message (and 
mailbox) windows that are already open 
by choosing them from the Windows 
menu. The Windows m enu also contains 
commands for managing window display, 
such as Send to Back, and-in the 
Windows versions of Eudora--cascade, 
Tile Horizontal, Tile Vertical, and Arrange 
Icons (for minimized windows). 
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Chapter 5 

Changing 
message priority 
You can change the message priority for 
incoming messages. You might want to do 
this to organize messages by importance. 

To change message priority (I) 

1. Open a message, and then choose a prior
ity from the priority pop-up menu in the 
message window (Figure 8). 

To change message priority (II) 

1. In the Mac versions of Eudora, select one 
or more messages in a mailbox, then 
move the cursor over the priority column 
(the second one from the left). When the 
cursor changes to look hke a menu, chck 
and hold to display the priority pop-up 
menu from which you can choose a pri
ority (Figure 9). 

In the Windows versions, right-chck one 
or more selected messages to display a 
pop-up menu with a hierarchical Change 
Priority menu from which you can 
choose a priority (Figure 1 0). 

To change message priority (Ill) 

1. Open a message or select one or more 
messages, then choose a priority from the 
hierarchical Priority menu in the hierar
chical Change menu in the Message menu 
(Figure 11 ). 

II Tips 

• Message priorities are primarily for your 
personal use, although they can carry 
through to replies if you set Eudora to 
copy the original's priority to the reply in 
the Replying settings panel. 

• You can also use fllters to change message 
priorities. (See Chapter 7, "Working with Filters") 

Figure 8 To change the priority of a message, choose a 
priority from the priority pop-up menu in the message 
window. 

Figure 9 In the Mac versions of Eudora, move the 
cursor over the priority column in a mailbox, and when 
it changes to a menu cursor, click to bring up a menu 
from

1 
which you can choose a priority. 

Figure I 0 In the Windows versions of Eudora, right
click one or more selected messages to bring up a pop
up menu with a hierarchical Change Priority menu from 
which you can choose a priority. 
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Figure I I You can also open a message or select one 
or more messages and then choose a priority from the 
hierarchical Prio rity menu in the hierarchical Change 
menu in the Message menu. 
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Figure I 2 in the Mac version of Eudora Pro, move the 
cursor over the label column in a mailbox and when it 
changes to a menu cursor, click to bring up a menu 
from which you can choose a label. 

Figure 13 In the Windows version of Eudora Pro, 
right-click one or more selected messages to bring up a 
pop-up menu with a hierarchical Change Label menu 
from which you can choose a label. 

NtWMUII91 MN 
Reply •n 
rorword 
At dire ct 
send Rgoln 

NtwMuuge To 
rorwerd To 
Turbo Rldlrec:t To 

New Menage Wllh 
Reply Wllh 

ft1141tll Ootumtftl ... X II 
Al l och • 
Oueue ror Oelluetu JU 

Outuf'lng ... 
ltt1Ut 

Dele le ao ,rtont_y_ 

(\\f'nllel ... 
In Progr•n 
Cool 

PrOJI!ft I 
Project 2 

Of'&IBITS 80Uhfl 
ldiiOr\ 
romp copy 
Lhatt Outl 
lobell2 
lebtl 11 
Done 
I IPf'f'f'l' t h IHUet' 

Figure 14 You can also open a message or select one 
or more messages and then choose a label from the 
hierarchical Label menu in the hierarchical Change 
menu in the Message menu. 

Working with Messages 

Changing message labels 
Eudora Pro lets you mark messages with 
labels, which is helpful for grouping related 
messages within a mailbox. Labels can have 
both text and color attributes. (See Chapter 12, 
"Working with Settings/ Options" for more information 
on creating labels) 

To change message labels (I) 

1. In the Mac version of Eudora Pro, select 
one or more messages in a mailbox, then 
move the cursor over the label column. 
When the cursor changes to look like a 
little menu, click and hold to bring up the 
label pop-up menu from which you can 
choose a label (Figure 12). 

In the Windows version, right-dick one 
or more selected messages to bring up a 
pop-up menu with a hierarchical Change 
Label menu from which you can choose a 
label (Figure 13). 

To change message labels (II) 

1. Open a message or select one or more 
messages, then choose a label from the 
hierarchical Label menu in the hierarchi
cal Change menu in the Message menu 
(Figure 14). 

V' Tips 

• Message labels are entirely for your per
sonal use-they're never transmitted to 
others in outgoing messages. 

• You can also use filters to change message 
labels. (See Chapter 7, "Working with Filters") 
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Chapter 5 

Changing message status 
Eudora assigns every message a status, such as 
Read, Unread, Forwarded, Sent, and Queued. 
Although Eudora assigns the status of each 
message automatically, there may be situa
tions where you want to change that status. 

To change message status (I) 

1. In the Mac versions of Eudora, select one 
or more messages, then move the 
cursor over the status cohunn (the left 
column). When the cursor changes to 
look like a menu, click and hold to bring 
up the status pop-up menu from which 
you can choose a status (Figure 15). 

In the Windows versions of Eudora, right
click one or more selected messages to 
bring up a pop-up menu with a hierarchi
cal Change Status menu from which you 
can choose a status (Figure 16) . 

To change message status (II) 

1. Open a message or select one or more 
messages, then choose a label from the 
hierarchical Status menu in the hierarchi
cal Change menu in the Message menu 
(Figure 17). 

II Tip 

• I sometimes change the status of a mes
sage in my In box from Read back to 
Unread so I'm sure to deal with it again 
the next day when I read my mail. I also 
sometimes have a number of messages in 
my Out box set to Sendable, and it's easier 
to select them all and change their status 
to Queued than it is to open each one in 
turn and click the Queue button. 

Figure I S In the Mac versions of Eudora, move the 
cursor over the status column in a mailbox and when it 
changes to a menu cursor, click to bring up a menu 
from which you can choose a status. 

Figure 16 In the Windows versions of Eudora, right
click one or more selected messages to bring up a pop
up menu with a hierarchical Change Status menu from 
which you can choose a status. 
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Figure 17 You can also open a message or select one 
or more messages and then choose a status from the 
hierarchical Status menu in the hierarchical Change 
menu in the Message menu. 
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Figure 18 You can open a message or select one or 
more messages and then choose a personality from the 
hierarchical Personality menu in the hierarchical 
Change menu in the Message menu. 

:so why:would-lwant tc?,--doth,s? -
Yc)u Jriight Wa:ntto· ~ge the personality 
of some:messag~·-if you!ve received a lot 
of,:messages Via one personality (say, an 
old email account you seldom use), but 
want to reply to them uSing another per
soliality (your current email account). 

Ifya~ change the persona1ity of the 
incoming messages -to the new, desired 
personality, all replies -will-automatically 

-come from that personality. I realize this is 
a bit ·tWeaky. but in the right situation, it 
could save yo~ a lot of work because you 
'WQuldn•t have to change the personality 
for-each reply individually. 

OfcoUl'Se, in my example above. you 
colild}ust change the old personality to 

: use :the retUrn a,ddress of the new email 
ac¢oiplt, but for the purposes of argu
til~t,lef's assume there's a reason you 
don-.t wanfto do that. 

Working with Messages 

Changing message 
personality 
You can select different personalities for out
going messages in the Mac version of Eudora 
Pro-since personalities can also receive 
messages, it makes sense that you could also 
change the personality of messages that 
you've received. The Windows version of 
Eudora Pro doesn't share this feature, but 
don't worry if that's what you use--you're 
not missing much. 

To change message personality 

1. Open a message or select one or more 
messages, then choose a personality from 
the hierarchical Personality menu in the 
hierarchical Change menu in the Message 
menu (Figure 18). 

You won't see any visible changes; how
ever, when you reply to a changed 
message, the reply should come from 
the personality you chose. 
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Chapter 5 

Changing message text 
Although you normally only think about 
changing the text of outgoing messages, 
Eudora also enables you to change the text of 
incoming messages. The trick is that you must 
first unlock the message for editing. 

To change message text 

1. Open a message, and in the message win
dow, click the pencil button to enable 
editing. In the Mac versions of Eudora, 
the button gets a checkmark next to it 
(Figure 19); in the Windows versions, it 
indents (Figure 20). 

2. Make any changes you want in the text of 
the message. 

3. When you're done, choose Save from the 
File menu Q Cmd 1-S/@!ill-S) to save your 
changes, and then choose Close from the 
File menu Q Cmd 1-W !@!ill-W) or click the 
window's close box to close the window. 
If you close the window without saving, 
Eudora prompts you to see if you wanted 
to save your changes (Figure 21). 

II Tips 

• Consider editing the text of a message if 
you receive a very long message that con
tains only a small amount of text you 
want to save. Just delete the unwanted 
text, then save the changed message. 

• People aren't very good at typing URis 
(the addresses ofWeb pages), so they 
occasionally make glaring errors that pre
vent you from double-clicking the URL to 
visit it in a Web browser. If you see the 
mistake (such as a Web page name ending 
in .hmtl instead of the correct .html), you 
can edit the text of the message to fix the 
problem. That way, double-clicking the 
URL works and will continue to if you 
save the message for later use. 

So 

Pencil button 

I ID·/.f t! I~ ln\-l ·-

Figure 19 To switch into edit mode, click the pencil 
button so there's a checkmark next to it in the Mac 
versions of Eudora. 

Pencil button 

il!I ~J 9 N:/"''' ~· "'" .... "' ..... 

Figure 20 To switch into edit mode, click the pencil 
button so it's indented in the W indows versions of 
Eudora. 

Figure 21 If you forget to save your changes after 
modifying a message. Eudora prompts you when you 
try to close the message window. 
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Figure 22 In a normal message window, the header 
lines are abbreviated to show only the interesting ones. 
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Figure 23 To display the boring headers in the Mac 
versions of Eudora, click the Blah button so a 
checkmark appears next to it. 
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Figure 24 To display the boring headers in the 
Windows versions of Eudora, click the Blah button 
so it indents. 
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Figure 25 After you click the Blah button, Eudora 
reveals all the boring headers. 

Working with Messages 

Revealing boring headers 
Eudora tries to protect you from the truly 
ugly header lines that come with every mes
sage-Eudora calls them "boring headers." 
However, there are times when you may wish 
to see those header lines, and it's easy to 
reveal them for further study. 

To reveal boring headers 

1. Open a message and note the headers that 
you can see (Figure 2 2). Then, in the 
message window, click the Blah button to 
reveal the boring headers. In the Mac 
versions of Eudora, the button gets a 
checkmark next to it (Figure 23); in the 
Windows versions, it indents (Figure 24). 

Eudora then immediately displays the 
boring headers at the top of the window 
(Figure 25). 

~Tips 

• If you look closely at the Received header 
lines, you can trace the path the message 
took on its way to you. You can even 
calculate how long it took, although you 
have to pay special attention to the time 
zones, which are generally offsets from 
Greenwich mean time. 

• I sometimes look at the boring headers 
because it's relatively easy to forge email 
(spammers do this all the time), but it's 
more difficult to forge the boring headers, 
so I can sometimes tell who sent some 
spam by looking carefully at the X-Sender 
and Received header lines. 

• If someone sends you a message using 
styled text and it's difficult to read, you 
can turn off all styling quickly by clicking 
the Blah button to reveal boring headers. 
That's because the Blah button also reveals 
the codes that control styles within the 
message window. 
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Chapters 

Navigating 
within messages 
I'm sure you know how to scroll and move 
around within a window, and Eudora is no 
different than most Mac and Windows appli
cations in this regard. However, just to review, 
here are the ways you can navigate within a 
message. 

Methods of navigating 
within messages 

• To scroll one line up or down, click the 
arrows on either end of the scroll bar 
(Figure 26). 

• To move up or down one line, press the 
Up and Down arrow keys when the inser
tion point is on either the first or last 
lines. (This is generally too much work.) 

• To scroll up or down a page (page size is 
determined by the window size), click in 
the scroll bar either above or below the 
elevator box (Figure 27). 

• To scroll up or down a page (page size is 
determined by the window size), press 
Page Up or Page Down. 

• To scroll down a page (page size is deter
mined by the window size), press the 
Spacebar. When you get to the bottom of 
the window, pressing the Spacebar again 
takes you to another message, either the 
next one or the next unread one, depend
ing on what you set in the Moving 
Around (Mac) or Miscellaneous 
(Windows) settings panel. 

• To move to the top or the bottom of the 
message in the Mac versions of Eudora, 
press Home or End. 
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Figure 26 To scroll one line up or down, click the 
arrows on either end of the scroll bar. 

Figure 27 To scroll up or down a page, click in the 
scroll box either above or below the elevator box. 



Controls for 
switching 

_ __;.__,,__--t- messages 

Figure 28 The Miscellaneous settings panel in the 
Windows versions of Eudora contains the settings for 
navigating between messages with the arrow keys. 

Open Open 
Previous Next 
Message Message 

llflR~~~~ffiJ:IJ~I 
Figure 29 To switch messages in the Windows 
versions of Eudora, click the Open Previous Message or 
Open Next Message button in the toolbar. 

The Windows pane interface 

You can create a pane interface (one that 
doesn't display separate movable windows) 
in the Windows versions of Eudora. To do 
this, choose View Mailboxes from the Tools 
menu, then right-click the Mailboxes 
window and make sure the Docking View 
menu is checked (choose it if not). Then, 
open any message window or mailbox 
window and click the Maximize button to 
make that window take up the rest of 
Eudora's window. From then on, every 
open message or mailbox window will 
display at the largest possible size within 
Eudora's window. 

Working with Messages 

Navigating 
between messages 
Eudora provides a number of ways of moving 
between messages, some of which are auto
matic and others of which you must invoke 
manually. 

Methods of navigating 
between messages 

• Close the current m essage window by 
clicking the close box or choosing Close 
(ICmdi-W/[Ctrii-W) from the File menu, 
then open another message. (See "Opening 
messages" in this chapter) 

• When you delete, transfer, or use the 
Spacebar to page past a message, Eudora 
closes the message and can open another 
one, depending on the settings of the 
Moving Around (Mac) or Miscellaneous 
(Windows) settings panel (Figure 28). 

• Press the Left or Up arrow keys to move 
to the previous message or the Right or 
Down arrow keys to m ove to the next 
message. These keys often require modi
fiers set in the Moving Around (Mac) or 
Mis-cellaneous (Windows) settings panel. 

• In the Windows versions of Eudora, click 
the Open Previous Message or Open Next 
Message toolbar button (Figure 29) to 
move to the previous or next message. 

• To switch between already open messages, 
choose them from the Windows menu. 

VTip 

• To close all open windows, hold down 
Option (Mac) or Shift (Windows) and 
choose Close (I Cmd 1-[ Option 1-W / [ Ctrii
[Shifi~W) from the File menu. Option
clicking a window's close box has the 
same effect in the Mac versions of Eudora. 



Chapter 5 

Visiting URLs 
You'll see many URLs in incoming email 
messages. Aside from telling friends and col
leagues about useful Web pages, people often 
include URLs in their signatures. You could 
copy and paste URLs into your Web browser, 
but that's way too much work. 

To visit a URL 

1. URLs in Eudora message windows appear 
in blue and underlined (Figure 30), as do 
links in many Web browsers. Double-click 
a Web URL to visit that Web page in your 
Web browser (Figure 31). 

II Tips 
• The fust time you double-click a URL in 

the Mac versions of Eudora, it asks you 
which application to use for that URL type 
(Figure 3 2). Select your favorite Web 
browser, or, if you clicked a different URL 
type (such as ftp, news, or telnet), the 
appropriate helper application. 

• If you want the Mac versions of Eudora to 
use a different helper application than you 
initially selected, hold down Option and 
double-click a URL to bring up the dialog 
box that asks which helper application to 
use for that type ofURL. 

• In the Mac versions of Eudora, if you 
check the "Read from Internet Config 
(not recommended)" checkbox in the 
Miscellaneous settings panel, Eudora will 
use the preferred helper applications set in 
Internet Config. 

• The Windows versions of Eudora send 
Web URLs to your default Web browser. 

Notice the underlined, text of the 
URL If this book was printed in 
color, it would be blue too. 
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Figure 30 To visit a URL you see in an email message 
{it will be blue and underlined), double-click it. 

Wjelcome to Tonya Engst's home page! 

Figure 31 When you double-click a URL, Eudora 
either launches or switches to your Web browser and 
loads the appropriate Web page. 
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Figure 32 The first time you double-click a URL {or if 
you bption-double-click a URL), Eudora asks what 
application you want to use for that type of URL. 
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Figure 33 To delete messages. either open a message 
or select one or more messages, then choose Delete 
from the Message menu. 

Nuke it 
Every now and then you 'll receive a truly 
sensitive message that you want to delete 
permanently and iinmediately, so there's 
no chance of someone going through 
yourTrash mailbox and finding it. In the 
Mac versions of Eudora, to delete a mes
sage permanently and immediately. hold 
down Control, Shift, and Option, and 
choose Nuke from the Message menu. 

Working with Messages 

Deleting messages 
Although you may save some incoming mail, 
you'll want to delete many messages. Keep in 
mind that Eudora doesn't delete messages 
immediately; deleted messages are merely 
moved to the Trash mailbox. They stay there 
until you empty the Trash by choosing Empty 
Trash from the Special menu. 

To delete the current message 

1. Open a message, read it, and then choose 
Delete QCmd)-D/@!ill-D) from the 
Message menu (Figure 33). 

Alternately, in the Windows versions, 
right-click the message window and 
choose Delete from the pop-up menu. 

Eudora moves the message to the Trash 
and displays the next message, if set to do 
so in the Moving Around (Mac) or 
Miscellaneous (Windows) settings panel. 

To delete one or more messages 

1. Select one or more messages in a mailbox, 
then choose Delete (ICmd)-D/ICtri)-D) 
from the Message menu. 

Alternately, select one or more messages 
and press either Delete/ Backspace or the 
Forward Delete key. 

Alternately, in the Windows versions, 
right-click the message window and 
choose Delete from the pop-up menu. 

VTips 

• To "undelete" a message (or multiple 
messages, if deleted together) immedi
ately, choose Undo (iCmd)-ZIICtri )-Z) 
from the Edit menu. Eudora tl1en moves 
the message back to the original mailbox. 

• In the Mac versions of Eudora, hold down 
Shift and choose Delete (I Cmd HShifi)-D) 
from the Message menu to delete the cur
rent message and not display the next one. 
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Chapter 5 

Transferring messages 
to mailboxes 
You can and should store important messages 
in special mailboxes-Eudora provides several 
different ways to transfer messages into mail
boxes. (See Chapter 6, "Working with Mailboxes") 

Methods of transferring messages 

• Open a message or select one or more 
messages, and then choose a mailbox 
from the Transfer menu (Figure 34). 

• Open a message, and drag the tow truck 
icon in the message window to another 
open mailbox (Figure 35) or to a mailbox 
folder in the Mailboxes window. 

• Select one or more messages, then drag 
them either to 'another open mailbox or 
to a mailbox folder in the Mailboxes 
window (Figure 36). 

~ • In the Windows versions, open a message 
0 or select one or more messages and then 
:z:: 1:; right-click to display a pop-up menu 
:E (Figure 3 7) with a hierarchical Transfer 

menu, from which you can choose a 
mailbox. 

• Create a filter that transfers matching mes
sages to another mailbox. (See Chapter 7, 
"Working with Filters") 

ti'Tips 

• To undo a transfer, immediately choose 
Undo {ICmdl-Z/@!ill-Z) from the Edit 
menu. 

• To transfer a copy of a message, hold 
down Option (Mac) or Shift (Windows) 
when you transfer the message. 

• In the Mac versions of Eudora, hold down 
Shift when you transfer a message to avoid 
displaying the next message. 
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Figure 34 To transfer messages from one mailbox to 
another, select one or more messages and then choose 
a mailbox from the Transfer menu. 
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Figure 35 Alternately, to transfer a message to 
another mailbox drag the tow truck icon to another 
open mailbox. 

Figure 36 Alternately, to transfer one or more 
messages, select them and drag them to another 
mailbox in the Mailboxes window. 

a I 

Figure 37 In the Windows versions of Eudora, you can 
also right-click a message window or selected messages 
to display a pop-up menu from which you can choose a 
mailbox from the hierarchical Transfer menu. 
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Figure 38 To open an attachment, double-click the 
attachment icon, or click once on it to select it and 
press Return/Enter. 
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Figure 39 To open an attachment, select it and choose 
Open Attachment (Windows) or Open Selection (Mac) 
from the File menu. 

Working with Messages 

Opening attachments 
When you receive attachments, Eudora places 
them in the Attachments (Mac) or Attach 
(Windows) folder in your Eudora Folder, and 
you can open them like any other file. You 
can also open them from within Eudora. 

Methods of opening attachments 

• Double-click an attachment icon 
(Figure 3 8) . 

• Click an attachment icon to select it, then 
press Return/Enter. 

• Click an attachment icon to select it, then 
choose Open Selection (Mac) or Open 
Attachment (Windows) from the File 
menu (Figure 39). 

• In the Mac versions of Eudora, drag the 
attachment icon onto the icon of a pro
gram that can open the attachment. 

tl' Tips 

• The Mac version of Eudora Pro will dis
play attached graphics within the body of 
the message if you check the "Display 
graphics attachments inline" checkbox in 
the Fonts & Display settings panel. 

• In the Mac versions of Eudora, hold down 
Option and double-click an attachment 
icon to choose an application to open that 
attachment. 

• In the Mac versions of Eudora, hold down 
Control and double-click the attachment 
icon to open the folder that contains the 
attachment in the Finder. 
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Chapter 5 

Moving attachments 
All your attachments end up in your 
Attachments (Mac) or Attach (Windows) 
folder in the Eudora Folder. You'll probably 
want to organize those files by moving them 
to other folders. You can of course do that in 
the Macintosh Finder or Windows desktop, 
but you can also do it from within Eudora. 

To move an attachment 

1. Drag the attachment icon to the folder to 
which you want to move it. 

It may not be obvious immediately, but 
Eudora moves the file from the 
Attachments (Mac) or Attach (Windows) 
folder into the specified destination folder. 

t/Tips 

• In the Mac versions of Eudora, hold down 
Option while you drag the attachment 
icon to another folder to make a copy of 
the file rather than moving it. 

• In the Windows versions of Eudora, watch 
the cursor while you drag attachment 
icons. When it's a circle with a slash, you 
can't drop the attachment; when it's a 
pointer with a plus sign, you can. 

• In the Windows versions of Eudora, if 
your destination folder or its parent folder 
is obscured but present on the Task bar, 
drag the attachment icon onto the folder's 
icon on the Task bar. That folder's window 
will come to the front so you can drop the 
attachment in the desired place. 
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Figure 40 If you delete a message in the Mac versions 
of Eudora while the "Trash attachments with messages" 
checkbox is checked, Eudora moves that message's 
attachments to the Trash in the Finder. 
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Figure 4 1 If you delete a message and then empty the 
trash in the Windows versions of Eudora while the 
"Delete attachments when emptying Trash" checkbox is 
checked, Eudora deletes that message's attachme nts. 

Working w ith Messages 

Deleting attachments 
Many attachments won't be interesting after 
an initial look, and some email p rograms 
include style information as attachments 
(which is really annoying). There are anum
ber of ways you can delete attachments. 

Methods of deleting attachments 

• In the Mac versions of Eudora, drag an 
attachment icon to the Trash in the Finder. 
This removes the attachment from the 
message, and moves the file to the Trash , 
where it will be deleted next time you 
empty the Trash. 

• In the Mac versions of Eudora, delete the 
message containing the attachment, if the 
"Trash attachments with messages" check
box is checked in the Attachments settings 
panel (Figure 40) . 

• In the Windows versions of Eudora, delete 
a message containing an attachment, then 
empty the trash by choosing Empty Trash 
from the Special menu, if the "Delete 
attachments when emptying Trash" check
box is checked in the Attachments settings 
panel (Figure 41). 

• Switch to the desktop, open the 
Attachments (Mac) or Attach (Windows) 
folder, and drag the file to the Trash (Mac) 
or Recycle Bin (Windows). 

V' Tip 

• Although you can drag attachment icons 
to other folders in the Windows versions 
of Eudora, you cannot drag them to the 
Recycle Bin to delete them, as you can 
drag attachments to the Macintosh Trash. 



Chapter 5 

Saving messages 
Eudora offers several ways to extract text from 
a message, such as copying or dragging it to 
another application, but you can also save one 
or more messages to a text file. 

To save messages to a text file 

1. Open a message or select one or more 
messages. 

2. From the File menu, choose Save As 
(Figure 42). 

Eudora displays a standard Save dialog box 
with a suggested file name and two addi
tional checkboxes, Include Headers and 
Guess Paragraphs (Figure 43). 

3. To include the headers of each selected 
message in the text file, check the Include 
Headers checkbox. To have Eudora attempt 
to wrap paragraphs of text, check the 
Guess Paragraphs checkbox. 

4. Name the file, navigate to the desired 
location, and click the Save button. 

V' Tips 

• If you don't check Include Headers, it may 
prove difficult to determine where one 
messages ends and the next one begins in 
the resulting text file. 

• I generally recommend not checking 
Guess Paragraphs because many messages 
become difficult to read when wrapped. 

• Eudora also enables you to create, open, 
edit, and save text files using the New Text 
Document (Mac) or New Text File 
(Windows), Open (Mac) or Open Text 
File (Windows), and Save commands in 
the File menu. 

• In the Mac versions of Eudora you can 
create clippings files by selecting text and 
dragging it to the Finder. 
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Figure 42 To save messages to a text file, open a 
message or select one or more messages, then choose 
Save As from the File menu. 

Fig ure 43 In the standard Save dialog box, enter a 
name for the file , check the Include Headers and Guess 
Paragraphs checkboxes if desired, then click the Save 
button. The Mac and Windows (shown here) Save 
dialog boxes look quite different, but are functionally 
identical. 
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Figure 44 To print messages, open a message or select 
one or more messages, then choose Print from the File 
menu to bring up the Print dialog box. Set any desired 
print options, then click Print (Mac) or OK (Windows). 
The Mac (shown her~) and Windows Print dialog boxes 
look quite different, but are functionally the same. 
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Figure 45 To see a preview of what will print in the 
Windows versions of Eudora, choose Print Preview 
from the File menu. 

Printing other windows 
You can print a number of windows in 
Eudora. including text windows and the 
contents of the Directory Services window. 
In the Mac versions, you can also print the 
contents of the Filters and Address Book 
windows. Just open the desired window 
and·choose Print from the File menu. 

Working with Messages 

Printing messages 
I generally discourage people from printing 
email messages since I consider it a waste 
of paper. However, there are instances where 
printing is absolutely necessary, such as when 
you receive driving directions in email. 

To print a message 

1. Open a message, or select one or more 
messages. 

2. From the File menu, choose Print 
a Cmd 1-P II Ctri)-P). 

Eudora displays the Print dialog box 
(Figure 44). 

3. Make any desired changes to the print 
options, then click the Print button (Mac) 
or OK button (Windows). 

Eudora prints the message with a header 
containing the sender's name, the message 
date and time, and the message subject. 
Also included is a footer with a page num
ber and a line that says "Printed for" and 
your name and email address (Figure 45) . 

.,Tips 
• In the Mac versions of Eudora, to print 

selected messages without seeing the 
Print dialog box, choose Print One Copy 
from the File menu. 

• In the Windows versions of Eudora, to 
see what your printout will look like 
before committing it to paper, choose 
Print Preview from the File menu. 

• In the Mac versions of Eudora, to print 
just selected text in a message, hold down 
Shift and choose either Print Selection or 
Print One Copy from the File menu. 

• You set the font used for printing in the 
Fonts & Display settings panel. (See Chapter 
12, "Working with Settings/Options") 
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WORKING 

WITH MAl LBOXES 
In the last chapter, we looked at how to work 
with the individual messages that you receive. 
Dealing with all those messages could prove 
daunting, especially for people like me who 
get hundreds of messages a day. Fortunately, 
Eudora has superior capabilities for storing 
messages in user-created mailboxes. 

You can create as many mailboxes as you 
want, and you can even nest mailboxes 
within mailbox folders, which simphfies the 
task of organizing collections of messages 
you want to save. 

What's most important about Eudora's 
mailboxes though, is that they're accessible in 
numerous ways. Everyone works in different 
ways, and Eudora presents no obstacles to 
individual methods of organizing messages. 

Along with the basic instructions on how 
to work with Eudora's mailboxes, I also delve 
into a few strategies that I've used over the 
years for managing my mailboxes. Perhaps 
I'm in an unusual situation because of the 
amount of email I receive, but if a strategy 
works well for me, it may prove useful, or at 
least instructive, for you as well. 

With that, let's turn our attention to working 
with mailboxes in Eudora. 
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Chapter 6 

Opening mailboxes 
Eudora creates three mailboxes by default: In, 
Out, and Trash. Before we get into how you 
create your own mailboxes,let's look at how 
you open mailboxes. 

Methods of opening mailboxes 

• From the Mailboxes menu or one of its 
hierarchical mailbox folder menus, 
choose a mailbox (Figure 1) to open it. 

• Open the Mailboxes window (Figure 2) 
by choosing Mailboxes from the Special 
menu (Mac) or View Mailboxes from the 
Tools menu (Windows). Then, either 
double-click a mailbox or select one and 
press Return/ Enter to open it. 

• In the Getting Attention settings panel in 
the Settings/Options dialog box, set 
Eudora to open mailboxes when new mail 
arrives in them (Figure 3) . (See Chapter 12, 
"Working with Settings/ Options") 

• Set a filter to open mailboxes that are 
matched by that filter. (See Chapter 7, 
"Working with Filters") 

• Open a message window, then hold down 
Command (Mac) or Control (Windows) 
and double-click the message's title bar to 
open its mailbox. 

• In the Mac versions of Eudora, select one 
or more mailboxes in the Mailboxes win
dow and choose Open Selection from the 
File m enu to open them. 

V'Tip 

• The Mac versions of Eudora mark 
mailboxes with unread messages by 
underlining them in the menus and 
Mailboxes window. The Windows versions 
do this by holding mailbox names in the 
Mailboxes window and placing a letter 
icon next to them in the Mailbox menu. 
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Figure I To open a mailbox, choose it from the 
Mailboxes menu or one of its hierarchical mailbox 
folder menus. 
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Figure 2 To open a mailbox from the Mailboxes 
window, double-click it or select it and press 
Return/Enter. 
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Figure 3 To set Eudora to open mailboxes automatically 
when new mail arrives in them, check the Open mailbox 
checkbox in the Getting Attention settings panel. 
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Figure 4 To sort messages, open a mailbox, then 
choose the desired sort from the hierarchical Sort 
menu in the Special menu (Mac) or Edit menu 
(Windows). 

Click a column header to sort the mailbox by that column. 

II I I I II I 

04 >t)"'flll/71 l 
Oi t H ... IIU /11; 
ClotOl ..., oJP1 .J1 t 
;•,U N< llf':IU ~ 

w,,oo ft< U / UU ~ 

t"hot "' u .J:.Ju • 
~ .,,.. ... v.uu J 

UtOI "' OllU, J 

-• • • U tllll lhohl 
....... u .. , ... . ......... , ..... . ... . 
~ •. ,..,y,_ n_o 
... ......... .., .. ¥ , ........ . ............ ... .. ,.- .... . 
.... .._, .. ........ ,, ,. .. _ • • uu• 
•• .... u .... ,.._,.,u.,.o • U 11f 

:::::.~::~.::---::::,~: ohll lo H 

:::~04:::::::.~ .·:: ... , '-6 ... 
Aolnnuo"' -unou 

Figure 5 Alternately. in all versions of Eudora except 
the Mac version of Eudora Light, click a header to sort 
the mailbox by that column. 

Group Subjects 

The Group Subjects command in the Mac 
versions of Eudora is a fabulous feature if 
you participate in lots of mailing lists. 
Open the mailbox where you store mes
sages from a specific mailing list, and 
choose Group Subjects from the hierarchi
cal Sort menu in the Special menu to turn 

on subject grouping for that mailbox. 

From then on (unless you turn off Group 
Subjects by choosing it again), Eudora 
tries to group messages with the same 
subject, overriding the current sort order. 
Thus, it's a lot easier to read all the mes
sages about the same topic, even if they 
didn't all arrive at once. 

Working with Mailboxes 

Sorting messages 
in a mailbox 
Once you have opened a mailbox window, 
you can sort the messages in that mailbox. 

To sort messages (I) 

1. Open the mailbox you want to sort, then 
choose the desired sort from the hierar
chical Sort menu (Figure 4) in the Special 
menu (Mac) or Edit menu (Windows). 

Eudora sorts the messages according to 
the sort you chose. 

To sort messages (II) 

1. Open the mailbox you want to sort, then 
click the header of the column by which 
you want to sort (Figure 5) . 

This works in all versions of Eudora 
except the Mac version of Eudora Light. 

tl' Tips 

• Hold down Option (Mac) or Shift 
(Windows) when performing a sort to 
sort in descending order (Z to A) rather 
than ascending order (A to Z). 

• In the Mac version of Eudora Pro, hold 
down Shift when performing a sor t to add 
that sort to the current sort rather than 
replacing the current sort order. This tells 
Eudora Pro to sort first by Sender then by 
Date, for instance. The Windows versions 
of Eudora always add a new sort order to 
the previous one. 
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Chapter 6 

Different types of sorts 
Most of the options for sorting messages are 
obvious (Figure 6), but some may not be. 

Different types of sorts 

• Status sorts m essages according to mes-
sage status, in the following order: 
Unread, Read, Replied, Forwarded, and 
Redirected. The order of a status sort in 
the Out box varies somewhat-just scroll 
to the top or bottom of the mailbox to see 
messages with less common statuses. 

• Priority places messages with the highest 

1ft 
priority messages at the top of the mail-

~ box and those with the lowest priority at 
a= the bottom. Q 
1ft ... • Attachment(s) groups messages with 
Q 

attachments at the bottom of the mailbox. 
1ft 
11.1 
A. • Label (Eudora Pro only) sorts messages in 
~ the same order as the label menu, with 
~ unlabeled messages at the top of the z 
11.1 mailbox. a= 
11.1 ... • Sender sorts messages alphabetically by ... 
cS the name of the sender. If the sender's 

name doesn't appear in the message, 
Eudora sorts alphabetically by the sender's 
email address. 

• Date sorts messages chronologically 
by date, with the newest messages at the 
bottom of the mailbox. Be aware that 
messages can come in with incorrect 
dates, thus messing up your date sorts. 

• Size sorts messages by size, with the 
smallest messages appearing at the top of 
the mailbox. 

• Server Status (Windows Eudora Pro only) 
sorts messages by their status on the 
server. 

• Subject sorts messages alphabetically by 
the subject of each message. 
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Figure 6 Eudora provides numerous ways of sorting 
mailboxes, all available from the hierarchical Sort menu 
in the Edit menu (Windows) or the Special menu (Mac). 

I Remembrance of sorts past 
I 

E~dora always remembers the way you 
last sorted each individual mailbox, and 
new messages that filter into a mailbox are 
sorted automatically by that last sort. 

This can cause some confusion if you 
think all new m essages should end up at 
the bottom of a mailbox-a message 
might sort to the top of a mailbox and 
thps remain unnoticed for a while, 

In the Mac version of Eudora Pro, to 
I . 

remove all sorong and have messages 
appear in the order in which they atrive, 
ho1d down Shift and click the cw:rent 
underlined column header to remove that 
sort (repeat if other columns are involved 

in !the sort as well) . 
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Figure 7 To create a new mailbox, choose New from 
the Mailbox menu or one of its hierarchical mailbox 
folder menus. 
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Figure 8 Eudora then displays the New Mailbox dialog 
box. Enter the name of your mailbox and when you're 
done, click OK. 
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Figure 9 In the Mac versions of Eudora, click the 
New Mailbox button in the Mailboxes window to 
create a new mailbox. 

Mo1lboxes l!i[!JEJ 

~ Eudora Fotder 
~ In 
~ Oul 
Mm Tn11sh 
9 from f nends 

a lii~ ' 'EiifO;""' 9 Frc Qpin 
9 Frc I'! 
9 Frc 

l!oloto Dol 9 S~< 
B ii!I IVc ~ FZ 

- 9 
llo<ltf!9V-9 11!1 TidBIT 

9 Re !iido 
9 Web Slot• 

Figure I 0 In the Windows versions of Eudora, right
click the Eudora Folder o r another mailbox folder, then 
choose New from the pop-up menu that appears. 

Working with Mailboxes 

Creating mailboxes 
I strongly recommend you create mailboxes 
to store related messages, especially those that 
come from specific mailing lists-there's no 
reason they should crud up your In mailbox. 

To create a mailbox (I) 

1. From the Mailbox menu or one of its 
hierarchical mailbox folder menus, 
choose New (Figure 7) . 

Eudora displays the New Mailbox dialog 
box (Figure 8). 

2. Enter a name for your mailbox and click 
OK to save it. 

If you chose New from within one of the 
hierarchical mailbox folder menus, the 
new mailbox is created inside that folder. 

To create a mailbox (11 - Mac) 

1. Open the Mailboxes window by choosing 
Mailboxes from the Special menu. 

2. Select a mailbox folder or a mailbox, then 
click the New Mailbox button (Figure 9) 
to create a new untitled mailbox in the 
selected folder or at the same level as the 
selected mailbox. 

3. Name your new mailbox- it works just 
like renaming a file in the Finder. 
(See "Renaming mailboxes and mailbox folders" 
in this chapter) 

To create a mailbox (11 - Windows) 

1. Open the Mailboxes window by choosing 
View Mailboxes from the Tools menu. 

2. Right-click the folder where you want to 
store the new mailbox, then choose New 
from the pop-up menu (Figure 1 0) to 
display the New Mailbox dialog box. 

3. Enter a name for your mailbox and click 
OK to save it in the selected folder. 

97 



Ill 
11.1 

!i 
Ill 
Ill 
11.1 
:& 

"' z 
i¥ 
~ 
11.1 ... 
Ill z 
~ .... ... 
0 
Ill 
Q 
0 
:c 
t; 
:e 

Chapter 6 

Transferring messages 
into mailboxes 
We looked at transferring messages back in 
Chapter 5, "Working with Messages," but the 
topic is equally relevant here because once 
you've created a mailbox, you'll want to 
transfer messages into it. 

Methods of transferring messages 

• Open a message or select one or more 
messages, and then choose a mailbox 
from the Transfer menu (Figure 11). 

• Open a message, then drag the tow truck 
icon in the message window to another 
open mailbox (Figure 12) or to a mailbox 
folder in the Mailboxes window. 

• Select one or more messages in a mailbox, 
then drag them either to another open 
mailbox or to a mailbox folder in the 
Mailboxes window (Figure 13) . 

• In the Windows versions of Eudora, open 
a message or select one or more messages 
and then right-click to display a pop-up 
menu (Figure 14) with a hierarchical 
Transfer menu, from which you can 
choose a mailbox. 

• Create a filter that transfers matching mes
. sages to another mailbox. (See Chapter 7, 

"Working with Filters") 

t/ Tips 

• To undo a transfer, immediately choose 
Undo (ICmdJ-Z/I Ctrli-Z) from the Edit 
menu. 

• To transfer a copy of a message, hold 
down Option (Mac) or Shift (Windows) 
when you transfer the message. 

• In the Mac versions of Eudora, hold down 
Shift when you transfer a message to avoid 
displaying the next message. 
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Figure I I To transfer messages from one mailbox to 
another, select one or more messages and then choose 
a mailbox from the Transfer menu. 
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Figure 12 Alternately, to transfer a message to 
another mailbox, drag the tow truck icon to another 
open mailbox. 

Figure 13 Alternately, to transfer one or more 
messages, select them and drag them to another 
mailbox in the Mailboxes window. 
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Figure 14 In the W indows versions of Eudora, you can 
also• right-click a message or selected messages to 
display a pop-up menu from which you can choose a 
mailbox from the hierarchical Transfer menu. 
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Figure I 5 To create a mailbox and transfer a message 
into it, open a message or select one or more messages, 
then choose New from the Transfer menu or one of its 
hierarchical mailbox folder menus. 
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Figure 16 Eudora then displays the New Mailbox 
dialog box, asking you to name your mailbox. Enter a 
name and click OK to save it. 

Working with Mailboxes 

Creating a mailbox 
during a message transfer 
Another way to create messages is probably 
the most common because it fits best with 
the way we think. Imagine you're reading a 
message you want to store in a new mailbox 
folder. Rather than create a mailbox and then 
transfer the message into it, you can perform 
both actions in a single step. 

To create a mailbox and 
transfer a message into it 

1. Open a message or select one or more 
messages in a mailbox. Then, from the 
Transfer menu or one of its hierarchical 
mailbox folder menus, choose New 
(Figure 15). 

Eudora displays the New Mailbox dialog 
box (Figure 16). 

2. Enter a name for your mailbox and click 
OK to save it. If you chose New from one 
of the hierarchical mailbox folder menus, 
the new mailbox is created inside that 
folder. After creating the new mailbox, 
Eudora transfers the selected message or 
messages into the new mailbox. 
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Chapter 6 

Creating mailbox folders 
using menus 
Eudora enables you to create nested folders 
for storing mailboxes, just like the Macintosh 
Finder or Windows desktop. 

To create a mailbox 
folder and a mailbox 
1. From the Mailbox menu or one of its 

hierarchical mailbox folder menus, 
choose New (Figure 17) . 

Alternately, open a message or select one 
or more messages in a mailbox, then 
choose New from the Transfer menu or 
one of its hierarchical mailbox folder 
menus. 

Eudora displays the New Mailbox dialog 
box (Figure 18). 

2. Enter a name for your mailbox folder, 
check the "Make it a folder" checkbox. 
and click OK to save the folder. 

If you chose New from one of the hierar
chical mailbox folder menus, the new 
mailbox folder appears inside that folder. 

Eudora then displays the New Mailbox 
dialog box again. 

3. Enter a name for your mailbox and click 
OK to save it in your newly created mail
box folder (Figure 19). (To avoid creating 
the mailbox, click Cancel.) 

If you chose New from the Transfer menu 
or one of its hierarchical m enus, Eudora 
transfers the selected messages to the new 
mailbox in the new folder. 

V' Tip 

• In the Windows versions of Eudora, check 
the "Don't transfer, just create mailbox" 
checkbox in the New Mailbox dialog box 
to create a mailbox without transferring 
any selected messages. 
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Figure 17 To create a new mailbox folder and a 
mailbox, choose New from the Mailbox menu or one of 
its hierarchical mailbox folder menus. 
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Figure 18 Eudora then displays the New Mailbox 
dialog box. Enter a name for your mailbox folder, check 
the "Make it a folder" checkbox, and click OK to create 
the mailbox folder. 
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Figure 19 Eudora then displays the New Mailbox 
dialog box again, so you can name the new mailbox that 
Eudora will create inside the new mailbox folder. Click 
OK when you're done. 
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Figure 20 To create a new mailbox folder from the 
Mailboxes window in the Mac versions of Eudora, 
select a mailbox or mailbox folder, then click the 
New Folder button. 
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Figure 21 To create a new mailbox folder from the 
Mailboxes window in the W indows versions of Eudora, 
right-click the Eudora Folder or another folder in the 
list. then choose New from the pop-up menu. 
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Figure 22 Eudora then displays the New Mailbox 
dialog box. Name your mailbox folder and check the 
"Make it a folder" checkbox, then click OK. 

Working with Mailboxes 

Creating mailbox folders 
in the Mailboxes window 
You can also create mailbox folders from the 
Mailboxes window. 

To create a mailbox folder (Mac) 

1. Open the Mailboxes window by choosing 
Mailboxes from the Special menu. 

2. Select a mailbox folder or a mailbox, then 
click the New Folder button (Figure 20) 
to create a new untitled mailbox folder in 
the selected folder or at the same level as 
the selected mailbox. 

3. Enter a name for the new mailbox folder. 

To create a 
mailbox folder (Windows) 

1. Open the Mailboxes window by choosing 
View Mailboxes from the Tools menu. 

2. Right-click a mailbox folder, then choose 
New from the pop-up menu (Figure 21) 
to display the New Mailbox dialog box. 

3. Enter a name for your mailbox folder, 
check the "Make it a folder" checkbox, 
and click OK to save it inside the selected 
folder (Figure 22). 

Eudora then displays the New Mailbox 
dialog box again. 

4. Enter a name for your mailbox and click 
OK to save it in the new mailbox folder. 
(To avoid creating the mailbox, click 
Cancel.) 

II Tip 

• In the Windows versions of Eudora, to 

"dock" (or "float," if it's already docked) 
the Mailboxes window to the left or right 
edges of the Eudora window, right-click 
the Mailboxes window and choose 
Docking View from the pop-up menu. 
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Chapter 6 

Opening and closing 
mailbox folders 
You can work with the contents of mailbox 
folders in several ways. 

To open and close 
mailbox folders (Mac) 

1. Open the Mailboxes window by choosing 
Mailboxes from the Special menu. 

2. Double-click a closed mailbox folder to 
open it and display its contents. Double
click an open mailbox folder to close it 
and hide its contents. 

Alternately, to open a mailbox folder, click 
the triangle to its left so that it points 
down. To close the folder, click the trian
gle so it points right (Figure 23). 

To open and close 
mailbox folders (Windows) 

1. Open the Mailboxes window by choosing 
View Mailboxes from the Tools menu. 

2 . Double-click a closed mailbox folder to 
open it and display its contents. Double
click an open mailbox folder to close it, 
and hide its contents. 

Alternately, to open a mailbox folder, 
click the plus icon to its left . The plus 
icon changes to a minus icon when 
the folder is open; click it to close the 
folder (Figure 24). 
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Figure 23 In the Mac versions of Eudora, to open or 
close mailbox folders, click the triangles to the left of 
the mailbox folder names. 
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Figure 24 In the Windows versions of Eudora, to open 
or close a mailbox folder, click the plus or minus icon 
to the left of the mailbox folder names. 
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Figure 25 To rename a mailbox or mailbox folder in 
the Mac versions of Eudora, click its name, pause briefly, 
and then edit the name or enter a new one. 
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Figure 26 To rename a mailbox or mailbox folder in 
the Windows versions of Eudora, click a mailbox or 
mailbox folder to select it, click the name again to enter 
editing mode, then edit the name or enter a new one. 
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Figure 27 Alternately, in the Windows versions of 
Eudora, right-click a mailbox or folder, then choose 
Rename from the pop-up menu to enter editing mode. 

Working with Mailboxes 

Renaming mailboxes 
and mailbox folders 
Don't worry if you don't like the names you've 
given your mailboxes-you can always change 
them later. 

To rename a mailbox 
or mailbox folder (Mac) 

1. Open the Mailboxes window by choosing 
Mailboxes from the Special menu. 

2. Click a mailbox name or mailbox folder 
name to select it, then wait briefly for 
Eudora to switch into editing mode, just 
like the Finder (Figure 25) . 

3. Enter a new name or edit the existing one. 
When you're done, click somewhere else 
or press Return to save your changes. 

To rename a mailbox 
or mailbox folder (Windows} 

1. Open the Mailboxes window by choosing 
View Mailboxes from the Tools menu. 

2. Click a mailbox or mailbox folder to select 
it, then click the name again (Figure 26) 
to switch into editing mode (just like the 
Windows desktop). 

Alternately, right-click a mailbox or mail
box folder and choose Rename (CEI]) 
from the pop-up menu (Figure 27) . 

3. Enter a new name or edit the existing one. 
When you're done click somewhere else 
or press Enter to save your changes. 

V'Tip 

li In the Mac versions of Eudora, you must 
click the name of a mailbox or mailbox 
folder and pause briefly to enter editing 
mode. Clicking the icon won't work. 
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Chapter 6 

Reorganizing 
mailboxes and folders 
As time passes, you'll undoubtedly want to 
reorganize your mailboxes and mailbox fold
ers-no organizational scheme lasts forever. 

To reorganize mailboxes 
and mailbox folders (Mac) 

1. Open the Mailboxes window by choosing 
Mailboxes from the Special menu. 

2. Select one or more mailboxes or mailbox 
folders, then drag them over another 
folder so the destination folder highlights 
(Figure 28). If the mailbox is closed, it 
automatically opens to display its con
tents. Drop the mailboxes or mailbox 
folders to move them to the highlighted 
folder. 

To reorganize mailboxes 
and mailbox folders (Windows) 

1. Open the Mailboxes window by choosing 
View Mailboxes from the Tools menu. 

2. Select a mailbox or mailbox folder, then 
drag it over another folder so the destina
tion folder highlights (Figure 29). Drop 
the mailbox or mailbox folder to move it 
to the highlighted folder. 

V' Tips 

• In the Windows versions of Eudora, you 
can select only one mailbox or mailbox 
folder at a time. 

• In the Windows versions of Eudora, if you 
drag a mailbox or mailbox folder where it 
doesn't make sense to drop it, the cursor 
turns to a circle with a slash through it. 
The cursor looks like a normal arrow 
when you can drop the mailbox or mail
box folder. 
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Figure 28 To move a mailbox from one folder to 
another in the Mac versions of Eudora, select it and 
drag it over the new folder, which opens automatically 
if it was closed. 
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Figure 29 To move a mailbox from one folder to 
another in the Windows versions of Eudora, select 
it and drag it over the new folder. 
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Figure 30 To delete a mailbox or mailbox folder in the 
Mac versions of Eudora, select it and click the Delete 
Mailbox button. 
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Figure 31 When you delete a mailbox or mailbox 
folder, Eudora warns you explicitly if you stand to lose 
messages in the process. 

Figure 32 To delete a mailbox or mailbox folder in the 
Windows versions of Eudora, right-click it and choose 
Delete from the pop-up menu. 

Working with Mailboxes 

Deleting mailboxes 
and mailbox folders 
Eventually, you'll decide that you no longer 
need a mailbox or even an entire mailbox 
folder. Deleting mailboxes and mailbox fold
ers is simple but destructive, so be careful! 

To delete a mailbox 
or mailbox folder (Mac) 

1. Open the Mailboxes window by choosing 
Mailboxes from the Special menu . 

2. Select one or more mailboxes or mailbox 
folders, then click the Delete Mailbox but
ton (Figure 30) or press Delete. 

Eudora asks if you want to delete the 
selected mailboxes or mailbox folders, 
warning you if the mailboxes contain 
messages (Figure 31 ). 

3. Click Cancel to cancel, Remove It to delete 
just the mailbox or folder mentioned in 
the dialog box and be prompted for the 
rest again, or Remove All to delete all the 
selected mailboxes or folders. 

To delete a mailbox 
or mailbox folder (Windows) 

1. Open the Mailboxes window by choosing 
View Mailboxes from the Tools menu . . 

2. Right-click a mailbox or mailbox folder, 
then choose Delete (Figure 32) from the 
pop-up menu. 

Eudora asks if you want to delete the 
selected mailboxes or mailbox folders, 
warning you if the mailboxes contain 
messages. 

3. Click Cancel to cancel, Remove It to delete 
just the mailbox or folder mentioned in 
the dialog box and be prompted for the 
rest again, or Remove All to delete all the 
selected mailboxes or folders. 
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Chapter 6 

Compacting mailboxes 
When you transfer a message from a mailbox 
or delete a message, Eudora doesn't immedi
ately reclaim the space that message used. 
Instead, it tracks the amount of wasted space 
in each mailbox and compacts mailboxes 
automatically when there's more wasted 
space than used space. You can also manually 
compact mailboxes to save the space. 

To compact mailboxes 

1. Open a mailbox, and look in the lower
left corner at the size display (Figure 33) . 

The three numbers are the number of 
messages in the mailbox, the size of the 
mailbox in kilobytes, and the amount of 
wasted space. 

2. To recover the wasted space in a mailbox, 
either hold down Command and click the 
size display (Mac) or just click the size 
display (Windows). 

II Tips 
• In the Windows versions of Eudora, to 

compact all your mailboxes, choose 
Compact Mailboxes from the Special 
menu (Figure 34) . 

• In the Mac versions of Eudora, to 
compact all your mailboxes, hold down 
Command-Option and click the size 
display of any mailbox. 
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Figure 33 To compact a mailbox, hold down 
Command and click the size display in the lower-left 
comer of the mailbox window. In the Windows 
versions of Eudora, just click the size display. 

Figure 34 To compact all your mailboxes in the 
Windows versions of Eudora, choose Compact 
Mailboxes from the Special menu. 

Why waste the space? 
You probably wonder why Eudora wastes 
splce and then recovers it later. The reason 
is simple-speed. It's faster to mark a mes
sage as deleted than it is to remove it from 
the mailbox file. If Eudora compacted 
mailboxes every time you closed them, it 
would take a lot of extra time. 

Eudora tracks which messages are deleted 
(and other pieces of information about 
messages, such as status, label, and 
priority) in a table of contents file. Table of 
contents files, or TOC files in Eudora 
parlance, have the same name as their 
mailbox but also have a .toe extension. 

In the most recent Mac versions of Eudora, 
separate TOC ftles aren't necessary since 
Eudora can optionally store the message 
information in the mailbox file itself (in 
the resource fork, if you care) . 
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Figure 35 To open a mailbox outside of your Eudora 
Folder, choose Other from the Mailbox menu. 
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Figure 36 Then, find a mailbox outside your Eudora 
Folder, select it. and click the Open button to open the 
mailbox and create the alias. 

Uses of aliased 
mailboxes and mailbox folders 

I use aliases to mailboxes and mailbox 
folders in two main ways. First, I alias my 
massive folder of archived mail into my 
Eudora Folder so I don't have to take it 
with me on my Power Book when I travel. 
Second, people occasionally send me 
Eudora mailboxes that I prefer to keep out
side of my Eudora Folder for organiza
tional purposes. 

Working with Mailboxes 

Eudora and aliases 
The Mac versions of Eudora honor aliases that 
you make of mailboxes and mailbox folders 
(select a mailbox file or a folder that contains 
mailboxes in the Finder, then choose Make 
Alias from the File menu). Thus, you can use 
aliased mailboxes and mailbox folders for a 
variety of interesting purposes. 

Using aliased mailboxes and 
mailbox folders 

• You can make an alias to a mailbox or a 
folder that contains mailboxes and place 
the alias in your Eudora Folder to make 
Eudora treat the alias as though it were a 
real mailbox or mailbox folder. This is a 
great way to store old or large mailboxes 
outside your Eudora Folder where they 
can be more readily managed. 

• To open a mailbox not in your Eudora 
Folder and make an alias to it in your 
Eudora Folder, choose Other (Figure 35) 
from the Mailbox menu or one of its hier
archical mailbox folder menus, and then 
select a mailbox (Figure 36).You might 
use this if someone sends you a Eudora 
mailbox that you want to store some
where other than in your Eudora Folder. 

• In Eudora Pro, to open a mailbox not in 
your Eudora Folder and make an alias to it 
in your Eudora Folder, double-click the 
mailbox file in the Finder. 

• In Eudora Pro, to open an external mail
box, make an alias to it in your Eudora 
Folder, and transfer the selected messages 
into that mailbox, select one or more 
messages, choose Other from the Transfer 
menu or one of its hierarchical mailbox 
folder menus and select a mailbox. 
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Chapter 6 

Being a pack rat 
I'm sure there are numerous strategies for 
archiving messages. I tend to save a lot of 
my email because disk space is cheap and I 
like going back to see what happened in 
the past. Here are a few strategies I use, many 
of which rely on filters to transfer messages 
into mailboxes automatically. (Set Chapter 7, 
"Working with Filters") 

Archiving strategies 

• Set Eudora to keep copies of outgoing 
messages in the Sending Mail settings 
panel of the Settings/ Options dialog 
box, then transfer all your already sent 
outgoing messages to another mailbox 
every month. 

• Organize mailing lists by setting Eudora 
to filter mailing list messages into their 
own mailboxes (Figure 3 7). Keep only 
the most interesting messages from mail
ing lists; otherwise the volume will over
whelm you. 

• Set Eudora to filter messages from friends 
and family into a single mailbox. Save 
most of those messages since they're from 
the people who are closest to you and 
will have the greatest value in the future. 
Archive the contents of this mailbox 
every year. 

• Set Eudora to filter messages from your 
most prolific correspondents into their 
own mailboxes. I do this with my wife 
Tonya and a few people who work on 
TidBITS (Figure 38). 

• If you're concerned about not being able 
to find an especially important message, 
store it in multiple mailboxes by holding 
down Option (Mac) or Shift (Windows) 
to copy the message rather than moving 
it. I do this when my organizational 
scheme can't quite cope with a message. 

108 

In 
OUI 
Trash 

-~ ,_._ 
bltlt 
IIOOJftUI 
EOJdoraiiQS Delells 
Framfrl.nds 
lnttrullog Clscunlon• Mou• ••• 

~:;~su i "'""~· 
ClldltMiscMoU I 
Pnljlets I =mru rmtuts : 

RllouollletraiiHI 
Rllrtllo• 
llpplo Dlrectllllls 
Rpploe.g. 
llpplolnttmot RIIIIOUIICI 
Rpple latomet Pnloldon 
Bpple lllltmot uson 
Rpplo PR 
tllllll..Ll1l 
tampOJttr Boot lhl 
tgllenpoctlow 
Clgllol MICII Ptnpoclluo 
DUIIelt 
.Spllll 
EoslgoloUsl 
Elhlpego 
5UI uuctlr< ... nl 
lnfo·Mac 
lnfa·Motldmln 
lnlomol tonng 
Ko!Uinllall 
lollorlllp 
List Hoedors &roup 
UsiMomUsl 
UsiSTIR·Tolt 
Mit tiiNIIIIIIItollons 
Mac Dilly oiOuntol 
ModnlosbllleiJ 
NollltlDttn 
News or the lllolnl 
NIINS 
llnllna:L 
rmu.BmiW 
RltiiNel 
Slotllo Wrlten list 
ID.IU11I 
tills II True 
ng.,.Meontllllllsll 
II!Gim 
•u•••=a. 

Figure 37 Here you can see the contents of my Mailing 
Lists mailbox folder. 
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Figure 38 Here you can see the contents of my TidBITS 
mailbox folder, including the From Geoff, From Mark. and 
From Tonya mailboxes. 



Figure 39 Sort messages by size, select those over a 
certain size (over I OK here), then de lete them. 

Figure 40 Sort messages by sender, Option/Ait-click 
the sender of an automated message to select all 
messages from that sender, then delete them. 

Figure 41 To delete all messages from the Trash 
mailbox, choose Empty Trash from the Special menu. 
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Figure 42 To set Eudora to empty the trash each 
time you quit, check the Empty Trash on Quit (Mac) or 
Empty t rash when exit ing (Windows) checkbox in the 
Miscellaneous settings panel of the Settings/Options 
dialog box. 

Working with Mailboxes 

Taking out the trash 
The Trash mailbox is just another mailbox to 

Eudora, with one exception-Eudora can 
delete me messages in it permanently. I prefer 
to save messages in the lrash for a while 
because I never know when I'll want to go 
back for an email address or something. Here, 
men, are my strategies for deleting messages 
to recover disk space when me Trash mailbox 
has grown too large. (See "Sorting messages in a 
mailbox" in this chapter) 

Trash strategies 

• Sort messages by date, select roughly me 
top half (me oldest messages) and delete 
them. 

• Sort messages by size, select all me 
messages over a certain size (look at me 
bottom of the Trash mailbox) and delete 
them. This recovers space quickly 
(Figure 39). 

• Sort messages by status, select all unread 
messages (since they were probably bor
ing messages from mailing lists) and 
delete them . 

• Sort messages by sender, Option/ Alt-click 
me senders of automated messages (such 
as bounces, or daily stock reports) to 
select them, men delete those messages 
(Figure 40). 

• If you really need me disk space, choose 
Empty Trash (Figure 4 1) from me Special 
menu to delete all the messages in the 
Trash. 

• If you're chronically short on disk space, 
set Eudora to empty the trash whenever 
you quit the program (Figure 42). 
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WORKING 

WITH fiLTERS 

Filter flexibility 
This chapter is a little tricky because 
Eudora's filters are so flexible that it's 
impossible to walk you through the steps 
necessary to create every type of filter. 
Instead, I show you how to create a basic 
filter and then look at all the different 
ways you can modify filters. 

Filters automatically perform a number of 
actions on email messages based on a mes
sage's content. If you receive only several 
email messages each day, you don't need 
filters. However, if you subscribe to even a 
single mailing list or, if you receive lots of 
email, filters are the life preserver that pre
vents you from drowning in a sea of email. 

Every filter has two parts, a match string and 
the action Eudora performs on messages that 
contain the match string. The match string is 
merely text that Eudora looks for in an email 
message; the action is what Eudora does 
when a message contains the match string. 

Eudora can look for match strings in specific 
lines in the message header, in the entire 
header, or even in the message body, although 
searching message bodies is a bit slower. 

Eudora can perform a wide range of actions 
when a message contains the match string. 
Eudora can. for instance, transfer it to a mail
box (the most common use for filters), for
ward the message, reply to it, redirect it, open 
it, open its mailbox, print it, change its label, 
or modify its priority. It's up to you, so let's 
start filtering now! 
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Chapter 7 

Creating filters 
Filters are extremely flexible, so the steps 
below are for creating a generic filter; I pro
vide ideas for specific fllters later. 

To create a basic filter 

1. From the Special menu (Mac) or the Tools 
menu (Windows), choose Filters. 

Eudora opens the Filters window 
(Figure 1) . 

2. Click the New button to create a new 
Untitled fllter (Eudora names the filter 
automatically based on what it does) . 

3. From the Header pop-up menu, choose a 
header line to match. 

4. From the Contains pop-up menu, choose 
how you want the match string to relate 
to the content of the message. (Contains is 
the most common.) 

5. Enter a match string in the field next to 
the Contains pop-up menu. 

6. From the first Action pop-up menu, 
choose an action. 

7. If necessary, configure the action in the 
controls that appear to the right of the 
Action pop-up menu. For instance, choose 
a mailbox to transfer the message to. 

8. In the Mac versions, choose Save from the 
File menu to save your new fllter. In the 
Windows versions, close the Filters win
dow and click Yes when prompted to save. 

tl Tip 

• Although you'll want to choose a header 
line from the Header pop-up menu most 
of the time, you can enter a specific 
header line into the Header field. That 
might be useful if you want to match 
messages with a strange header line that's 
not included in the Header pop-up menu. 
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Figure I To create a basic filter in the Filters window, 
click the New button, choose a header line from the 
Header pop-up menu, choose how you want the 
header line to be matched from the Contains pop-up 
menu, enter a match string, and then choose an action 
from one of the Action pop-up menus. 
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Figure 2 To set a filter so it filters incoming messages, 
check the Incoming checkbox. To set a filter so it filters 
outgoing messages, check the Outgoing checkbox. And, 
to set a fllter so it filters a selected set of messages at 
any time, check the Manual checkbox. 

Working with Rlters 

Selecting messages 
to filter 
At the top of the Filters window there are 
three checkboxes, Incoming, Outgoing, 
and Manual (Figure 2) . They control which 
messages the filter looks at. 

Incoming 

• To match new incoming messages, 
make sure the Incoming checkbox is 
checked for each filter (it's done for 
you by default) . 

Almost all of my filters are incoming 
filters. 

Outgoing 

• To match outgoing messages once they're 
sent, check the Outgoing checkbox. 

I seldom use outgoing filters, but you 
could use them to archive only certain 
outgoing messages for later reference. 

Manual 

• To match only the messages you've 
selected in a mailbox, check the Manual 
checkbox. 

Manual filters, though not as commonly 
used as incoming fllters, enable you to 
perform actions on arbitrary sets of mes
sages whenever you like. 

tl Tip 

• When you're considering creating a man
ual filter, consider if there isn't an easier 
way of accomplishing the same task. For 
instance, if you're using Eudora Pro, you 
can Option/ Ale-click a message summary 
cell to select all messages like that one, 
and once you've selected them, transfer 
them to another mailbox. A manual filter 
could do the same thing, but is probably 
more work. 
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Chapter 7 

Header lines 
Eudora's filters can examine any line in 
message headers or even in message bodies 
(Figure 3). 

Header lines for filters 

• · To look for the match string in a specific 
message header line, choose To, Cc, From, 
Subject, or Reply-To from the Header 
pop-up menu. 

• To look for the match string in the To or 
Cc line of message headers, choose «Any 
Recipient» from the Header pop-up 
menu. 

• To look for the match string in any header 
line, choose «Any Header» from the 
Header pop-up menu. 

• To look for the match string in the bodies 
of messages, choose «Body» from the 
Header pop-up menu. 

• In Eudora Pro, to look for the match 
string in the name of the personality 
associated with the messages, choose 
«Personality» from the Header pop-up 
menu. 

t/nps 
• <<Any Recipient» is useful because people 

don't use the To or the Cc lines consis
tendy, and «Any Recipient» matches both. 

• Subject filters seldom work well, since 
people aren't good at writing subjects 
consistendy. 

• Reply-To filters are most useful with mail
ing lists that set explicit Reply-To lines. 

• Scanning message bodies is slower than 
scanning message headers, and scanning 
the entire header is a litde slower than 
scanning a specific line. Speed isn't an 
issue until you amass a lot of filters. 
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Figure 3 Choose an item from the Header pop-up 
menu to have Eudora scan that part of the header for 
the match string. The currently selected item is 
indicated with a diamond in the Mac versions of Eudora 
and by being highlighted in the Windows versions. 
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does not co ntai n 
is 
is not 
starts with 
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appears 
does not appear 
i nte rsects nickname 

Figure 4 Choose an item in the Contains pop-up 
menu to control how Eudora compares the chosen 
header line with the match string. The currently 
selected item is indicated with a diamond in the Mac 
versions of Eudora and by being highlighted in the 
Windows versions. 
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Working with Filters 

Contains menu 
After you've told a filter which header line to 
scan, you must determine how it should 
compare the match string to the chosen item 
in the Header pop-up menu (Figure 4). 

Contains menu items 

• To match header lines that contain a 
portion of the match string, choose 
"contains." For instance, ace@tidbits.com 
contains the match string ace. 

• To match header lines that don't contain a 
portion of the match string, choose .. does 
not contain." For instance, ace@tidbits.com 
does not contain the match string gurgle. 

• To match header lines that contain the 
complete match string, choose "is." For 
instance, the match string ace@tidbits.com is 
ace@tidbits.com. 

• To match header lines that don't contain 
the complete match string, choose "is 
not." For instance, the match string ace is 
not ace@tidbits.com. 

• To match header lines that start with the 
match ·string, choose "starts with." For 
instance, ace@tidbits.com starts with the 
match string ace. 

• To match header lines that end with the 
match string, choose "ends with." For 
instance, ace@tidbits.com ends with the 
match string tidbits.com. 

• To match header lines that appear in the 
header, choose "appears." 

• To match header lines that don't appear in 
the header, choose "does not appear." 

• To match header lines that contain an 
address that's part of the nickname 
entered as the match string, choose 
"intersects nickname." 
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Chapter 7 

Filter actions 
Filters must do something, and Eudora Pro 
provides numerous possibilities (Figure 5) . 
Eudora Light can only change priorities and 
subjects, copy or transfer messages, and skip 
the rest of the filters. 

Action menu items 

• To have the filter do nothing to a message 
or have that m essage skipped by all other 
filters choose None or Skip Rest. 

• To change the personality (Mac Eudora 
Pro. only), status, priority, or label of the 
matched message, choose Make 
Personality, Make Status, Make Priority, or 
Make Label, and then choose a personality, 
status, priority, or label from the pop-up 
menus to the right. 

• 

• 

To change the subject of the matched 
message, choose Make Subject, and enter a 
subject in the text field to the right. 

To notify an application like paging soft
ware (Windows Eudora Pro only). play a 
sound, open the m essage or the message's 
mailbox, print the message, notify you, or 
change the server status of the message, 
choose Notify Application, Play Sound, 
Open, Print, Notify User, or Server Status, 
and set the controls to the right. 

• To forward or redirect the matched mes
sage, choose Forward To or Redirect To, 
and enter an email address or nickname in 
the text field to the right. 

• To reply to the matched message, choose 
Reply With and then choose a stationery 
from the pop-up menu to the right. 

• To copy or move the matched message to 
a mailbox, choose Copy To orTransferTo 
and then choose a mailbox from the 
Transfer menu (Mac) or the pop-up menu 
(Windows). 
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<> None 

Make Status 
Make Priority 
Make Label 
Make Personality 
Make Subject 

Play Sound 
Open 
Print 
Notify User 

Forward To 
Redirect To 
Reply With 

Server Options 

Copy To 
Transfer To 

Skip Rest 

Figure 5 Choose an item in the Action pop-up menu 
to perform that action on matched messages. The 
currently selected item is indicated with a diamond in 
the Mac versions of Eudora and by being highlighted 
in the Windows versions. 

Action advice 

The most commonly used action is 

'fransferTo, which you use to separate 
mailing lists into mailboxes. I also use 
Open to open messages and mailboxes. 

The actions for changing status, priority, 
label, and subject are especially useful for 
organizing and categorizing messages 
within a mailbox. 

The Forward To and Redirect To items 
won't work with mail that was automati
cally generated, such as bounces. 

Eudora can perform up to five different 
actions in a single filter, so you could 
easily have a filter change the label of a 
message, raise its priority. transfer it to a 
mailbox, open that mailbox, and play a 
sound, all from a single filter. 
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Figure 6 To activate manual filters, select some 
messages in a mailbox, then choose Filter Messages 
from the Special menu. 

Working with Filters 

Activating filters 
I noted previously in this chapter three ways 
of selecting which messages filters look at, 
controlled by the Incoming, Outgoing, and 
Manual checkboxes. It follows, then, that 
there are three ways of activating filters, 
depending on the type. 

To activate incoming filters 

1. To activate incoming filters, which are 
the most common type, simply choose 
Check Mail from the File menu or use any 
other method of having Eudora retrieve 
new messages. (See Chapter 4, "Sending and 
Receiving Messages") 

Eudora retrieves the new incoming mes
sages, and once it's done, applies your 
incoming filters to them. 

To activate outgoing filters 

1. To activate outgoing filters, simply 
choose Send Queued Messages from the 
File menu or use any other method of 
having Eudora send outgoing messages. 
(See Chapter 4, "Sending and Receiving Messages") 

Eudora sends the queued outgoing mes
sages, and once it's done, applies your 
outgoing filters to them. 

To activate manual filters 

1. To activate manual fllters, select some 
messages in a mailbox, then choose Filter 
Messages QCmdl-J/@ill-J) from the Special 
menu (Figure 6) . 

Eudora immediately applies your manual 
filters to the selected messages. 
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Chapter 7 

Filter ideas 
How might you use filters? Lots of ways, but 
here are a few suggestions that I use. 

Filter ideas 

• Create filters that transfer messages from 
mailing lists to their own mailboxes. This 
sort of filter keeps down the clutter in 
your In mailbox and allows you to read 
mailing lists whenever you want. 

• Create a set of filters that transfer messages 
from your close friends and family into a 
specific mailbox. I like to do this, and I 
keep those messages as a kind of email 
diary. 

• Create filters that open messages or play 
sounds when you receive messages from 
important people. That way you're more 
likely to see the messages and reply 
promptly. 

• Create a filter that marks messages by 
whether your address appears in the To 
line, the Cc line, or in none of the recipi
ent lines. You can usually assume that mail 
that's cc'd to you is less important than 
messages sent directly to you, and mail 
that doesn't contain your address at all 
seldom requires a response or might even 
be spam. 

• If you frequently receive misc!irected 
mail, create a filter that forwards or redi
rects messages to the appropriate person 
automatically. 

• Create a set of fllters that transfer bounce 
messages into a special mailbox where 
you can figure out how to deal with them. 
Set the filter to look for addresses contain
ing postmaster, Mailer-Daemon, or Mail Delivery 
Subsystem. 
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\want. I once filtered o~ -tWo exclama~ 
j tion points in the s\lbj~c:;t~ put that 
1 occasionally caught a good message. 

• ! Spammers·almost always forge 
i ~ddresses, sodt's difficult to filter 
j strccessfuny oil any ·given. address. I 
! capture 5ome spam by looking in <<Any 
; Header>> for cyherpromo. ie.mmc.otg, 
l ispam.net, and savetrees.com. But, such· a 
I system is always doomed to failure, 
I because spammers are always trying to 
, circumvent filters. 

• Th~e are a variety of utilities and, pre .. 
tonfigured filters for eliminating spam 
from your In mailbox, but frankly, I 
haven't found them ail that. useful. 
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Figure 7 To find a filter in the Mac versions of Eudora, 
open the Filters window, open the find window, enter a 
search term in the f ind field , and click the find button. 

Figure 8 Eudora searches through your filters and 
selects the first one that matches the search term. 

Working with Filters 

Finding filters 
After you've been creating filters for a while, 
it becomes difficult to find any given one in 
the list. In the Mac versions of Eudora, you 
can use the Find window to find a filter. 

To find a filter 

1. From the Special menu, choose Filters. 

Eudora opens the Filters window. 

2. From the hierarchical Find menu in the 
Special menu, choose Find OCmdH). 
Eudora opens the Find window (Figure 7). 

3. Enter the search term in the Find field. 
The search term should include the text 
for which the filter looks, such as an email 
address. 

4 . Click the Find button. 

Eudora starts searching through your 
filters. If Eudora fmds a match, it stops 
and selects the matching filter (Figure 8). 
If not, Eudora tells you that it was unable 
to find the search term. 

5. To continue searching if you find a fllter 
that's not the one you want, click the Find 
button again. 

V' Tips 

• Don't worry about the starting point when 
trying to find a filter. Eudora searches your 
entire set of filters, starting at the selected 
filter and wrapping around if necessary. 

• The Match case checkbox works as you 
would expect, so if it's checked, a search 
·for ACE will not find a fllter that looks for 
acc@tidbits.com. 

• Avoid the Whole word checkbox because 
it's not clear what a "word" is in the con
text of a filter. 
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Chapter 7 

Modifying filters 
Sooner or later someone's email address will 
change or you'll want to modify a filter for 
different actions. 

To modify a filter 
1. From the Special menu (Mac) or the 

Tools menu (Windows), choose Filters. 

Eudora opens the Filters window 
(Figure 9). 

2. From the list on the left side of the Filters 
window, click the filter you want to mod
ify to select it. 

3. Modify the fllter settings as desired. 

4. In the Mac versions of Eudora, choose 
Save from the File menu to save your new 
filter. In the Windows versions, close the 
Filters window and click Yes when 
prompted to save. 
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Figure 9 To modify a filter, open the Filters window, 
click the filter you want to modify, and then change the 
actions or any other part of the filter. 

Mac filter effectiveness 
In the Mac versions of Eudora, you can 
determine how well your filters work (and 
if t!hey're working at all). Eudora creates a 
Last Used date field above the Action 
menus and updates it every time that filter 
activates. I periodically scan my filters to 
make sure they're being used. If the Last 
Used date is many months old, I look 
more closely at the filter to see if some
thing about it has broken, or if I've simply 
stopped receiving messages that it would 
match (perhaps I unsubscribed from a 
mailing list). If it's no longer necessary, I 
delete the filter to speed up the filtering 
process. 
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Figure I 0 To reorder a filter in the Mac versions of 
Eudora, drag it up or down in the list of filters. A small 
line indicates where it will go when you drop it. 
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Figure I I To reorder a filter in the Windows versions 
of Eudora, select the filter then click the Up or Down 
buttons to move it up or down in the list. Here I've 
moved my filter for Tonya down in the list. 

Working with Filters 

Reordering filters 
When filters are invoked, either automatically 
or manually, Eudora matches each message 
against each filter, working from the top of 
the filter list to the bottom. If you include the 
Skip Rest action in a fllter, Eudora skips all 
other filters below that one for that message. 
Thus, the order of filters can prove important. 
In addition, I like to group related filters 
(such as all those that look for m essages from 
friends and family) for easier access. 

To reorder a filter (Mac) 

1. From the Special menu, choose Filters. 

Eudora opens the Filters window. 

2. Click the filter you want to reorder and 
drag it up or down in the list (Figure 10). 

3. Drop the filter in the desired location, as 
indicated by a small blue line that appears 
in the list. 

4. Choose Save from the File menu to save 
your changed fllter order. 

To reorder a filter (Windows) 

1. From the Tools menu, choose Filters. 

Eudora opens the Filters window. 

2. Click the filter you want to reorder, and 
then click either the Up or Down button 
at the top of the list to move the filter 
up or down in the list (Figure 11). 

3. Choose Save from the File menu to save 
your changed filter order. 

V' Tip 

• In the Mac versions of Eudora, you can 
m ove multiple filters at the same time. 
Shift-click to select a range of filters, or 
Command-click to select a noncontiguous 
set of filters, then drag them all at once. 
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Chapter 7 

Deleting filters 
If you unsubscribe from a mailing list or 
stop receiving mail that requires filtering, 
you should delete the unused filters. 

To delete a filter 
1. From the Special menu (Mac) or the 

Tools menu (Windows), choose Filters. 

Eudora opens the Filters window. 

2. Click the filter you want to delete 
(Figure 12). 

3. Click the Remove button. 

Eudora deletes the filter instantly, without 
asking first. 

4. In the Mac versions of Eudora, choose 
Save from the File menu to save your 
new filter. In the Windows versions, close 
the Filters window and click Yes when 
prompted to save. 

vTips 

• In the Mac versions of Eudora, you can 
delete multiple filters at the same time. 
Shift-click to select a range of filters, or 
Command-click to select a noncontiguous 
set of filters, then click the Remove button 
to delete them. 

• Be careful when deleting filters because 
Eudora doesn't warn you before deleting 
them. 
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Figure 12 To delete a filter, select it and then click the 
Remove button. 



FINDING 
• 
~ 

AND SEARCHING 
In Chapter 6, "Working with Mailboxes," I 
encouraged you to store old messages in 
mailboxes for later reference. Much of my 
communication takes place in email, which 
makes my stored email the record of both my 
personal and my business lives. 

In previous chapters I introduced you to a 
number of features that simplify the task of 
finding messages, including features like sort
ing and Option/ Alt-clicking messages to 
select similar messages in the same mailbox. 

But, what if you need to find a message that 
you stored away some time ago, and you're 
not sure who sent it or when it carne in? In 
such a situation, you must rely on Eudora's 
finding and searching capabilities. 

Unfortunately, although Eudora's finding and 
searching capabilities are fast and powerful, 
they can be confusing, especially in the Mac 
versions of Eudora. After you read this chap
ter, though, you shouldn't have problems. 

To aid in understanding, I recommend that 
you read all the pages relevant to your version 
of Eudora in this chapter, since later pages 
build on earlier ones in significant ways. 

These features differ a good bit between the 
Mac and Windows versions of Eudora, so I'll 
cover the two separately where necessary. 
Let's see what we can find! 
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Chapter 8 

Finding text in a message 
The first task is to find text within a single 
message. Occasionally you receive a long 
message, and it's easier to use Eudora's Find 
feature than it is to scan the message. 

I call the text you want to find the "search 
term" throughout this chapter. 

To find text in a message 

1. Open a message window, then choose 
Find GCmdl-F) from the hierarchical Find 
menu (Figure 1) in the Special menu. 

Eudora opens the Find window. For now, 
ignore everything below the horizontal 
line under Options. 

2. Type the search term in the Find field 
(Figure 2) . 

3. Click the Find button to fmd the fust 
instance of the search term. 

Eudora selects the found text (Figure 3). 

4. To find subsequent instances of the search 
term within the message, continue to click 
the Find button or choose Find Again 
G Cmd l-G) from the hierarchical Find 
menu in the Special menu. 

V'Tips 

• To restrict the found text to whole words, 
check the Whole word checkbox. Without 
Whole word checked on a search for sing, 
Eudora finds sing, singer, and singing. With 
Whole word checked, Eudora finds only 
sing. 

• To restrict the found text to words with 
the same case as the search term, check 
the Match case checkbox. Without Match 
case checked on a search for sing, Eudora 
finds sing, Sing, and SING. With Match case 
checked, Eudora finds only sing. 
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Figure I To find text in a message, open the message 
window, then choose Find from the hierarchical Find 
menu in the Special menu. 
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Figure 2 Eudora then opens the Find window. Enter 
your search term in the Find field, and click the Find 
button to find the first instance of the search term in 
the current message window. 
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Figure 3 Eudora selects the found text within the 
current message. Click the Find button in the Find 
window to find the next instance of the search term. 



WINDOWS ONLY! 

Figure 4 To find text in a message, open the message 
window, then choose Find from the hierarchical Find 
menu in the Edit menu. 

Figure 5 Eudora then opens the Find window. Enter 
your search term in the Find field, and click the Find 
button to find the first instance of the search term in 
the current message window. 
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Figure 6 Eudora selects the found text within the 
current message. Click the Find button in the Find 
window to find the next instance of the search term. 

Finding and Searching 

Finding text in a message 
The first task is to find text within a single 
message. Most messages are fairly short, but 
occasionally you receive a long message, and 
it's easier to use Eudora's Find feature than it 
is to scan the message. 

I call the text you want to find the "search 
term" throughout this chapter. 

To find text in a message 

1. Open a message window, then choose 
Find @!ill-F) from the hierarchical 
Find menu (Figure 4) in the Edit menu. 

Eudora opens the Find window. 

2. Type the search term in the Find field 
(Figure 5). 

3. Click the Find button to find the first 
instance of the search term. 

Eudora selects the found text (Figure 6) . 

4. To find subsequent instances of the search 
term within the message, continue to click 
the Find button or choose Find Again 
((ill) from the hierarchical Find menu 
in the Special menu. 

II Tips 

• To restrict the found text to words that 
have the same case as the search term, 
check the Match case checkbox. Without 
Match case checked on a search for sing, 
Eudora finds sing, Sing, SING, and so on. 
With Match case checked, Eudora finds 
only sing. 

• Checking the Summaries only checkbox 
has no effect when you are finding text 
within a single message. 
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Chapter 8 

Searching for 
text in a mailbox 
You'll also want to search all messages in a 
mailbox. Note that "finding" happens in a · 
single message; "searching" spans messages. 

To search for text in a mailbox 

1. Open a mailbox, scroll to the top, select 
the first message, and then choose Find 
OCmd~F) from the hierarchical Find 
menu in the Special menu. 

Eudora opens the Find window. 

2. Type the search term in the Find field. 

3. Click the Search "Mailbox" button 
(Figure 7) to locate the first instance of 
the search term. The name of the button 
changes to reflect the current mailbox. 

Eudora displays the Finding dialog box 
and, when it finds a message containing 
the search term, opens the message and 
selects the found text. 

4. To locate subsequent instances of the 
search term within that mailbox (moving 
from top to bottom), continue to click the 
Search "Mailbox" button or choose Search 
Again OCmd~;) from the hierarchical Find 
menu in the Special menu. 

t/ Tips 

• To make a message the starting point, 
select it, then open the Find window. 
Selecting a message when the Find win
dow is already open has no effect on the 
starting point unless you also change the 
search term. 

• Click the buttons that look like VCR but
tons (Figure 7) to change the starting 
point or click the Choose button and 
choose a mailbox from the Mailbox menu 
to make the first message in that mailbox 
your starting point. 
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Figure 7 To search within a single mailbox, open the 
mailbox, select the top message to make it the starting 
point, open the Find window, enter your search term in 
the Find field, then click the Search "Mailbox" button. 
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Oick to search within the 
current mailbox (older. 

Figure 8 To search within a mailbox folder, open the 
first mailbox in the mailbox folder, select the top 
message to make it the starting point, open the Find 
window, enter your search term in the Find fie ld, then 
click the Search "Mailbox folder" button. 

Finding and Searching 

Searching for text 
in a mailbox folder 
A desired message may live in one of several 
mailboxes within a mailbox folder. If so, you 
can restrict your search to messages in mail
boxes in a specific mailbox folder. (See Chapter 
6, "Working with Mailboxes") 

To search for text 
in a mailbox folder 

1. Open the first mailbox in a mailbox 
folder, scroll to the top, select the first 
message, and then choose Find a Cmd H) 
from the hierarchical Find menu in the 
Special menu. 

Eudora opens the Find window. 

2. Type the search term in the Find field. 

3. Click the Search "Mailbox folder" button 
(Figure 8) to locate the first instance of 
the search term. 

Eudora displays the Finding dialog box 
and, when it finds a message containing 
the search term, opens the message and 
selects the found text. 

4. To locate subsequent instances of the 
search term within a mailbox folder 
(moving from top to bottom, as defined 
by the order of the Mailbox menu), con
tinue to click the Search "Mailbox folder" 
button or choose Search Again QCmd~;) 

from the hierarchical Find menu in the 
Special menu. 

V" Tip 

• Refer to Figure 7 on the previous page for 
descriptions of the buttons that look like 
VCR buttons. 
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Searching in 
multiple ·mailboxes 
You may not know what mailbox contains a 
desired message, and in the Mac versions of 
Eudora you can expand your search to 
include multiple mailboxes. 

To search iri multiple mailboxes 

1. Set a starting point by opening a mailbox, 
scrolling to the top, selecting the first 
message, then choosing Find QCmdH) 
from the hierarchical Find menu in the 
Special menu. 

Alternately, use the VCR buttons or the 
Choose button in the Find window to set 
the starting point. 

Eudora opens the Find window. 

2. Type the search term in the Find field. 

3. Click the Search To End button (Figure 9) 
to search messages in all mailboxes below 
the starting point. 

Eudora displays the Finding dialog box 
and, when it finds the search term, opens 
the message and selects the found text. 

4. To locate subsequent instances of the 
search term within any mailbox below the 
current mailbox, continue to click the 
Search To End button or choose Search 
Again QCmd~ ;) from the hierarchical Find 
menu in the Special menu. 

V' Tips 

• If no mailboxes are open, Eudora sets the 
starting point at the first message in the 
first mailbox, which is the In mailbox. 

• When a search hits the end of all mail
boxes, it stops. 

• To stop a search, click the Stop button in 
the Finding dialog box (Figure 10) . 
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Figure 9 To search multiple mailboxes, open the first 
mailbox you want to search, select the top message 
to make it the starting point, open the Find window, 
enter your search term in the Find field, then click the 
Search To End button. 
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Figure I 0 To stop a search, click the Stop button in the 
Finding dialog box. 
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Find ~eld 

Oick to locate the next instance of 
the search term, starting with the 
~rst message in the next mailbox. 

Oick to locate the next 
instance of the search 
term, starting with the 
next message. 

Oick to locate the next 
instance of the search term 
in the same message or any 
subsequent message. 

Figure I I To search multiple mailboxes, open the first 
mailbox you want to search, select the top message, 
open the Find window, enter your search term in the 
Find field, then click the Find button. 

Figure 12 To stop a search, click the Stop button in 
the Progress di~log box. 

Finding and Searching 

Searching in 
multiple mailboxes 
The Windows versions of Eudora can't restrict 
a search to a mailbox or a mailbox folder, but 
as a result, it's a bit easier to use. 

To search in multiple mailboxes 

1. Open a mailbox, scroll to the top, select 
the first message, and then choose Find 
(@!ill-F) from the hierarchical Find menu 
in the Edit menu. 

Eudora opens the Find window. 

2. Type the search term in the Find field. 

3 . Click the Find button (Figure 11) to 
locate the first instance of the search term. 

Eudora displays the Progress dialog box 
and, when it finds a message containing 
the search term, opens the message and 
selects the found text. 

4. To locate subsequent instances of the 
search term within the current message, 
the current mailbox, or all mailboxes 
(moving from top to bottom in both the 
current mailbox and the list of mailboxes 
as displayed in the Mailbox menu), click 
the Next button (@!ill-;). 

Alternately, to skip to the next message 
and continue searching, click the Next 
message button. 

Alternately, to skip to the next mailbox 
and continue searching, click the Next 
mailbox button. 

V' Tips 

• When a search reaches the bottom of the 
current mailbox, it wraps around 
throughout all your mailboxes. 

• To stop a search, click the Stop button in 
the Progress dialog box (Figure 12). 
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Searching for text in 
message summaries 
Searching the full text of every message 
can take a while if you have many stored 
messages. To speed up the search, consider 
limiting your search to the Sender and 
Subject columns of the message summaries 
that you see in mailboxes. The Mac and 
Windows versions of Eudora share this 
feature. 

To search for text 
in message summaries 

1. Set up any of the previously mentioned 
methods of searching. 

2. Before clicking the Find button or any of 
the search buttons, check the Summaries 
only checkbox in the Find window 
(Figure 13). 

3. Continue with the search as you would 
normally, and note how much faster 
Eudora searches . 

.t Tips 
• Remember that searching only in message 

summaries restricts you to searching for 
text you can see in the Sender or Subject 
columns of the message summaries. 

• The Sender column generally contains 
only names, not email addresses. 

• Although searching for text in message 
summaries proceeds much more quickly 
than full text searching, it's much easier to 
enter a search term that won't match any 
messages. 

• Eudora's full text finding and searching 
capabilities are sufficiently fast that 
searching for text in message summaries 
is primarily useful if you're searching 
through numerous large mailboxes. 
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Figure 13 To search just message summaries, which is 
much faster than a full text search, check the Summaries 
only checkbox in the Find window before performing 
any other sort of search. 
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Figure 14 To transfer selected text to the Find field of 
the Find window, choose Enter Selection from the 
hierarchical Find menu in the Special menu (Mac) or 
the Edit menu (Windows). 
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Figure IS To search all mailboxes in the Mac versions 
of Eudora, set the starting point to the first message in 
the In mailbox by clicking the First Message VCR 
button, then use the Search To End button. 

Find ... X F 
Find Again X G 
Enter Selection ·-
Search Rqain X; 

Search MallboH 
Search Mall folder 

Figure 16 The hierarchical Find menu in the Special 
menu duplicates several of the Find window's buttons. 

f.rnd Or .. F 
Find Again F3 
fnttr Selection Alttf3 

Figure 17 The hierarchical Find menu in the Edit menu 
duplicates several of the Find window's buttons. 

Finding and Searching 

Searching tips and tricks 
The best way to become comfortable with 
Eudora's finding and searching capabilities is 
to try them. However, here are a few tips and 
tricks that might be especially handy. 

V' Tips 

• If a search has gone too far, especially in 
the Windows versions of Eudora, click the 
Stop button to stop it. 

• After stopping a search or after a search 
fails, remember that you must reset the 
starting point in the Mac versions of 
Eudora before trying again. 

• To move selected text in a message to the 
Find field in the Find window, choose 
Enter Selection QCmd~=/@ffi from 
the hierarchical Find menu (Figure 14) in 
the Special menu (Mac) or Edit menu 
(Windows). V\ 

'" ,. 
• To search all mailboxes in the Mac ver- :=D 

t"\ 
sions, set the starting point to the first :z: 
message in the In mailbox, which you can z 

G"' 
do by clicking the First Message VCR but- ::! 
ton in the Find window (Figure 15), then 'V 

use the Search To End button. 
Cll ,. 
z • The Whole word (Mac only) and Match II:' 

case checkboxes apply to both finding and -t 
:=D 

searching. n 
~ 

• The hierarchical Find menu (Figure 16 Cll 

and Figure 17) contains menu items that 
duplicate the Search Mailbox, Search 
Mailfolder, and Search To End buttons 
(Mac) and the Next Message and Next 
Mailbox buttons (Windows). I can't 
imagine why you'd use them instead 
of the buttons, but they're there if you 
want them. 

• In case I haven't sufficiently beaten this 
deceased equine, in the Mac versions of 
Eudora, pay attention to the starting point! 
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WORKING WITH 

THE ADDRESS BOOK 
Let's face it-lots of email addresses are con
fusing and hard to type. And, if you type an 
email address incorrectly, your message will 
probably bounce or be delivered to the 
wrong person. 

Eudora addresses this problem (pun intended, 
sorry) by providing a powerful address book 
in which you can store email addresses and 
link them ro nicknames that are short, easy to 
remember, and easy to type. So, since I send 
email to my wife Tonya all the time, instead of 
typing her email address in each message, I 
just type the letter t, which is my nickname 
for her. Eudora then substitutes the address 
for the nickname. 

In addition to making it easier to address 
messages, Eudora's address book enables you 
to associate a single nickname not just with 
an individual , but also with a group of peo
ple. Want to create a nickname that expands 
to the email addresses of your entire family, 
all your college friends, or the people in your 
department? No problem. 

Nicknames are so useful that I strongly rec
ommend you make heavy use of Eudora's 
address book capabilities. If you send some
one or a group of people mail frequently, 
using a nickname is the easiest way to go. 
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Chapter 9 

Creating nicknames for 
individuals 
Eudora offers several ways to create nicknames 
for individuals. 

To create individual nicknames (I) 

1. Open or select a message, and then choose 
Make Address Book EntryOCmd~K/@ill-K) 
from the Special menu (Figure 1) . This 
creates a nickname for the sender of the 
selected message. 

Or, in the Mac versions, select an email 
address, hold down Shift, and then choose 
Make Address Book Entry {ICmdHShift~K) . 

Eudora displays the New Nickname (Mac) 
or Make Address Book Entry (Windows) 
dialog box (Figure 2) . 

2. Enter a nickname, and if desired, check 
the "Put it 'on the recipient list" checkbox. 
(See "Using the recipient list" in Chapter 2, "Creating 
MessageO In Eudora Pro, choose a file from 
the pop-up File menu. Click OK. 

To create individual nicknames (II) 

1. Open the Address Book window 
(Figure 3) by choosing Address Book 
{ICmdi-LIICtrii-L) from the Special (Mac) 
orTools (Windows) menu. 

2. Click the New button to display the New 
Nickname dialog box. 

3. Enter a nickname, and if desired, check 
the "Put it on the recipient list" checkbox. 
In Eudora Pro, choose a file from the pop
up File menu. Click OK. 

4. In the Address(es) field, enter the nick
name's email address. Optionally, check 
the Recipient List checkbox, and in the 
other fields, enter the person's real name, 
notes, and in Eudora Pro, postal address, 
phone number, and fax number. Choose 
Save from the File menu. 
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Figure I To create an individual nickname for the 
sender of a message, open or select a message, 
then choose Make Address Book Entry from the 
Special menu. 

~ doyauwilh ID call it? 

J 

Figure 2 Eudora displays the Make Address Book 
Entry (Windows) or New Nickname (Mac) dialog box. 
Enter a nickname, check the "Put it on the recipient 
list" checkbox if desired, choose a file in Eudora Pro. 
and click OK. 

Click to switch to 
the Addresses ~eld. 

Click to switch to 
the Notes ~eld. 

Click to switch 
to the Info ~eld. 

Figure 3 Alternately, open the Address Book window, 
click the New button, enter a nickname in the Make 
Address Book Entry (Windows) or New Nickname 
(Mac) dialog box, then enter the email address in the 
Address(es) field . 
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Emptq Trash 

Figu re 4 To create a group nickname, select several 
messages, then choose Make Address Book Entry from 
the Special menu. 

New Nickname 

Whet do y ou wish to cell 117 

I steff 

In file: I TldBITS ..,. I 
181 Put It on t he recipient list 

Figure 5 Eudora displays the New Nickname (Mac) or 
Make Address Book Entry (Windows) dialog box. Enter 
a nickname, check the "Put it on the recipient list" 
checkbox if desired, choose a file in Eudora Pro, and 
then click OK. 
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Figure 6 Alternately, open the Address Book window, 
click the New button, enter a nickname in the New 
Nickname (Mac) or Make Address Book Entry 
(Windows) dialog box, then enter the email addresses 
in theAddress(es) fie ld. 

Working with the Address Book 

Creating group nicknames 
Eudora also offers several ways to create nick
names for groups of people. 

To create group nicknames (I) 

1. Select several messages, then choose Make 
Address Book Entry QCmd~K/@!ill-K) 
from the Special menu (Figure 4) . This 
creates a group nickname for the senders 
of those messages. 

Or, in the Mac versions, select several 
addresses, hold down Shift, then choose 
Make Address Book Entry 0 Cmd H Shift~ K) . 

Eudora displays the New Nickname (Mac) 
or Make Address Book Entry (Windows) 
dialog box (Figure 5). 

2. Enter a nickname, and if desired, check 
the "Put it on the recipient list" checkbox. 
(See "Using the recipient list" in Chapter 2, "Creating 
Messagesn) In Eudora Pro, choose a file from 
the pop-up File menu. Click OK. 

To create group nicknames (II) 

1. Open the Address Book window by 
choosing Address Book QCmd)-LI[Ctrl )-L) 
from the Special (Mac) or Tools 
(Windows) menu (Figure 6) . 

2 . Click the New button to display the New 
Nickname dialog box . 

3. Enter a nickname, and if desired, check 
the "Put it on the recipient list" checkbox. 
In Eudora Pro, choose a file from the pop
up File menu. Click OK . 

4. In theAddress(es) field, enter the nick
name's email addresses, separating them 
with commas or returns. Optionally, check 
the Recipient List checkbox, and in the 
other fields, enter a name for the group. 
any notes, and in Eudora Pro, a postal 
address, phone number, and fax number. 
Choose Save from the File menu. 
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Chapter 9 

Nickname tips 
A few tips may make creating and using nick
names easier. 

V' Tips 
• You can't use spaces in nicknames, but 

you can use underscores (Eudora defaults 
to replacing spaces with underscores) , 
hyphens, or most any other character. 

• To simulate a space in your nicknames, 
hold down Option (Mac) or Control 
(Windows) and press the Spacebar. 
Remember that you'll have to type 
Option-Spacebar or Control-Spacebar to 
enter the nickname correctly. 

• It's a good idea to make groups from 
other nicknames. That way, for instance, if 
you have a Family group nickname, and 
your sister changes her email address, you 
can change her individual nickname and 
have that change automatically reflected in 
the Family group nickname. 

• Eudora knows about a special nickname 
called "me." If you create it and fill it in 
with your personal information, Eudora 
uses that information to determine who 
you are to satisfy the Include yourself 
checkbox in the Replying settings panel 
(Figure 7). In addition, Eudora uses the 
me nickname to determine if you're the 
sender of a message that you're redirect
ing (and if so, it adds your signature to 
the message) . 

• In the Windows versions of Eudora, you 
can right-click a nickname or the nick
name list in the Address Book window to 
display a pop-up menu that duplicates 
some of the controls in the Address Book 
window: 

Figure 7 Eudora uses the "me" nickname to determine 
who you are for the sake of the Include yourself 
checkbox in the Replying settings panel. 

Eudora's hidden glossary 
Many word processors have glossary 
features that let you set up shortcUts for 
commonly used pieces of boilerplate text. 
For instance, you 1}1ight type add and have 
thb word processor replace that with your 
full postal address. 

E~dora doesn't claim to have this feature, 
bu:t it does! You can enter any text you 
w.bt as the address of a nickname. Then, 
in ·a message, type the nickname, hold 
d<>rwn Option (Mac) or Shift (Windows) 
ana choose Finish and Expand Address 
Book Entry QCmdHOptlon~,/lCtrl HShift~,) 
from the Edit menu. I always use the key
board shortcuts, but you could also hold 
do:wn Option (Mac) or Shift (Windows) 
and choose a nickname from the hierar
chical Insert And Expand Recipient menu 

in ~the Edit menu. 

Make sure that the "Domain to add to 
unqualified names" field in the Sending 
M.pl settings panel is empty, or Eudora 
w:ill add that domain to the first word of 
your glossary entry, as in This@tidbirs.com is 

a test. 
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Click to collapse 
the Address 
&ok window. --f~~~ 

Figure 8 To collapse the Address Book window, click 
the Collapse button. 

,L!.O_,.....- Oick to expand 
l~:;;=;;::::=;r.;=; the Address 

Book window. 

Figure 9 Eudora then hides the nickname editing area. 

-·-,_, ... _ 
.,n. .... ,""'' ... _ 
• . ,..tile 

•""'" •. 
Click to expand 
the Address 
&okwindow. 

Figure I 0 To expand the Address Book window, click 
the Expand button {which is the same as the Collapse 
button in the Mac versions of Eudora). 

Figure II To change the contents of the nickname list, 
choose one of the items from the View By pop-up 
menu. Here I've chosen Name instead of Nickname. 

Working with the Address Book 

Using the Address Book 
window 
The Address Book window offers features that 
ease working with nicknames. 

To collapse and expand 
the Address Book window 

1. To collapse the Address Book window 
and save screen space, click the Collapse 
button (Figure 8). 

Eudora hides the nickname editing area 
(Figure 9). 

2. To expand the Address Book window 
(which is necessary to edit nicknames), 
click the Expand button, which is the 
same as the Collapse button in the Mac 
versions (Figure 10) . 

To change the 
nickname list contents 
1. To switch between Nickname, 

Address(es), Name, Postal Address, Phone, 
and Fax, choose the desired item from the 
View By pop-up menu (Figure 11). 

Eudora changes the nickname list to 
match the View By menu setting. 

t/ Tips 

• You can resize the nickname list pane by 
clicking and dragging the vertical line that 
separates it from the editing area. 

• In the Mac version of Eudora Pro, to 
expand typed nicknames to their email 
addresses immediately, check the "Expand 
nicknames immediately" checkbox in the 
Sending Mail settings panel. 

• In the Windows version of Eudora Pro, to 
expand typed nicknames to their email 
addresses immediately, check the Expand 
Nickname checkbox in the Address Book 
window. 

137 



Chapter 9 

Adding nicknames to 
messages 
If you're working in the Address Book win
dow already, or if you want to send a message 
to a lot of different people, you can address a 
message directly from within the Address 
Book window. And, of course, you can always 
just type a nickname in the To, Cc, or Bee 
fields of a message. 

To add nicknames to a message 

1. Open the Address Book window by 
choosing Address Book GCmd~LI@ill-L) 
from the Special (Mac) or Tools 
(Windows) menu. 

2. Select one or more nicknames and click 
the To, Cc, or Bee button (Figure 12) . 

Eudora creates a new message if necessary 
and inserts the nicknames in the field 
corresponding to the button you clicked. 

t/ Tips 

• You can drag nicknames out of the 
Address Book window in the Mac versions 
of Eudora, but you get all the information 
in the nickname, not the nickname itself 

• To keep the Address Book window in the 
front after adding a nickname to a mes
sage, hold down Shift when you click the 
To, Cc, or Bee button. This is handy if 
you want to add more nicknames to the 
message. 

• In the Mac version of Eudora Pro, to 
expand a nickname immediately even if 
Eudora is set not to do so, hold down 
Option when you click the To, Cc, or Bee 
button. 

• Combine the two previous tips by holding 
down Shift-Option when clicking the To, 
Cc, or Bee button. 
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Figure 12 To insert one or more selected nicknames 
in the To, Cc, or Bee fields of an outgoing message. click 
the To, Cc, or Bee button. 

I Adding nicknames to 
an existing outgoing message 

Eudora generally creates a new message if 
you click the To, Cc, or Bee button in the 
Address Book window. However, if you're 
working on an outgoing message, you can 
ada nicknames to that message as well. 
Make sure the outgoing message window 
is in the front, then open the Address Book 
window, select nicknames, and click the 
To, Cc, or Bee button to add the selected 
nicknames to the existing outgoing 
message. If any other window is in front 
when you open the Address Book window 
and click the To, Cc. or Bee button, Eudora 
will create a new message instead of 
adding the nicknames to your existing 
outgoing message. 
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Figure 13 To create a nicknames file, click the New 
button in the Address Book window and, in the New 
Nickname dialog box, check the "Make it a file" 
checkbox, and then click OK. 

The right-pointing triangle 
indicates a closed nick
names ~le; click it to open.-

The down-pointing
triangle indicates an 
open nicknames file; 
click it to dose. 
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Figure 14 To expand and collapse nicknames files in 
the Mac version of Eudora Pro, click the triangles next 
to the nicknames file names. 

The open book icon 
indicates an open nicknames 
~le; double·<fick it to close. 

The closed book icon ----+~ 
indicates a closed nicknames 
~le; double-click it to open. 

Figure IS To expand and collapse nicknames files in 
the Windows version of Eudora Pro, double-click the 
book icons next to the nicknames file names. 

Nicknames files 

Eudora Pro stores nicknames files (which 
are just specially formatted text files) in 
the Nicknames Folder inside the Eudora 
Folder. 

Working with the Address Book 

Multiple nicknames files 
Eudora Pro enables you to create multiple 
nicknames files for better categorization of 
your nickname collection. 

To create a new nicknames file 

1. In the Address Book window, click the 
New button to bring up the New 
Nickname dialog box. 

2. Enter a name for your nicknames file, 
and check the "Make it a file" checkbox 
(Figure 13). Click OK. 

Eudora creates a new nicknames file. 

To expand and 
collapse nicknames files 

1. In the Mac version, to e>.."Pand a nick
names file in the Address Book window, 
click the triangle to its left so that it points 
down. To collapse the file, click the trian
gle so it points right (Figure 14). 

In the Windows version, to expand a nick
names flle in the Address Book window, 
double-click the closed book icon to its 
left. The book then opens; double-click it 
to collapse the flle (Figure 15). 

To move nicknames between files 

1. dick the nickname you want to move to 
select it. 

2. Drag the nickname within the nickname 
list into another nicknames flle. 

VTips 

• It's easier to move nicknames between 
nicknames files if you collapse the inter
vening nicknames flles. 

• The Mac version of Eudora Pro always 
sorts nicknames flles alphabetically; the 
Windows version sorts by creation order. 
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Chapter 9 

Finding nicknames 
After you've created a number of nicknames, 
you might have trouble finding any given 
one. Luckily, Eudora provides some assistance 
in this area. 

To find a nickname (I) 

1. Open the Address Book \vindow by 
choosing Address Book OCmd)-L/@ill-L) 
from the Special (Mac) or Tools 
(Windows) menu. 

2. Type the first few letters of the nickname 
you want to find. 

Eudora scrolls the list to the first nick
name whose first few letters match what 
you typed (Figure 16). 

To find a nickname (11 - Mac) 

1. Open the Address Book window by 
choosing Address Book OCmd)-L) from 
the Special menu. 

2. Open the Find window by choosing 
Find OCmdH) from the hierarchical 
Find menu in the Special menu. 

3. Enter the search term in the Find field 
and click the Find button (Figure 17). 

Eudora fmds the first nickname whose 
information matches the search term 
and selects it (Figure 18). 

II Tip 

• In the Mac versions of Eudora, you can 
use the Find window to find information 
in any of the Address Book's fields. 
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Figure 16 To find a nickname in the Address Book 
window quickly, type the first few characters of the 
nickname. Here,l've typed "to" and Eudora has selected 
Tonya properly. 
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Figure 17 In the Mac versions of Eudora, you can also 
use the Find window to find nicknames. Just open the 
Address Book window, then the Find window, enter 
your search term (any piece of information that might 
be stored in the address book), and click Find. 
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Figure 18 Eudora then selects the nickname whose 
infor~ation matches your search term. Here, l've 
searched for "davis" to find the nickname for Nancy 
Davis, my extremely nice editor at Peachpit Press. 



The nlcknome "Noncy• alreody eHists. Would you 
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nlcknome with the new addresses? 

[Different Name 1 I Add To II J I Reploce II 1 

Figure 19 If you try to create a nickname with the 
same name as an existing nickname, Eudora asks if you 
want to create a nickname with a different name, add 
the email address or addresses to the existing 
nickname, or replace it. 

Nickname conflicts 
In Eudora Pro, different nicknames files 
can contain different, but identically 
named nicknames. When in doubt, Eudora 
Pro uses the one that's highest in the nick
name list. I recommend avoiding this situ
ation entirely by never creating identically 
named nicknames. Otherwise you risk 
sending a message to the wrong person, 
which can be tremendously embarrassing. 

Working with the Address Book 

Modifying nicknames 
Eventually you'll want to modify one or more 
of your nicknames. 

To modify a nickname (I) 

1. Open the Address Book window by choos
ing Address Book 0Cmd~LI@!ill-L) from 
the Special (Mac) or Tools (Windows) 
menu. Make sure the Address Book win
dow is expanded to display the nickname 
editing fields. (See "Using the Address Book 
window" in this chapter) 

2. Select the nickname you wish to modify. 

3. Make the desired changes, then choose 
Save from the File menu. 

To modify a nickname (II) 

1. First, open or select a message, then choose 
Make Address Book Entry 0Cmd~K/(Ctrl ~K) 
from the Special menu to create a nick
name based on the sender's email address. 

Or, in the Mac versions, select an email 
address, hold down Shift, and then choose 
Make Address Book Entry ([Cmd)-(Shitt~K) . 

Eudora displays the New Nickname (Mac) 
or Make Address Book Entry (Windows) 
dialog box with a suggested nickname. 

2. Enter an existing nickname and click OK. 
In Eudora Pro, choose the file containing 
the existing nickname. 

Eudora displays the Duplicate Nickname 
dialog box (Figure 19) . 

3. Click Different Name to create a new 
nickname, Add To It to add the address to 
the existing nickname, or Replace It to 
replace the old address with the new one. 
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Managing your 
recipient list 
You can modify a nickname's inclusion on 
your recipient list menus. I recommend that 
you maintain your recipient list to ensure that 
it stays short and useful. 

To add a nickname 
to the recipient list 

1. Open the Address Book window by 
choosing Address Book 0 Cm4 Ll@!ill-L) 
from the Special (Mac) or Tools 
(Windows) menu. Make sure the Address 
Book window is expanded to display the 
nickname editing fields. 

2. Select the nickname you wish to add to 
your recipient list. 

3 . Check the Recipient List checkbox 
(Figure 20), then choose Save from the 
File menu. 

To delete a nickname 
from the recipient list 

1. Open the Address Book window by 
choosing Address Book QCmd~LI@ill-L) 
from the Special (Mac) or Tools 
(Windows) menu. Make sure the Address 
Book window is expanded to display the 
nickname editing fields. 

2. Select the nickname you wish to delete 
from your recipient list. 

3. Uncheck the Recipient List checkbox, 
then choose Save from the File menu. 

V' Tip 

• The recipient list appears in the hierarchi
cal Insert Recipient menu in the Edit 
menu and the hierarchical New Message 
To, Forward To, and Redirect To menus in 
the Message menu. 
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Check the Redpiem Ust checkbox to 
place the nickname on your recipient list 
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Figure 20 To add a nickname to your recipient list, 
check the Recipient List checkbox in the Address Book 
window. To remove it from the recipient list, uncheck 
the Recipient List checkbox. 

Recipient list hints 

It's awkward to look at one of the hierar
chical menus that contains the recipient list 
to determine who's in it. Luckily. you can 
see who's in the recipient list at a glance in 
the Address Book window. 

In the Mac versions of Eudora, nicknames 
in the recipient list have bullets ( •) next to 
their names. The Windows versions show 
nicknames in the recipient list in bold. If 
yo11look at screenshots of the Address Book 
window in this chapter, you can see which 
nicknames I've put on my recipient list. 



Figure 21 To de lete a nickname, select it and click the 
Del (Windows) or Remove (Mac) button. 
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Figure 22 When you try to delete a nicknames file, 
Eudora asks to make sure you know what you're doing. 
since doing so also deletes all nicknames in the file. 

Figure 23 In the Windows versions of Eudora, you can 
also right-click a nickname or a nicknames file and 
choose Delete from the pop-up menu to delete the 
nickname or nicknames file. 

Working with the Address Book 

Deleting nicknames 
Don't keep nicknames for people with whom 
you're unlikely to correspond again- it's 
worth deleting them to keep your address 
book clean and up-to-date. 

To delete nicknames 

1. Open the Address Book window by 
choosing Address Book ([Cmd~L/@0]-L) 
from the Special (Mac) or Tools 
(Windows) menu. 

2 . Select the nickname or nicknames you 
wish to delete. 

3. Click the Remove (Mac) or Del (Windows) 
button (Figure 21). Choose Save from the 
File menu. 

to~ Tips 

• To delete a nicknames file and all the nick
names it contains, select it and click the 
Remove (Mac) or Del (Windows) button. 
Eudora asks to make sure you know what 
you're doing (Figure 22), then deletes the 
entire H.le. 

• In the Windows versions of Eudora, you 
can also select one or more nicknames 
and press the Forward Delete key to delete 
them. 

• In the Windows versions of Eudora, you 
can also right-dick an address book entry 
and choose Delete from the pop-up menu 
(Figure 23) to delete it. 
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WORKING 
WITH THE TOOLBAR 

Eudora offers several different interfaces to 
satisfy different ways of working. You can 
choose menu items with the mouse, use key
board shortcuts, or click buttons on toolbars 
(I assume you know how to click a button on 
a toolbar, so I don't provide steps for that). 

I use keyboard shortcuts when possible, and 
when they aren't available, I tum to menus. 
I'm not a toolbar fan because the graphics 
often aren't clear and the buttons are usually 
too small. · 

I don't use Eudora's tool bar that often. If you 
find that it works well for you, great, but 
remember that there's nothing on the toolbar 
that's not available from menus as well. Also, 
note that this chapter covers the main toolbar, 
not the formatting toolbar available within 
message windows in Eudora Pro. (See Chapter 3, 
"Writing Messages" for additional information on the 
formatting toolbar) 

The various versions of Eudora offer different 
tool bar functionality. The Windows version of 
Eudora light has a static toolbar, and the Mac 
version of Eudora light lacks a tool bar 
entirely. Both versions of Eudora Pro feature 
customizable tool bars, but the methods you 
use to customize them differ. 

So, if you're a tool bar fan, read on for the 
neat things you can do with Eudora's toolbar! 
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Chapter 10 

Turning the 
toolbar on and off 
Eudora turns the toolbar on by default, but 
you can rurn it off and back on manually, too. 

To tum the toolbar on 

1. From the Special menu choose Settings 
(Mac) or from the Tools menu choose 
Options (Windows) to bring up the 
Settings/Options dialog box. 

2. Scroll down in the list of settings panels 
and click eitherToolbar (Mac) or Fonts & 
Display (Windows) (Figure 1). 

3. Check the Show toolbar checkbox and 
click OK to turn the toolbar on. 

To tum the toolbar off 

1. From the Special menu choose Settings 
(Mac) or from the Tools menu choose 
Options (Windows) to bring up the 
Settings/Options dialog box. 

2. Scroll down in the list of settings panels 
and click eitherToolbar (Mac) (Figure 2) 
or Fonts & Display (Windows) . 

3 . Uncheck the Show toolbar checkbox and 
click OK to turn the toolbar off. 

t1 Tips 

• In the Windows versions of Eudora, right
click the tool bar or the starus bar to bring 
up a pop-up menu (Figure 3) that enables 
you to show or bide the Mailboxes win
dow, the tool bar, and the status bar. 

• If neither the tool bar nor the starus bar is 
showing in the Windows versions of 
Eudora, the only way to rurn the toolbar 
and starus bar back on is through the 
Fonts & Display settings panel in the 
Options dialog box. 
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I!Sbow-llar e.----
Figure I To turn the toolbar on, open the 
Settings/Options dialog box, click Fonts & Display 
(Windows) orToolbar (Mac), and check the Show 
toolbar checkbox. 

Settings 

Ill! ........... ~ ~SI'IO'J toolber 

Orlenteti~:~n: 

• £u6or.a l.c>t\J ® HorlzCintal toolber 

(j: OtUin9 Mttnt~ QVertlceltoolbar 

.&. txtr.a .......... w,s 
Button type: 
@)81QIC01'3¥1IhN~ 

~ ........ J, 
QBtotcon:sonly 
QSmalltcom&.nenm 

.,. IOT/Pf'f' ... H« 0 Smell teoM onlv 

/t Hov~ Ar~ QHamesonly 

iii HiK<-
r8J ""-P function l::e1J' to buttons 
t8) ShOV function tty l•btb 

r£1 I Concel ) (:E:J 

Figure 2 To turn the toolbar off, open the 
Settings/Options dialog box, click Toolbar (Mac) or 
Fonts & Display (Windows), and uncheck the Show 
toolbar checkbox. 

Figure 3 Alternately, in the Windows versions, right 
click the tool bar or status bar, then choose Toolbar to 
turn the toolbar on or off. 



Sailings 

Ill! .... ....... I! 
I8JSbWtoolber 

Oritntetlon: 
f} £udor• L.O.b 1'. @Hortzonteltoolbar 

{IOott ... Ait,.t"' 
QVtrtlc.oltoolber 

... [Jc1r . ... ..,... 
Buttont1Jpe: 

® Bit Icons vUh l'lltnH 

~ ... ~ ... 0 !ht I tons onl \1 

lt OTIPW""'Hoo 
0 SrN111c:ons & r.mn 
QSrnelllc:onsonlv 

<\' .............. QNI,..,onlv 

&11-.n- 181 ,..,.P funttton bvs to but toM 
181 $h0v funttlon tev ltbele 

~ I Contel ) (:E:J 

Figure 4 Select diffe rent settings in the Tool bar settings 
panel to control how the Mac version of Eudora Pro 
displays the toolbar. 

Figure 5 Select different settings in the Fonts & Display 
settings panel to control how the Windows versions of 
Eudora display the toolbar. 

Working with the Toolbar 

Toolbar settings 
You have a number of options for how the 
tool bar displays, all available from the Tool bar 
settings panel (Mac) (Figure 4) or the Fonts & 
Display settings panel (Windows) (Figure 5) 
of the Settings/Options dialog box. 

Toolbar settings (Mac) 

• The Orientation radio buttons determine 
whether the toolbar displays horizontally 
or vertically. 

• The Button type radio bu ttons control 
how the buttons display. Experiment with 
different settings to see which you pre
fer-the specifics will depend on your 
monitor size, eyesight, hand-eye coordi
nation, and working habits. 

• The "Map function keys to buttons" 
checkbox controls whether you can press 
one of the function keys at the top of 
the keyboard instead of clicking a tool bar 
button. 

• The "Show function key labels" checkbox 
controls whether function key labels 
appear with their associated buttons. 

Toolbar settings (Windows) 

• The Show toolbar tips checkbox controls 
whether Eudora displays a small help note 
when you move the cursor over a toolbar 
button. 

• The Show status bar checkbox controls 
whether Eudora displays a status bar at the 
bottom of the screen that contains more 
information than the toolbar tips about 
the toolbar buttons. 
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Chapter 10 

Default toolbar functions 
Although the button names in the Mac ver
sion of Eudora Pro (Figure 6) and toolbar 
tips in the Windows versions of Eudora 
(Figure 7) explain what each button does, 
here's a quick overview of the default func
tions of the tool bar buttons. 

Creates Replies 
Attaches Checks 
a ~le the 

Opens 
the Opens 

Deletes o the Out 
message mailbox 

Opens 
the In 
mailbox 

Checks 
(or new 
mail 

a new to o Forwards Redireas to a spelling of Address Prints a 
message message a message a message message o message Book message 

Figure 6 Here are the default buttons on the toolbar In the Mac version of Eudora Pro. Note that Reply and Redirect 
are disabled because I had a new outgoing message window open when I took this screenshot. Toolbar buttons are 
active only if they make sense for the current siwation. 

Opens Creates Replies to all Redirects Displays Attaches Shows context 
the Out anew addresses in o message the next a~letoa sensitive help (or the 
mailbox message a message message message next item you click 

Opens Displays Checks the 
Deletes o the In Checks (or Replies to Forwards the previous spelling of Opens the Prints o 
message mailbox new mail o message a message message o message Address Book message 

Figure 7 Here are the default toolbar buttons in the Windows versions of Eudora. Note that Check Spelling is disabled 
because I had a mailbox window open when I took this screenshot. Toolbar buttons are active only if they make sense 
for the current situation. 



A blank button 

Figure 8 To add a blank button to the toolbar, hold 
down Command and click between two existing 
buttons on the tool bar. 

- Toolbar Button Creation -

Please choose any menu Item or 
press any key combination. 

( Remoue Button ) 

Figure 9 Eudora presents the Toolbar Button Creation 
dialog box. Choose a menu item or press a keyboard 
shortcut to assign that function to the button. If you 
made a mistake, click Remove Button. 

The new button 

I 

~ J ~ I~ I) ~ I A\todlOocunenL From Frlonds Ch+ck Spollin9 

,.,. no n r 

Figure I 0 Here, l've chosen my From Friends mailbox 
from the Mailbox menu. Clicking the From Friends 
button on the toolbar will now open the From Friends 
mailbox. 

Working with the Toolbar 

Adding a button 
to the toolbar 
In Eudora Pro, you can customize the toolbar 
by adding buttons for functions that aren't 
represented on the toolbar by default. 

To add a button 
to the toolbar (Mac) 
1. Hold down Command and click between 

any two buttons on the toolbar to insert a 
blank button at that point (Figure 8). 

Eudora displays the Tool bar Button 
Creation dialog box (Figure 9) , which 
asks you to choose a menu item or press 
a keyboard shortcut. To back out, click 
Remove Button. 

2. Choose any menu item or press a key
board shortcut. 

Eudora assigns that function to the 
button, names it, and gives it an icon 
(Figure 10). 

II Tips 

• When you're holding down Command 
and have the cursor positioned between 
two buttons on the toolbar, the cursor 
changes to a line with two arrows point
ing out on either side to indicate you can 
click to insert a blank button. 

• To add a button that opens a specific 
mailbox, you can either create a button 
normally, choosing the mailbox from 
the Mailbox menu, or you can drag the 
mailbox from the Mailboxes window to 
the toolbar. 
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Adding a button 
to the toolbar 
In Eudora Pro, you can customize the toolbar 
by adding buttons for functions that aren't 
represented on the toolbar by default. 

To add a button to the toolbar 
1. Right-click the toolbar to bring up a pop

up menu (Figure 11) , and choose 
Customize. 

Eudora displays the Customize Tool bar 
dialog box (Figure 12) . 

2. Select a category in the Categories list 
(they mostly parallel the menu items), 
then select a button in the Buttons area to 
view a description in the Description area. 

3. Drag a button from the Buttons area to the 
desired spot on the toolbar (Figure 13). 

4. If Eudora needs additional information 
(such as which mailbox to open, or to 
which recipient to redirect a message), it 
displays an explanatory dialog box 
(Figure 14) , then a menu from which 
you choose the desired item (Figure 15). 

tl Tip 
• Double-clicking a button in the Buttons 

area executes that function. This even 
works with the Exit button, which 
promptly quits the program, much to my 
amusement. 

Figure I I To add a button to the toolbar, right-click 
the toolbar to bring up a pop-up menu, then choose 
Customize. 
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Figure 12 Eudora Pro displays the Customize Tool bar 
dialog box. Select a category in the Categories list and 
click a button in the Buttons area to see a description 
of it in the Description area. Then, drag the button to 
the desired location on the toolbar to add it. 

The new button 

Figure 13 The new button (in this case one that 
creates a new message addressed to Tonya) appears in 
the toolbar where you dropped it. 

Figure 14 If necessary, Eudora Pro prompts you to 
chooke an item from a menu that it displays after this 
dialog box. 

Figure IS Choose the desired item from the menu 
that Eudora Pro displays if a button needs 
customization. 



Working with the Toolbar 

Button ideas 
Don't be constrained by the obvious com
mands that appear on most tool bars, like 
Save, Print, and Quit. There are many items 
that you could add to your Eudora Pro 
toolbar that you might not have considered 
initially. Anything that you do regularly is a 
candidate for a toolbar button. 

Button ideas · 

• Make a button that creates a new message 
addressed to your most frequent corre
spondent. You could do the same thing for 
Forward and Redirect. 

• Make a button that creates a new message 
using your most common pieces of sta
tionery. Consider also a button that replies 
with stationery. · 

• Make a button that transfers messages to a 
specific mailbox, especially if the mailbox 
is several levels down in the Transfer 
menu. 

• For easy categorization, make a button 
that changes the labels of messages. 

• Make buttons for the formatting com
mands you use, so you don't have to 
display the formatting toolbar in every 
outgoing message window. 
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Chapter 10 

Moving toolbar buttons 
If you use the toolbar, you should customize 
it exactly the way you want it, which includes 
moving buttons around. 

To move a button (Mac) 

1. Hold down Command and drag a button 
either between any two other buttons or 
to either end of the tool bar (Figure 16). 

When you Command-drag the button 
between two other buttons, the cursor 
changes to a line with two arrows point
ing out on either side to indicate that it's 
okay to drop the button in that location. 

To move a button (Windows-!) 

1. Hold down Alt and drag a button in the 
toolbar to the desired location. 

To move a button (Windows-11) 

1. Right-click the toolbar to bring up a pop
up menu, and choose Customize. 

Eudora displays the Customize Toolbar 
dialog box. 

2. Click a button in the toolbar and drag it to 
en the desired location. z 
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Figure 16 To move a toolbar button in the Mac 
version of Eudora Pro, hold down Command and drag 
the button to the new location. In the Windows version 
of Eudora Pro, hold down Alt and drag the button to 
the new location. 



~ Toolbar Button Creation ~ 

Please choose any menu Item or 
press any key combination. 

( Remoue Button ) 

Figure 17 To delete a button from the toolbar in the 
Mac version of Eudora Pro, hold down Command, click 
the desired button, and then, in the Toolbar Button 
Creation dialog box, click Remove Button. 

Working with the Toolbar 

Deleting toolbar buttons 
You'll undoubtedly find some of the default 
toolbar buttons superfluous, and you may 
want to remove some of those you create as 
projects finish or life changes. 

To delete a button (Mac -I) 

1. Hold down Command and drag a button 
to the Trash in the Finder. 

To delete a button (Mac -II) 

1. Hold down Command and click a button 
on the toolbar. 

Eudora displays the Toolbar Button 
Creation dialog box (Figure 17). 

2. Click Remove Button. 

To delete a button (Windows -I) 

1. Hold down Alt and drag a button off the 
tool bar. 

To delete a button (Windows -II) 

1. Right-click the toolbar to bring up a 
pop-up menu, and choose Customize. 

Eudora displays the Customize Tool bar 
dialog box. 

2. Drag a button off the tool bar. 

V' Tip 
• In the Mac version, make sure the Trash 

in the Finder isn't obscured by a win
dow before you start dragging a button 
to the Trash. 
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Chapter 10 

Changing button functions 
What if you just want to change the function 
of a button on the toolbar?You can, of 
course, just remove one button and replace it 
with another, but the Mac version of Eudora 
Pro provides an easier method. 

To change a button function 
1. Hold down Command and click a button 

on the toolbar (Figure 18). 

Eudora displays the Tool bar Button Creation 
dialog box (Figure 19) , which asks you 
to choose a menu item or press a keyboard 
shortcut. (To back out, click Cancel.) 

2. Choose any menu item or press a key
board shortcut. 

Eudora assigns that function to the but
ton, along with a new name and icon, 
replacing the previous icon, name, and 
function (Figure 20) . 
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Figure 18 To change the function of a button, hold 
down Command and click the button. 

Toolber Button Creation 

Plense choose eny menu Item or 
press nny key comblnntlon. 

( Remoue Button ) 

Figure 19 Eudora presents the Toolbar Button 
Creation dialog box. Choose a menu item or press a 
keyboard shortcut to assign that function to the button. 

Figure 20 Eudora then changes the button's function 
and name (and icon, if necessary) to reflect your 
change. Here, I've changed the button that opens the 
From Friends mailbox to one that opens the From 
Tonya mailbox. 



USING 
DIRECTORY SERVICES 

What are Ph and Finger? 
You can best think of Ph (pronounced as 
two separate letters) as an electronic 
version of an organization-specific tele
phone book. Ph servers contain contact 
information about only the people who 
work at a particular business, university. 
or institution. 

Finger works like Ph but uses even older 
technology. Finger servers also tend not to 
be as comprehensive as Ph servers. 

You use both Ph and Finger to look up 
information (telephone numbers, email 
addresses, or office numbers) about peo
ple, just as you might use a telephone 
book specific to that person's organization. 

A problem with email is that it can be diffi
cult to find someone 's email address if you 
only know that person's name. 

Eudora supports two older methods oflook
ing up information about people. Called Ph 
and Finger, these Internet services are handy, 
but by no means universal. In this chapter, I 
show you bow to use both Ph and Finger 
from within Eudora. 

Let me state up front that there is no central
ized Internet directory. You cannot reliably 
look up someone's email address if you know 
only that person's name. Some Web sites 
attempt to provide such functionality, but 
even they are extremely limited. 

In addition, you must keep in mind that nei
ther Ph nor Finger will do you any good 
unless the person you're looking for is at an 
organization that runs a Ph or Finger server. 
There is no way of knowing if that's true for 
any given person. Academic institutions are 
more likely to run Ph servers than commer
cial Internet service providers, and smaller 
(and older) Internet service providers are 
more likely to run Finger services than large 
or new Internet service providers. 

Eudora provides a number of neat features if 
you do want to use Ph or Finger-let's see 
what you can do. 
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Chapter 11 

Setting up Ph and Finger 
The tricky part of starting, particularly with 
Ph, is that you can't find any Ph servers unless 
you already know a Ph server to ask. You 
don't have to set up a Finger server, but since 
you're likely to query the same Finger server 
most of the time (probably the one your 
Internet service provider runs, if it runs one), 
entering a Finger server makes queries easier. 

To define Ph and Anger servers 

1. From the Special menu (Mac) or Tools 
menu (Windows), choose Settings (Mac) 
or Options (Windows). 

Eudora opens the Settings/Options 
dialog box. 

f. 2. Click Hosts in the left-hand column to 
display the Hosts settings panel 
(Figure 1) . 

3. In the Ph field, enter ns.uiuc.edu 

4. In the Finger field, enter halcyon.com 

5. Click the OK button to save your changes. 

t1 Tips 
• If you leave the Finger field blank, Eudora 

uses your SMTP server as your Finger 
server, which might or might not work. 

• If you leave the Ph field blank, the Mac 
versions ofEudora default to the Ph server 
at ns.uiuc.edu. 
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Figure I To set up your default Ph and Finger servers, 
choose Settings (Mac) or Options (Windows) from the 
Special menu (Mac) or Tools menu (Windows), click 
Hosts in the left-hand column, then enter the names of 
your Ph and Finger servers in the appropriate fields. 

Entering your own servers 

In this book, I use the University of 
Illinois at Urbana-Champaign's Ph server 
Jd my Internet service provider's 
(Northwest Nexus) Finger server because I 
need something here to explain Ph and 

I 
Finger. 

However, unless you regularly want to 
lopk up people who study or wol'k at 
UIUC or people who get their Internet 
connections from Northwest Nexus, I 
re~ommend you change these settings. 

It's best to set your Ph server to an organi
zation where you're likely to want to look 
up people. 

It's generally best to set your Finger server 
to be the machine you're most likely to 
us!e for fingering people. For me, that's 
Northwest Nexus. Try entering the domain 
part of your email address (like halcyon. com) 
~d if that fails, ask your Internet service 
provider if they run a Finger server or 
i ow of a good one to use. 



Current Ph server Ph URL 
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Figure 2 To select a Ph server o ther than your default 
Ph server, choose Directory Services from the Special 
menu (Mac) or Tools menu (Windows), then click the 
globe button (Mac) or Server button (Windows).After 
Eudora retrieves the list of Ph servers and displays it in 
the lower pane, double-click the desired Ph URL to use 
that server. 

Note that the server became 
qi.cornel/.edu, after I clicked the 
Ph URL (or that server in Figure 2. 
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Figure 3 After you double-click a Ph server URL. 
Eudora switches to using that new server. 

II 
)Ill 

Figure 4 The Windows versions of Eudora track all 
the Ph servers you've used. To select a previously used 
Ph server, choose it from the Server pop-up menu. 

Using Directory Services 

Selecting another 
Ph server 
As large as the University of Illinois is, I don't 
expect you will want to look up only people 
there. You can easily use other Ph servers. 

To select another Ph server 

1. From the Special menu (Mac) or Tools 
menu (Windows) , choose Directory 
Services (I Cmd )-Y II Ctrl )-Y) . 

Eudora opens the Directory Services 
window. 

2. In the Mac versions of Eudora, click the 
globe button, and in the Windows ver
sions of Eudora, click the Server button. 

Eudora asks the UIUC Ph server for the list 
of all the Ph servers that it knows about, 
and displays them in the bottom pane 
(Figure 2). 

Note that a Ph URL appears next to each 
organization name-like other URLs, it's 
blue and underlined. 

3. Scroll through the list, and when you see 
a Ph server you want to query, double
click its URL. 

Eudora changes the server field to the new 
Ph server (Figure 3). 
You can now search the new Ph server for 
people at that organization. (See "Searching a 
Pb setver" on rbe nexr page) 

V'Tips 

• The Windows versions of Eudora keep 
track of all the Ph servers you've visited in 
the Server pop-up menu (Figure 4) . 
Choose any server from that menu for 
quick access. 

• In the Mac versions of Eudora, you can 
switch back to your main Ph server and 
search for other servers by holding down 
Option and clicking the globe button. 
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Searching a Ph server 
Once you've selected the appropriate Ph 
server, the next task is to perform a search in 
that server. 

To search a Ph server 

1. Open the Directory Services window 
by choosing Directory Services 
0 Cm4 Y / @!ill-Y) from the Special menu 
(Mac) or Tools menu (Windows). 

2. In the Enter query field (Mac) or 
Command field (Windows), type the 
name of the person you want to find and 
click the Ph button. 

Eudora queries the current Ph server and 
returns the listings for people who match 
your search request (Figure 5) . 

t1 Tips 

• In the Mac versions of Eudora, select a 
word or two, then hold down Shift and 
choose Directory Services 0Cmd)-Y) from 
the Special menu to insert the selected text 
in the Enter query field. 

• In the Mac versions of Eudora, if you 
check the "Live" Ph queries checkbox in 
the Hosts settings panel (Figure 6), 
Eudora makes Ph queries automatically if 
you type something in the Enter query 
field and pause. It also looks up inserted 
text (from the previous tip) immediately. 

• In the Windows versions of Eudora, check 
the Keep on top checkbox to keep the 
Directory Services window on top of any 
other Eudora windows. 

• Try not to search for common first names 
because you'll get way too many people 
in the results listing. 

• I generally search on last name, although 
if I'm positive of my spelling, I'll search 
on first and last name. 
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Figure 5 To search for someone using Ph, open the 
Directory Services window by choosing Directory 
Services from the Tools menu (Windows) or Special 
menu (Mac).Then enter the name of the person you 
want to find (in this case, my friend Oliver) and click 
the Ph button. 
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Figure 6 Note that I've checked the "Live" Ph queries 
checkbox so Ph queries happen automatically without 
me having to click the Ph button. Instead, I just pause 
after typing the search terms. 



Figure 7 In Eudora Pro, to send email from the results 
of a Ph search, select some text in one or more of the 
results, then click the To, Cc, or Bee button. 
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Figure 8 To make a nickname from the results of a Ph 
search, select some text in one or more of the results, 
as I did in Figure 7, then choose Make Address Book 
Entry from the Special menu. 

New Nickname 

In file: 

0 Put II on the recipient list 

Figure 9 Eudora then prompts you for the name of 
the nickname. Change the default nickname if you wish, 
choose a file if you're using Eudora Pro, then click the 
OK button to create the nickname. If desired, check the 
"Put it on the recipient list" checkbox. 

Using Directory Services 

Using the results of 
a Ph search 
Ph results usually fall into what my high 
school math teacher called the "look, see" 
method. You look at the results, and you see 
what you need. However, Eudora adds several 
useful features. 

To send email from a Ph 
search (Eudora Pro only) 

1. Do a Ph search, then select some text in 
one or more of the results (Figure 7). 

2 . Click the To (or press Return/Enter), Cc, 
or Bee button to create a new outgoing 
message addressed to the person or peo
ple whose entries you selected. 

To make a 
nickname from a Ph search 

1. Do a Ph search, and select some text in 

one or more of the results. 

2. Choose Make Address Book Entry 
0Cmd)-K/ICtri )-K) from the Special menu 
(Figure 8). 

Eudora displays the New Nickname dialog 
box (Mac) or Make Address Book Entry 
dialog box (Windows) (Figure 9) . 

3. Enter a nickname for the person or peo
ple, select a file if you're using Eudora 
Pro, and check the "Put it on the recipient 
list" checkbox if you want the nickname 
on your recipient list. Click the OK button 
when you're done. (See Chapter 9, "Working 
with the Address Book") 

II Tip 

• If you have an outgoing message window 
active, clicking the To, Cc, or Bee button 
adds that person to the appropriate header 
line rather than creating a new message 
addressed to that person. 
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Searching a Finger server 
Searching a Finger server is different than 
searching a Ph server. 

To search your 
default Anger server 

1. Open the Directory Services window by 
choosing Directory Services 
G Cmd 1-Y !@ill-Y) from the Special menu 
(Mac) or Tools menu (Windows). 

2. In the Enter query field (Mac) or 
Command field (Windows), type the 
name or username (the part of an email 
address before the @) of the person you 
want to fmd, then click the Finger button. 

Eudora queries your default Finger server 
and returns the listings for people who 
match your search request (Figure 10) . 

To search another Anger server 

1. Open the Directory Services window by 
choosing Directory Services 
G Cmd 1-Y /I Ctrll-Y) from the Special menu 
(Mac) or Tools menu (Windows). 

2. In the Enter query field (Mac) or 
Command field (Windows), type the 
name or email username of the person 
you want to fmd, followed by an @ char
acter and the domain name of the Finger 
server you want to query, and then click 
the Finger button. 

Eudora queries the specifted Finger server 
and returns the listings for people who 
match your search request (Figure 11). 

vTip 

• Although both are always visible, Eudora 
makes either the Ph or the Finger button 
the default (pressing Return/Enter is the 
same as clicking a default button) based 
on the last type of search you performed. 
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Figure I 0 To search for someone using your default 
Finger server; open the Directory Services window by 
choosing Directory Services from the Special menu 
(Mac) or Tools menu (Windows). Then enter the name of 
the person you want to find (in this case, me, at another 
of my email accounts) and click the Finger button. 
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Figure II To search for someone using another Finger 
server, open the Directory Services window by choosing 
Directory Services from the Tools menu (Windows) or 
Special menu (Mac).Then enter the name of the person 
you want to find (in this case, my friend Geoff), followed 
by an @ character and the domain name of the Finger 
server, and then click the Finger button. 

Finding Anger servers 

Unfortunately. there is no directory of 
Finger servers, as there is with Ph. The 
only way to figure out if an organization 
or Internet service provider runs a Finger 
server is to try to use it or to ask. 



Integrating Web 
directories with Eudora 

Unfornmately, there's no guaranteed 
method of communication between the 
online Web directories and Eudora other 
than copy and paste. 

However, in some versions of the main 
Web browsers (mainly Microsoft Internet 
Explorer), clicking a mailto link (a link 
that's an email address-the Web directo
ries often display these) can automatically 
create a new outgoing message in Eudora 
and address it. 

The Windows versions of Eudora have a 
checkbox called "Intercept Netscape 
mailto URI.s" in the Miscellaneous settings 
panel. When that's checked, clicking a 
mailto link in Netscape Navigator or 
Netscape Communicator creates a new 
message in Eudora rather than in Netscape 
Mail or Netscape Messenger (the built-in 
email programs in different versions of 
Netscape). 

To set the Mac versions of Eudora to inter
cept Netscape mailto URI.s, read and fol
low the instructions on the Eudora as 
Netscape's Mailto Helper Web page at 
http: I I www.am.herst.edu/ - atstarr I eudora/ 
eudorowi thnetscape.hnnl. 

Using Directory Services 

Online directories 
on the Web 
Ph and Finger are relatively elderly Internet 
technologies, and in fact, a number ofWeb 
sites have sprung up that help you find peo
ple's email addresses. They're by no means 
perfect either, but if you have Web access, 
they're worth trying. There may be other 
online Web directories as well, but these are 
the main ones that I've used. 

Online Web directories 

• Bigfoot 

http: I I www. bigfoot.coml 

• FourllDirectory Services 

http:llwww.fourll .com/ 

• InfoSpace 

http://www.infospace.com/ 

• Imernel Address Finder 

http://www.iaf.net/ 

• Who Where? 

http:/lwww.whowhere.com/ 
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Getting more help 

If you're confused about a setting in 
Eudora's Settings/ Options dialog box, 
Eudora itself can often provide additional 
information. 

In the Mac versions of Eudora, choose 
Show Balloons from the Guide menu 
(which looks like a question mark), then 
point at the setting in question to display a 
help balloon. 

In the Windows versions of Eudora, click 
the question mark button in the dialog 
box's title bar, then click the setting in 
question to display context-sensitive help. 

0 Important settings 

Eudora has far too many settings for me 
to document them all, and frankly, some 
of them aren't at all interesting. Look for 
the above exclamation point graphic next 
to especially interesting or important 
settings-the exclamation point will 
repeat next to the explanatory text for 
those settings. 

By now I'm sure you have the sense that 
Eudora is a deep program. Recognizing that 
everyone works differently, Eudora's designers 
have provided multiple ways for you to use 
almost every part of the program. 

Nowhere is this more evident than in Eudora's 
Settings (Mac) or Options (Windows) dialog 
box, where you control many of Eudora's set
tings. In fact, Eudora provides so much flexi
bility that the Settings/Options dialog box can 
seem overwhelming. Don't worry though. 
because apart from the few settings we modi
fied back in Chapter I, "Eudora Basics," the 
defaults are fine for most situations. 

This chapter differs from most of the others 
in this book. Those chapters teach you how to 
perform specific tasks, but there aren't many 
tasks to perform in the Settings/Options dia
log box. Instead, on each page, I discuss a 
specific settings panel, calling out interesting 
or especially useful settings. 

Some of Eudora's settings panels are rather 
technical and esoteric, and others aren't 
standard (particularly in the Mac versions, 
to which you can add settings panels by 
dropping special files in your Eudora Folder). 
I won't cover those, but rest assured that I 
will cover the most important and useful 
settings panels. 



Chapter 12 

Getting Started 
The Getting Started settings panel (Figure 1 
and Figure 2) is the first and most important 
settings panel in Eudora. In it, you provide 
the bare minimum information Eudora needs 
to send and receive messages. 

Settings 

U The Real name field holds your real name. 
If you want to be cute, of course, you can 
enter anything you like here. I always rec
ommend that people use their names. 

U The POP account field holds your POP 
account, which looks like an email 
address. In fact, it is your email username, 
followed by an @ character, and the name 
of your POP server. Note that your POP 
account may not be the same as your 
return address. 

You get your POP account from your 
Internet service provider or network 
administrator-don't bother guessing. 

U The Return address field holds your email 
address. If your return address is the same 
as your POP account, you may leave the 
Return address field blank. 

U The Connection method options control 
how Eudora connects to send and receive 
email. In almost all cases, TCP / IP (Mac) or 
Winsock (Windows) is the correct choice. 
Eudora has the capability to dial a modem 
itself if you select Communications 
Toolbox (Mac) or Shell account access 
(Windows). but few people use those 
options any more. 

• Check the Offiine (no connections) 
checkbox if you aren't connected to the 
Internet temporarily (because you're 
using a laptop on the road, say) and want 
to prevent Eudora from checking for mes
sages automatically. 
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Figure I Use the Getting Started settings panel in the 
Mac versions of Eudora to enter the basic information 
necessary to use Eudora. 

Figure 2 Use the Getting Started settings panel in the 
Windows versions of Eudora to enter the basic 
information necessary to use Eudora. 
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Figure 3 Use the Personal Information settings panel 
in the Mac versions of Eudora to enter information 
about yourself. Much of the information is shared with 
other settings panels. 

Figure 4 Use the Personal Info settings panel in the 
Windows versions of Eudora to enter information 
about yourself. Much of the information is shared with 
other settings panels. 

Working with Settings/Options 

Personal Information 
The Personal Information settings panel 
(Figure 3 and Figure 4) picks up most of its 
information from the Getting Started settings 
panel. Eudora's settings panels often share 
information because users often aren't sure 
where to look for any specific setting and it 
may logically fit in multiple settings panels. 

Settings 

D The POP account, Real name, and Return 
address fields match the fields in the 
Getting Started settings panel covered on 
the previous page. Information entered in 
the Getting Started settings panel is shared 
by the Personal Information settings panel, 
and vice versa. So, if you want to change 
these settings, you can do it here, in the 
Getting Started Settings panel, or in any 
settings panel that shares the same fields. 

• The Dialup username field can be left 
blank unless you use the Communications 
Toolbox (Mac) or Shell account access 
(Windows) and have Eudora connect to 
the Internet directly via a modem. Most 
people should ignore the Dialup user
name field. 
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Hosts 
The Hosts settings panel (Figure 5 and 
Figure 6) holds the names of various Internet 
servers that Eudora talks to for different 
reasons. Eudora picks up some Hosts panel 
settings from either the Getting Started or 
Personal Information settings panel. 

Settings 

U The POP account field holds your POP 
account (shared by the Getting Started, 
Personal Information, and Checking Mail 
settings panels) . 

0 The SMTP server field holds the name of 
the server to which Eudora sends outgo
ing messages. If you leave it blank, Eudora 
sends messages to the machine that runs 
the POP server. Since many computers that 
run POP servers also run SMTP servers, 
this technique works much of the time. 

You must ask your Internet service 
provider or network administrator if you 
should fill in the SMTP server field, and if 
so, what to enter there. 

• The Ph and Finger fields hold the names 
of your default Ph and Finger servers. 
(See Chapter II, "Using Directory Services") 

• The Mac versions of Eudora offer several 
additional check boxes, none of which 
offer necessary functionality. 
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Figure 5 Use the Hosts settings panel in the Mac 
versions of Eudora to enter the names of the various 
Internet servers Eudora talks to. 

6 Use the Hosts settings panel in the Windows 
versions of Eudora to enter the names of the various 
Internet servers Eudora talks to. 
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Figure 7 Use the Checking Mail settings panel in the 
Mac versions of Eudora to customize how Eudo ra 
checks for mail. 

Figure 8 Use the Checking Mail settings panel in the 
Windows versions of Eudora to customize how Eudo ra 
checks fo r mail. 

Working with Settings/Options 

Checking Mail 
The Checking Mail settings panel (Figure 7 
and Figure 8) provides numerous options 
that let you customize how Eudora checks 
mail. (See Chapter 4, "Sending and Receiving Messages") 

Settings 

0 The POP account field holds your POP 
account (shared by the Getting Started, 
Personal Information, and Hosts settings 
panels). 

0 The "Check for mail every X minutes" 
section controls if and how often Eudora 
automatically checks for mail. 

0 The "Skip messages over X K" checkbox 
and field control whether Eudora down
loads messages over a specified size. 

0 Th e Leave mail on server sections and the 
"Delete from server when emptied from 
Trash" ch eckbox offer options for storing 
messages on the server and deleting them 
after a specified number of days. 

0 The "Send on check" checkbox controls 
whether Eudora sends outgoing messages 
w hen you check for new incoming mes
sages. I recommend you check it. 

0 The Save password checkbox controls 
whether Eudora remembers your pass
word or asks for it every time you check 
for new incoming messages. I recommend 
you check it. 

• The Authentication radio buttons control 
how Eudora proves to your POP server 
that you are who you say you are. Leave 
Passwords selected unless your Internet 
service provider or n etwork administrator 
tells you to select a different radio button. 

n z 
m 
n 
~ 
z 

" 
~ ,.. 
"' ~ 
z 

" "' ~ z 
m ,.. 



Chapter 12 

Sending Mail 
The Sending Mail settings panel (Figure 9 
and Figure 10) enables you w customize 
how Eudora sends messages. (See Chapter 4, 
"Sending and Receiving Messages") 

Settings 

U The Return address and SMTP server fields 
match the fields with the same names in 
the Getting Started, Personal Information, 
and Hosts settings panels. 

U The Immediate send checkbox controls 
whether Eudora sends messages 
immediately or queues them. I strongly 
recommend you uncheck this checkbox 
so Eudora queues messages. 

U The "Send on check" checkbox is dupli
cated from the Checking Mail settings 
panel. Leave it checked. 

U In the Mac versions. the Fix curly quotes 
checkbox tells Eudora to translate charac
ters like curly quotes into more common 
characters like straight quotes for accurate 
transmission. Leave it checked. 

• In Eudora Pro, all new messages can use a 
specific piece of stationery. 

U In the Mac version of Eudora Pro, check 
the Expand nicknames immediately 
checkbox to replace nicknames with their 
associated email addresses. 

The Windows version puts this checkbox 
in the Miscellaneous settings panel. 

U The message content checkboxes and 
menus: Word wrap, May use quoted
printable, Tabs in body of message 
(Windows) , Keep copies of outgoing 
mail, and Signature set defaults for the 
outgoing message toolbar menus and 
buttons. I recommend using the defaults. 
(See Chapter 3, "Writing Messages") 
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Figure 9 Use the Sending Mail settings panel in the 
Mac versions of Eudora to customize how Eudora 
sends messages. 

Figure I 0 Use the Sending Mail settings panel in the 
Windows versions of Eudora to customize how Eudora 
sends messages. 
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Figure I I Use the Attachments settings panel in the 
Mac versions of Eudora to set Eudora's default encoding 
format for outgoing attachments and location for 
incoming attachments. 
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Figure 12 Use the Attachments settings panel in the 
Windows versions of Eudora to set Eudora's default 
encoding format for outgoing attachments and location 
for incoming attachments. The Attachment directory 
button is blank because Eudora uses the Attach folde r 
by default. 

Working with Settings/Options 

Attachments 
The Attachments settings panel (Figure 11 
and Figure 12) lets you set Eudora's default 
encoding format for outgoing attachments 
and where incoming attachments should be 
stored. (See Chapter 3, "Writing Messages") 

Settings 

u The Encoding method radio buttons set 
the default encoding format for outgoing 
attachments. In general, leave the Mac ver-
sions of Eudora set to AppleDouble and 
leave the Windows versions set to MIME. 

u In the Mac versions, the "Always include > 
Macintosh information" makes Eudora ~ 
send file type and creator information n 
with the attachment. Leave it checked. 
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enables you to select an alternate location '" I'"' 
for received attachments. It defaults to the 
Attachments (Mac) or Attach (Windows) 
folder in your Eudora Folder. 

• In the Mac versions, the "Trash attach-
ment~ with messages .. checkbox makes 
Eudora move attachment flles to the 
Finder's Trash when you move a message 
to the Trash mailbox. 

In the Windows versions, the "Delete 
attachments when emptying Trash" 
checkbox deletes attachment flles when 
you empty the Trash mailbox. 

• In the Mac versions, the "TEXT flles 
belong to" button lets you set which 
application opens text file attachments. 
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Fonts & Display 
The Fonts & Display settings panel (Figure 13 
and Figure 14) controls Eudora's interface. 

Settings 

D The Screen and Print font and size 
controls (a menu and field in the Mac 
versions; a button that opens a Font 
dialog box in the Windows versions) 
enable you to set the font and size used 
for viewing messages. 

• The Mac versions of Eudora enable you to 
pick the text and background colors from 
a color wheel. I still like black and white. 

• The Message window width and Message 
window height fields enable you to set the 
size of message windows in characters 
(width) and lines (height) . 

D The "Zoom windows when opening" 
checkbox zooms windows to display as 
much content as possible. 

• In the Mac versions of Eudora, the "Waste 
cycles drawing trendy 3D junk" checkbox 
toggles between a 3D and 2D interface. 

• In the Mac version of Eudora Pro, the 
"Display graphics attachments inline" 
checkbox enables display of graphics in 
message bodies. 

D In the Windows versions, the Show tool
bar, Show toolbar tips, and Show status 
bar checkboxes control the main toolbar 
options. In the Mac version of Eudora Pro, 
the Show formatting toolbar checkbox 
toggles the formatting toolbar in outgoing 
message windows (the Tool bar settings 
panel handles the main toolbar options). 

• In the Windows versions, the Show cate
gory icons checkbox controls whether the 
settings panels list at the left of the 
Options dialog box has icons. 

Settings 
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Figure 13 Use the Fonts & Display settings panel in 
the Mac versions of Eudora to customize how Eudora 
displays text and windows. 

Figure 14 Use the Fonts & Display settings panel in 
the Windows versions of Eudora to customize how 
Eudora displays text and windows, along with toolbars. 
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Figure IS Use the Toolbar settings panel in the Mac 
version of Eudora Pro to control the display of the 
main toolbar. 

Working with Settings/Options 

Toolbar 
The Tool bar settings panel (Figure 15) con
trols the display of the main tool bar in the 
Mac version of Eudora Pro. (See Chapter 10, 
Working with theToolbar") 

Settings 

U The Show toolbar checkbox controls 
whether the toolbar displays. 

• The Orientation radio buttons control 
whether the toolbar displays horizontally 
or vertically. 

U The Button type radio buttons control 
how the buttons display. I recommend 
starting with icons and names, and work
ing your way down to only icons if you 
need the screen space. It can be hard to 
remember what functions map to specific 
icons without the names. 

• The "Map function keys to buttons" 
checkbox assigns the function keys at the 
top of your keyboard to different buttons. 

• The "Show function key labels" checkbox 
displays labels indicating which function 
keys m ap to which buttons. If you use the 
function keys, I recommend leaving this 
checkbox checked. 

v Tip 

• The Windows versions of Eudora have 
toolbars as well, but their controls are 
located in the Fonts & Display settings 
panel rather than in a separate Tool bar 
settings panel. 
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Chapter 12 

Eudora Labels/Labels 
The Eudora Labels (Mac) or Labels (Windows) 
settings panel (Figure 16 and Figure 17) 
enables you to name and color labels. 

Settings 

• To name any label, replace the text in the 
label name field with your desired name. 

• To change the color of a label, click the 
color button to the left of the label name 
field, then select a color from the color 
picker. 

II Tip 
• The Mac version of Eudora Pro provides 

eight labels, but those are in addition to 
the seven standard Macintosh labels set in 
the Labels control panel (available from the 
Control Panels folder in the Apple menu). 
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Figure 16 Use the Eudora Labels settings panel in the 
Mac version of Eudora Pro to create and modify labels 
beyond the basic seven provided by the Finder's Labels 
control panel. 

Figure 17 Use the Labels settings panel in the Windows 
version of Eudora Pro to create and modify labels. 
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Figure 18 Use the Getting Attention settings panel in 
the Mac versions of Eudora to control how Eudora 
alerts you to new messages and other interesting events. 

Figure 19 Use the Getting Attention settings panel in 
the Windows versions of Eudora to control how Eudora 
alerts you to new messages and other interesting events. 

Working with Settings/Options 

Getting Attention 
The Getting Attention settings panel 
(Figure 18 and Figure 19) controls how 
Eudora alerts you to new messages and other 
events of note. 

Settings 

• The Use an alert checkbox makes Eudora 
pop up an alert dialog box when you have 
new mail. I find it a pain. 

• The "Flash an icon in the menu bar" 
(Mac) checkbox makes Eudora flash an 
icon to alert you to new mail. 

g The Open mailbox checkbox tells Eudora 
to open mailboxes that contain new 
messages after checking for new mail. I 
often do this instead with filters so I can 
control which mailing list mailbox win
dows open. 

g The Play a sound checkbox and menu 
(Mac) or button (Windows) enables you 
to set Eudora to play a specified sound 
when you receive new mail or when 
Eudora needs your attention (Mac). 

g In the Mac versions of Eudora, check the 
"Say OK to alerts after 2 minutes" check
box to dismiss Eudora's alert dialog boxes 
after two minutes automatically. 

The Windows versions of Eudora have the 
same setting, but it's located in the 
Miscellaneous settings panel. 

• In the Windows versions of Eudora, check 
the Generate filter report checkbox to see 
a report of where Eudora has filtered mes
sages after processing them. 

The Mac versions of Eudora have the same 
setting, but it's located in the 
Miscellaneous settings panel. 
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Chapter 12 

Extra Warnings 
The Extra Warnings setting panel (Figure 20 
and Figure 21) lets you manipulate Eudora's 
"nag factor." I enjoy setting Eudora to warn 
me only about what I consider important 
events, rather than mere niggling details. 
Most of these settings are obvious, so I focus 
on a few that I think are important. I've used 
Mac checkbox names here, but the Windows 
checkbox names are extremely similar. 

Settings 

D I check "Try to queue a message with 
styled text" because I only occasionally 
want to send styled text. The warning 
gives me a chance to remove the styles. 
(See Chapter 3, "Writing Messages") 

D I check "Try to quit with messages queued 
to be sent" because I don't want to quit 
Eudora and forget to send messages that 
are waiting to go out. (See Chapter 4, "Sending 
and Receiving Messages") 

D I check "Try to send a message whose size 
is more than X K" because it can take a 
long time to send a large message and I 
may not want to wait for the message to 
go out at that moment. (See Chapter 4, 
"Sending and Receiving Messages") 

D I check "Empty the Trash mailbox" 
because I don't want to lose all the 
m essages in there accidentally. I delete 
messages from my Trash mailbox manu
ally. (See Chapter 6, "Working with Mailboxes") 

D I check "Try something that requires too 
much memory" (Mac) because it provides 
a chance to avoid an unnecessary crash. 

D I check "Start Eudora and it's not the 
default mailer" (Windows) because other 
email programs occasionally try to make 
themselves the default email program for 
Windows, and I hate that. 
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Figure 20 Use the Extra Warnings settings panel in the 
Mac versions of Eudora to fine-tune how often Eudora 
nags you. 
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Figure 2 1 Use the Extra Warnings settings panel in the 
Windows versions of Eudora to fine-tune how often 
Eudora nags you. 



Settings 

'<t .... ~ ·~~~~r .£ btn'W'art'l*"tf Repl'-ltOtll . 
~ Bvesefault (~neoptton ket.~ for M:nder ontv) 

U WDenopt1onl::e~t~bdovn 

l; OTIPPP ... M> Wl'lennplVff'ljltooll: 
0 Include y:'ltlrse\f 

~: ..... ~ ....... 18J Put ortqinel To· reclphnts in 

~ ,_...._. Ce· field, not To; field 

~Cop~Joriqir.l•spri:lritytoreplv 

IIJ s. .......... 
llB M<fl>oxC..._ 

Aj St\l)tdhxt 

~ ( concei J[JD} 

Figure 22 Use the Replying settings panel in the Mac 
versions of Eudora to control how Eudora replies to 
incoming messages. 

Concoll 

Figure 23 Use the Replying settings panel in the 
Windows versions of Eudora to control how Eudora 
replies to incoming messages. 

Working with Settings/Options 

Replying 
The Replying settings panel (Figure 22 and 
Figure 23) enables you to control how 
Eudora replies to incoming messages. 

Settings 

II In the Mac versions of Eudora, the Reply 
to all radio buttons control whether 
Reply to all is the default action or requires 
that Option be held down. I strongly rec
ommend you select the "When option 
key is down" radio button to make it 
more difficult to send replies to multiple 
people, which can prove embarrassing. 
Similarly, in the Windows versions of 
Eudora, leave unchecked the "Map Ctrl+R 
to Reply to All" checkbox. (Set Chapter 2, 
"Creating Messages") 

• The "When replying to all" checkboxes 
control whether you're included in a reply 
to all and where the original recipients' 
addresses go in the message header. 
Frankly, neither option matters much, but 
I usually uncheck Include yourself 

• The "Copy original's priority to reply" 
checkbox assigns the priority setting of 
the original message to your outgoing 
reply message. It simply ensures that if 
someone thinks a message deserves a spe
cific priority, the reply to that message 
shares the same priority level. 

• In the Windows version of Eudora Pro, 
the "Automatically Fcc to original mail
box" checkbox puts a copy of each reply 
in the same mailbox that contains the 
original message. The same checkbox 
appears in the Mac version of Eudora Pro 
in the Sending Mail settings panel. I've 
never seen the utility of it, personally. 
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Chapter 12 

OT/PPP and MacSLIP I 
Advanced NehNork 
The OT /PPP and MacSUP (Mac) (Figure 24) 
and Advanced Network (Windows) 
(Figure 25) settings panels simplify connect
ing if you have a dial-up connection to the 
Internet. The OT /PPP and MacSUP settings 
panel is only of use if your Mac connects 
to the Internet using Apple's Open Transport 
PPP or Hyde Park Software's MacSLIP.The 
Advanced Network settings panel's connec
tion options require that you've installed the 
dial-up networking services in Windows 95. 

Settings 

U In the Mac versions of Eudora, the "Don't 
make automatic checks when MacSUP or 
OT / PPP is not already connected" check
box prevents Eudora from checking mail 
automatically unless you're already con
nected to the Internet. This prevents 
Eudora from dialing your modem and 
connecting automatically. 

U In the Mac versions of Eudora, the 
"Disconnect MacSUP or OT / PPP if Eudora 
connected it" checkbox makes Eudora 
hang up the modem after checking for 
new mail only if an automatic mail check 
caused OT /PPP or MacSUP to connect to 
the Internet. I recommend you check this 
checkbox if you use OT / PPP or MacSUP 
and have Eudora check mail periodically. 

U In the Windows versions of Eudora, the 
"Automatically dial & hangup this con
nection" checkbox enables Eudora to con
nect to the Internet automatically to send 
and receive mail. Choose your Internet 
service provider from the Entry pop-up 
m enu and enter your username in the 
Username field. Check the Save password 
checkbox if you don't want to enter your 
password for every connection. 
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Figure 24 Use the OT/PPP and MacSLIP settings panel 
in the Mac versions of Eudora to control how Eudora 
makJs and breaks connections if you use OT/PPP or 
MacSLIP to connect to the Internet. 

Figure 25 Use the Advanced Network settings panel 
in the Windows versions of Eudora to control how 
Euddra makes and breaks Internet connections if you're 
using a dial-up connection to the Internet. 
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Figure 26 Use the Moving Around settings panel in the 
Mac versions of Eudora to determine how you navigate 
between messages in Eudora. 

Working with Settings/Options 

Moving Around 
The Moving Around settings panel 
(Figure 26) enables you to set how you 
navigate between messages in Eudora. 

Settings 

0 The "Arrow + these modifiers to switch 
messages" checkboxes enable you to pick 
which, if any, modifier keys work in con
junction with the arrow keys to switch 
between messages. 

0 The "After transferring or deleting or 
paging past end of current message, 
open" radio buttons enable you to decide 
what Eudora should open after you m ove 
past a message. I usually select Next 
unread message. 

• The "Tab to switch fields, option-tab to 
insert tab" checkbox controls whether 
pressing Tab inserts a tab or moves the 
insertion point between header fields. I 
don't use tabs in messages much, so I 
always leave this checkbox checked. 

• The "Return switches among header 
fields" checkbox enables you to decide if 
pressing Return in the header of a mes
sage should insert a Return character or 
move the insertion point to the next 
header field. Since there 's seldom any rea
son to insert a Return character in the 
header fields, I always leave this checkbox 
checked. 

II Tip 
• The Windows version of Eudora lacks a 

Moving Around settings panel but pro
vides much of the same functionality in 
the Miscellaneous settings panel. 
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Chapter 12 

Miscellaneous 
The Miscellaneous settings panel (Figure 27 
and Figure 28) contains, as you might 
expect, a hodgepodge of unrelated settings. I 
call out only those that I think are important 
below. Note that the Windows versions of 
Eudora include a number of important set
tings that appear elsewhere in the Mac ver
sions' settings panels-I've marked them 
with exclamation point graphics, but I won't 
discuss them again. 

Settings 

0 I leave the "Close messages with mailbox" 
checkbox unchecked because I like mes
sage windows to remain open when their 
mailboxes close. 

0 I leave the "Empty Trash on Quit" check
box unchecked because I prefer to keep 
messages in my Trash mailbox for a while. 
(See Chapter 6, "Working with Mailboxes") 

0 I check the "Turbo redirect by default" 
checkbox because it speeds up the process 
of redirecting messages. 

0 In the Windows versions of Eudora, 
I check the "Automatically open next mes
sage" checkbox because I find it makes 
reading mail go faster. 

D In the Windows versions of Eudora, I 
check the "Allow drag and drop transfers" 
checkbox. That's what the mouse is for, 
after all! 

D In the Windows versions of Eudora, 
I check the "Intercept Netscape mailto 
URI.s" checkbox because I want to use 
Eudora for all my messages, even if I'm 
using Netscape Navigator or 
Communicator to browse the Web. 
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Figure 27 Use the Miscellaneous settings panel in the 
Mac versions of Eudora to control a wide variety of 
unrelated settings. 
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Figure 28 Use the Miscellaneous settings panel in the 
Windows versions of Eudora to control a wide variety 
of unre lated settings. 
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Figure 29 Use the Settings Icons settings panel in the 
Mac versions of Eudora to pick the display style of the 
scrolling list in the Settings dialog box. 

Working with Settings/Options 

Settings Icons 
The Settings Icons settings panel (Figure 29) 
enables you to pick the display style of the 
scrolling list in the Settings dialog box. 

Settings 

• The Icon sizes radio buttons let you pick 
whether Eudora should display the set
tings panel list with big icons with names, 
big icons only, small icons with names, or 
names only. I prefer small icons with 
names, because there are too many set
tings panels to scroll through easily with 
big icons showing. 

V' Tip 

• The Windows version of Eudora lacks a 
Settings Icons settings panel but provides 
a Show category icons checkbox in the 
Fonts & Display settings panel. Checking 
that checkbox displays icons for each set
tings panel, rather than just the name. 
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Chapter 12 

Mailbox Columns 
The Mailbox Columns settings panel 
(Figure 30 and Figure 31) enables you to 
pick which columns should display in mail
box windows. Since I have large monitors, I 
leave all columns showing, but if you're tight 
for space, you might want to turn some off. 

Settings 

• The Show columns checkboxes determine 
which columns will display in mailbox 
windows. Check a checkbox to display 
that column. 

• In the Mac versions of Eudora, you can 
uncheck the Draw separator lines check
box to prevent Eudora from drawing 
separator lines between message sum
maries and mailbox columns. Personally, 
I like them . 

V' Tip 
• Eudora Pro provides two additional 

columns beyond those offered by Eudora 
light: Label and Server status. 
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Figure 30 Use the Mailbox Columns settings panel in 
the versions of Eudora to determine which 

display in mailbox windows. 

Figure 31 Use the Mailbox Columns settings panel in 
the Windows versions of Eudora to determine which 
columns display in mailbox windows. 
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Figure 32 Use the Styled Text settings panel in the Mac 
versions of Eudora to control how Eudora displays 
incoming messages containing styled text and, in Eudora 
Pro, whether to send outgoing messages with styled text. 

Figure 33 Use the Styled Text settings panel in the 
Windows versions of Eudora to control how Eudora 
displays incoming messages containing styled text and, 
in Eudora Pro, whether to send outgoing messages 
with styled text. 

Working with Settings/Options 

Styled Text 
The Styled Text settings panel (Figure 32 and 
Figure 33) controls how Eudora displays 
received messages containing styled text. In 
addition, in Eudora Pro, the Styled Text set
tings panel enables you to decide whether to 
send messages with styled text. 

Settings 

• In the Mac version of Eudora Pro, you can 
check the Show formatting toolbar check
box to display the formatting toolbar in 
outgoing message windows. 

II The controls for sending messages with 
styled text enable you to either send the 
styles or discard the style information in 
outgoing messages. I let Eudora Pro send 
styled messages but set it to prompt me 
first, so I can decide on a per-message 
basis if I actually want to send styles. 

II The "When receiving styles, pay attention 
to" checkboxes determine which styles 
Eudora displays in message windows. 
Check a checkbox to display that style if 
it's present in an incoming m essage. I 
leave all of these checked, just in case 
someone sends a heavily styled message. 

181 



~ s 
~ 
:::i 
< z 
0 
Ill 
a:: 
1&.1 c. 
Q 
z 
< 
Ill 
1&.1 

E ... 
< z 
0 
Ill a:: 
1&.1 c. 

Chapter 12 

Personalities and 
Personality Extras 
The Personalities and Personality Extras (Mac) 
settings panels (Figure 34, Figure 35 , and 
Figure 36) enable you to create, modify, and 
delete personalities. Personalities are usually 
used to manage email on multiple accounts , 
but more generically, they are collections of 
settings that apply to outgoing messages. 

Settings 

0 To switch between personalities, choose 
one from the pop-up Personality menu. 

0 To create a new personality, click the New 
button. Then fill in all desired fields in the 
Personality and Personality Extras (Mac) 
settings panels. 

0 To remove a personality, choose it from 
the pop-up Personality menu, then click 
the Remove button. 

V' Tips 

• The settings in the Personalities and 
Personality Extras (Mac) settings panels 
duplicate many of those we've already 
looked at in this chapter. Flip back for 
information on specific fields and 
check boxes. 

• Personalities are especially useful if you 
have multiple email accounts. You can 
create a personality for each account and 
have Eudora Pro check each account regu
larly. In addition, when creating messages, 
you can decide w hich personality a mes
sage should be from. (See Chapter 3, "Writing 
Messages") 
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Figure 34 Use the Personalities settings panel in the 
Mac versions of Eudora to enter basic information for 
alternate personalities. 
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Figure 35 Use the Personality Extras settings panel in 
the Mac versions of Eudora to customize additional 
settings for alternate personalities. 

Figure 36 Use the Personalities settings panel in the 
Windows versions of Eudora to enter basic 
information for alternate personalities. 



Figure 3 7 Use the Spell Checking settings panel in the 
Windows version of Eudora Pro to control how 
Eudora Pro checks the spelling of message text. 

Working with Settings/Options 

Spell Checking 
The Spell Checking settings panel (Figure 3 7) 
enables you to control precisely how Eudora 
Pro checks the spelling of m essage text. You 
can also change most of these settings by 
clicking the Options button in the Check 
Spelling dialog box. (See Chapter 3, "Writing 
Messages") 

Most of the options in the Spell Checking 
settings panel are obvious; I call out only the 
interesting ones below. 

Settings 

U I check the Ignore original text checkbox 
because it's too time-consuming to check 
other people's writing when replying to 
their messages. 

U If you're truly concerned about your 
spelling, check the "Check when message 
queued/ sent" checkbox to check every 
message before it goes out. 

V'Tip 
• The Mac version of Eudora Pro has no 

equivalent Spell Checking settings panel, 
but you can set similar preferences by 
choosing Preferences from the File menu 
when the spell checking window is open. 
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INDEX 
A 
about 

the address book 13 3 
attachments 53 
filters Ill 
message plug-ins 38 
Ph and Finger servers 15 5 
signatures 49 
the toolbar 145 

activating fllters 11 7 
adding toolbar buttons 149 
address book 133-143 

adding names to messages 13 8 
addressing messages 

from alternate email 3 3 
to multiple recipients 3 2 
to recipient list 25 

introducing the 13 3 
multiple nicknames files 13 9 
nicknames 

adding to recipient list 14 2 
creating 134, 135 
deleting 14 2, 143 
finding 140 
modifying 141 
tips for 136 

toolbar button for 148 
using the Address Book window 13 7 

Address Book window 
collapsing and expanding the 1 3 7 
creating nicknames 134, 13 5 
keeping in front 1 3 8 

aliases (Macintosh) 
configuring Eudora for multiple 

people 8 
creating 6 
for mailboxes 1 0 7 

America Online attachments 56 
AppleSingle encoding format 

(Macintosh) 56 
AppleDouble encoding format 

(Macintosh) 56 
archiving messages 1 08 
attachments 

about 53 
changing format for 57 
copying (Macintosh) 88 
deleting 89, 167 
moving 88 
opening 87 
selecting formats for 56 
text files as 3 6 
via dialog boxes 54 
via drag and drop 55 
with voice recordings 59 

Attachments settings panel 169 

B 
BinHex encoding format 56 
Blah button 8 1 
boilerplate messages 27-29 
boring headers 81 
buttons 

adding toolbar 149 
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Index 

buttons (continued) 

c 

changing functions of 154 
deleting on tool bar I 53 
ideas for toolbar 15I 
moving on tool bars 15 2 
for outgoing message tool bar 58 
toolbar, illustrated 148 

case plug-ins 38 
Change Queueing dialog box 63, 64 
changing 

message labels 7 7 
message personality 7 9 
message priority 7 6 
message status 7 8 
message text 80 

Check Mail 66, 71 
Check Mail Specially 7 1 
Check Spelling dialog box (Windows) 40 
Checking Mail settings panel 7, I6 7 
checking messages 

incoming 66, 67 
for Power Book users 6 7 
retrieving messages by size 7 0 
for spelling 3 9-4I 

Clear Formatting button 48 
closing mailbox folders 102 
Compact Mailboxes (Windows) I06 
compacting mailboxes I 06 
configuring Eudora 7-1 0 
conflicts with nicknames 14I 
Contains pop-up menu 115 
contextual help 1 2 
Copy and Unwrap 3 7 
copying attachment files (Macintosh) 88 
creating 

aliases (Macintosh) 6 
buttons to open mailboxes 149, 15 0 
clippings files 90 
filters 1I2 
group nicknames 13 5 
mailbox folders I 00, 101 
mailboxes 97, 99 
messages 17-19 
multiple nickname files 139 

186 

creating (continued) 
nicknames for individuals 
pane interface (Windows) 
shortcuts (Windows) 6 
stationery messages 27-28 
To and Subject lines 18 
and using signatures 50 

134, 159 
83 

custom signatures 51 
Customize Tool bar dialog box 

(Windows) 15 0 

D 
decoding plug-ins 38 
defaults 

for attachment formatting 57 
Reply to All 21 
for sorting messages 96 
for toolbar buttons 148 

Delete attachments when emptying Trash 
checkbox 89, 167 

Delete from server after X days checkbox 69 
Delete Mailbox button (Macintosh) 105 
deleting 

attachments 8 9, 16 7 
buttons on tool bar 15 3 
filters 122 
mailbox folders 1 0 5 
messages 69, 70, 71,85 
nicknames 142, 143 

dial-up connection settings 176 
directory services 15 5-1 61 

about Ph and Finger 155 
online directories on the Web 161 
searching 

a Finger server 160 
for names on a Ph server 15 8 

selecting Ph servers 15 7 
setting up Ph and Finger servers 15 6 
using search results from Ph server 15 9 

disk space 
compacting mailboxes 1 0 6 
recovering by emptying Trash 

mailbox 109 
Don't Send radio button 65 
Don't transfer, just create mailbox checkbox 

(Windows) 1 00 



downloading Eudora 3 
drag and drop attachments 55 
dragging messages to another mailbox 98 

E 
editing 

signatures 52 
text 37 

email. See messages 
email glossary I4-I 6 
encoding 

formats for 56 
plug-in for 38 

Encoding format menu 57 
encrypting and decrypting messages 60 
etiquette for redirecting messages 23 
Eudora 

address book 13 3-I43 
configuring 7-1 0 
controlling interface for 1 7 0 
creating messages 1 7-1 9 
directory services IS 5-I6I 
filters I 1 I-I 2 2 
getting software 3 
getting started 1-I 6 
glossary feature I 3 6 
hardware and software 

requirements 2, II 
installing 

for Macintosh 4 
for Windows 5 

launching and quitting 6 
mailboxes 93-I 09 
newsgroups and Web sites for 13 
printing windows from 9I 
settings and options for I63-I83 
toolbar I45-I54 
See also Eudora Pro; messages 

Eudora 1.3.1 2 
Eudora Labels settings panel 

(Macintosh) I 7 2 
Eudora Light 3 

·Eudora Pro 
adding button to toolbar I49, ISO 
adjusting font sizes, styles, and 

color 44-46 

Index 

Eudora Pro (continued) 
changing 

button functions I 54 
fonts for 43 
indents 48 

choosing a personality 3 3 
configuring for multiple accounts 1 0 
creating 

multiple nicknames files I 3 9 
and replying with stationery 

messages 27-29 
deleting buttons on tool bar IS 3 
Eudora Labels settings panel 

(Macintosh) 1 7 2 
formatting messages 4 2 
getting software for 3 
ideas for buttons on toolbar ISI 
justifying 47 
removing sorting from (Macintosh) 96 
special mail transfer options 7 I 
spell checking 3 9-4I 
Spell Checking settings panel 

(Windows) 18 3 
Tool bar settings panel (Macintosh) 1 71 
See also Eudora 

expanding and collapsing the Address Book 
window I37 

Extra Warnings settings panel 1 7 4 

F 
Fetch button 7 0 
files 

attaching 54, 55 
attachments as text 3 6 
copying attachment (Macintosh) 88 
creating clippings 90 
nicknames I3 9 
table of contents 1 0 6 

fllters II1-I22 
activating 11 7 
creating II 2 
deleting 1 2 2 
examining header lines with 114 
finding (Macintosh) I19 
introducing 1II 
modifying 120 



Index 

filters (continued) 
reordering 1 2 1 
selecting 

actions for 1 1 6 
messages to filter 11 3 

setting search parameters for 115 
suggestions for using 118 

Find dialog box 
for Macintosh 124 
for Windows 1 2 5 

finding 
filters (Macintosh) 119 
nicknames 140 
text 123-131 

in a mailbox folder (Macintosh) 127 
in a mailbox (Macintosh) 1 2 6 
in a message 124, 125 
in message summaries 13 0 
in multiple mailboxes 

Macintosh 1 28 
Windows 129 

searching for names on a Ph server 15 8 
stopping a search 128, 129, 131 
tips and tricks for searching 13 1 
See aJso starting point 

Finger servers 
searching 1 60 
setting up 1 56 

fonts 
adding styles to 44 
adjusting sizes of 46 
changing 43 
changing colors of 45 

Fonts & Display settings panel 146, 147, 170 
formatting toolbar 48 
forwarding messages 2 2 
From line 19 
function keys (Macintosh) 1 7 1 

G 
Getting Attention settings panel 1 7 3 
getting started 1-1 6 

configuring 
Eudora 7, 8, 9 
Eudora Pro for multiple accounts 1 0 

email glossary 14-1 6 
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getting started (continued) 
Eudora news groups and Web sites 13 
getting software for Eudora Light and 

Eudora Pro 3 
hardware and software requirements 2 
installing Eudora 

for Macintosh 4 
for Windows 5 

launching and quitting Eudora 6 
online help 1 2 
RAM requirements (Macintosh) 11 

Getting Started settings panel 7, 164 
glossary 14-1 6 
glossary feature 1 3 6 
Group Subjects (Macintosh) 9 5 
Guess Paragraphs checkbox 9 0 

H 
hanging indents 48 
hard returns 3 7 
headers 

examining with filters 114 
for forwarded messages 2 2 
including when saving messages 90 
options for retrieving 71 
revealing 81 

help 
online 12 
for settings and options 163 
Web sites for 13 

Hosts settings panel 16 6 

I 
Include Headers checkbox 90 
indents 48 
installer 

for Macintosh 4 
for Windows 5 

ISPs (Internet Service Providers), preventing 
disconnects from 6 7 

K 
Keep Copies button 58 



keyboard shortcuts 

L 

for glossary feature 13 6 
for Mail1i'ansfer Options dialog box 71 
for selecting messages 7 4 
for sending queued messages 6 2 
See pull-out keyboard shortcuts page 

Labels settings panel (Windows) 1 7 2 
launching Eudora 6 
Leave mail on server checkbox 69 
leaving messages on the server 69 

M 
Macintosh 

adding button to toolbar 149 
aliased mailboxes and mailbox folders I 0 7 
changing button functions 154 
checking messages for PowerBook 

users 67 
configuring Eudora for two people 8 
copying attachment files 88 
creating 

aliases for users 6, 8 
clippings files 90 

encoding formats for 56 
finding 

information in Address Book 140 
text in mailbox folders 1 2 7 
text in multiple mailboxes 1 28 

Getting Started settings panel 1 64 
hardware and software requirements 

for 2 
installing Eudora for 4 
launching Eudora from 6 
message plug-ins for 3 8 
modifying filters 120 
Moving Around settings panel 1 7 7 
Nuke 85 
Personal Information settings panel 165 
RAM requirements for 11 
removing sorting from Eudora Pro 96 
replying to part of a message 2 0 
resetting the starting point 1 3 1 
searching for names on a Ph server 15 8 

Macintosh (continued) 
selecting color for text 1 7 0 
setting toolbar options in 170, 171 
Settings Icons settings panel 17 9 
spell checking 3 9, 41 

Index 

switching back to previous Ph server 15 7 
toggling balloon help on and off 1 2 
unwrapping quoted text 3 7 

Macintosh Info button 58 
Mail Transfer Options dialog box 71 
Mailbox Columns settings panel 180 
mailbox folders 

creating 
in Mailboxes window 1 0 1 
from menus 1 00 

deleting 1 0 5 
finding text in (Macintosh) 127 
opening and closing 1 02 
renaming 103 
reorganizing 1 04 

Mailbox menu 97 
mailboxes 93-109 

aliases (Macintosh) 1 0 7 
archiving messages 108 
compacting 1 06 
creating 97 

buttons to open 149, 150 
during a message transfer 99 
mailbox folders 1 0 0, 1 0 1 

deleting 105 
finding text in (Macintosh) 126 
opening 94 
renaming 1 03 
reorganizing I 04 
searching for text in multiple 

Macintosh 128, 131 
Windows 129 

sorting messages in 9 5, 9 6 
transferring messages into 98 
Trash 109 
See also mailbox folders 

Make Address Book Entry 134, 135 
Make Address Book Entry dialog box 

(Windows) 134 
Make it a folder checkbox I 00, I 0 I 
"me" nickname I36 
message labels 7 7 
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Index 

Message Options dialog box 3 3 
message plug-ins 38 
message priorities 7 7 
messages 1 7-7 1 

about 
attachments 53 
message plug-ins 3 8 

adding nicknames to 13 8 
archiving 108 
changing 

incoming message text 80 
message labels 7 7 
message personality 7 9 
message pnonty 7 6 
message status 7 8 

choosing a personality 3 3 
creating 1 7-19 
deleting 

attachments 89, 167 
messages 85 

fmding text in 
Macintosh 1 2 4 
Windows 125 

forwarding 2 2 
indicators for unread 94 
moving attachments 8 8 
navigating 

between 83 
within 82 

opening 
attachments 8 7 
messages 75 

printing 91 
redirecting 2 3 
replying 

to messages 1 9-2 1 
with stationery messages 27-29 

resending 2 4 
revealing headers 8 1 
saving messages 90 
selecting 7 4 
sending and receiving 61-71 

checking for incoming messages 66, 67 
deleting on the POP server 69 

190 

at later date or time 64 
leaving messages on the server 
messages left on the POP server 

68,69 
68 

messages, sending and receiving (continued) 
preventing messages from being 

sent 65 
retrieving and deleting messages by 

size 70 
sending messages immediately 53, 63 
sending messages later 64 
sending queued messages 6 2 
special mail transfer options 7 1 

sorting in mailboxes 9 5 
transferring to mailboxes 86, 98 
using the recipient list 25 
using Turbo Redirect 26 
visiting URLs from 84 
writing 

addressing 3 2 
adjusting font colors, sizes, and 

styles 44-46 
attaching files 54, 55 
changing fonts for 43 
changing indents 48 
changing justification of 47 
editing text 3 7 
encrypting with PGP plug-in 60 
entering a subject 34 
entering text 3 6 
formatting text for 4 2 
outgoing message tool bar buttons 58 
outgoing message toolbar menus 57 
Pure Voice plug-in 59 
selecting attachment formats 56 
spell checking 3 9-41 
text selection and navigation 3 5 
using signatures 49-5 2 

See also attachments; queued messages; 
quoted messages 

messages summaries 13 0 
MIME encoding format 56 
Miscellaneous settings panel 1 7 8 
modifying 

filters 120 
nicknames 141 

mouse 35 
moving 

attachments 88 
buttons on tool bars 1 52 
nicknames between files 13 9 



Moving Around settings panel 
(Macintosh) 1 7 7 

multiple accounts 
configuring Eudora for 1 0 
sending mail to 18 

multiple nicknames files 1 3 9 

N 
navigating 

between messages 8 3 
through text 3 5 
within messages 8 2 

New Mailbox dialog box 97 I 99 
New Message 18 
New Nickname dialog box 

(Macintosh) 1341 135 
newsgroups and Web sites 13 
nickname list 13 7 
nicknames 

adding 
to messages 13 8 
to recipient list 14 2 

conflicts with 141 
creating 

from a Ph search 15 9 
group 135 
for individuals 134 

deleting 142 1 143 
dragging to address lines 3 2 
finding 140 
modifying 141 
tips for creating and using 13 6 

nicknames files 13 9 
Nicknames Folder 13 9 
Nuke (Macintosh) 85 

0 
online resources 

help 12 
Web directories 161 

Open mailbox checkbox 94 
Open Next Message button (Windows) 83 
Open Previous Message button 

(Windows) 8 3 

Index 

opening 
attachments 8 7 
mailbox folders I 02 
mailboxes 94 
messages 75 

Options dialog box (Windows). See 
Settings/ Options dialog box 

OT /PPP and MacSUP I Advanced Network 
settings panels I 7 6 

Out mailbox 26 
outgoing message tool bar menus 57 

p 
Paste As Quotation 3 6 
Personal Information settings panel 165 
personalities 

choosing 33 
selecting 71 
sending mail to I 8 
setting up in Macintosh 1 0 

Personalities settings panel 1 0 I 1 8 2 
Personality Extras settings panel 182 
PGP (Pretty Good Privacy) plug-in 60 
Ph servers 

searching for names on 158 
selecting 1 57 
setting up and choosing 15 6 
using search results from 15 9 

plug-ins 
message 38 
PGP 60 
Pure Voice 59 

POP account 
in Checking Mail settings panel 1 6 7 
entering 7 
in Getting Started settings panel 164 
in Hosts settings panel 166 
in Personal Information settings 

panel 165 
POP server 

leaving or retrieving mail on 69 
messages left on 68 

preventing 
disconnects from ISPs 6 7 
messages from being sent 65 

Print dialog box 91 
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Index 

printing messages 91 
Priority menu · 57 
Progress dialog box 

retrieving messages from SMfP server 
and 62 

sending queued messages and 6 2 
stopping a search in the 129 

purchasing Eudora Pro 3 
Pure Voice plug-in 59 

Q 
Qualcomm Web site I 2 
question mark button (Windows) 163 
queued messages 

changing queueing for postponed 
messages 64 

preventing messages from being sent 65 
sending 62, 63 
warnings for I7 4 

quitting Eudora 6 
quoted messages 

in forwarded mail 2 2 
pasting in text 3 6 
replying with selections of 

(Macintosh) 20 
Quoted-Printable button 58 

R 
RAM requirements (Macintosh) 11 
Real name field 

in Getting Started settings panel 164 
in Personal Information settings 

panel 165 
receiving messages. See sending and receiving 

messages 
recipient list 

adding nicknames to I4 2 
addressing messages to 25 

recipients 
addressing messages to multiple 3 2 
replying to all 2 1 
using list of 25 

Redirect To menu (Windows) 2 6 
redirecting messages 2 3 

Turbo Redirect 26 
reminders 64 
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removing sorting from Eudora Pro 96 
renaming mailbox folders 1 03 
reordering filters 1 2 1 
reorganizing mailbox folders I 04 
Reply 19 
Reply Quoting Selection (Macintosh) 20 
Reply to All 2 1 
replying 

to all recipients 21 
to messages 19 
to part of a message (Macintosh) 20 
setting options for 1 7 5 

Replying settings panel I 7 5 
resending messages 24 
retrieving messages by size 7 0 
Return address field 

in Getting Started settings panel 1 64 
in Personal Information settings 

panel 165 
in Sending Mail settings panel 168 

Return Receipt button (tool bar) 58 
revealing headers 81 
Right Now radio button 63. 
Rot13 Text plug-in (Macintosh) 38 

s 
SaveAs 27 
saving messages 18, 19, 90 
Screen and Print font and size 

controls 1 7 0 
searching text. See fmding text 
security 60 
selecting 

actions for filters I16 
messages 74 
messages to filter 11 3 
words and paragraphs 3 5 

Send Again 24 
Send on check checkbox 6 7 
Send Queued Messages 6 2 
Sender column 130 
sending and receiving messages 6I-7I 

checking incoming messages 66, 67 
leaving messages on the server 69 
messages left on the POP server 68 
preventing messages from being sent 65 



sending and receiving messages (continued) 
retrieving and deleting messages by 

size 70 
sending 

messages later 64 
messages now 53, 63 
queued messages 6 2 

special mail transfer options 7 1 
Sending Mail settings panel 7, 168 
settings and options 163-183 

Attachments settings panel 169 
Checking Mail settings panel 16 7 
Eudora Labels/Labels settings panel 172 
Extra Warnings settings panel 1 7 4 
Fonts & Display settings panel 1 7 0 
Getting Attention settings panel 1 7 3 
Getting Started settings panel 164 
Hosts settings panel 166 
Mailbox Columns settings panel 180 
Miscellaneous settings panel 1 7 8 
Moving Around settings panel 

(Macintosh) 177 
OT /PPP and MacSUP I Advanced Network 

settings panels 1 7 6 
Personal Information settings panel 165 
Personalities and Personality Extras settings 

panels 182 
Replying settings panel 1 7 5 
Sending Mail settings panel 168 
Settings Icons settings panel 

(Macintosh) 179 
Spell Checking settings panel 

(Windows) 183 
Styled Text settings panel 181 
Tool bar 

Macintosh 147, 171 
Windows 147, 170 

Settings dialog box (Macintosh). See 
Settings/ Options dialog box 

Settings Icons settings panel 
(Macintosh) 179 

Settings/ Options dialog box 
checking for mail periodically 6 7 
Delete attachments when emptying Trash 

checkbox (Windows) 89, 167 
Delete from server after X days 

checkbox 69 

Index 

Settings/ Options dialog box (continued) 
Getting Started settings panel 7, 1 64 
Leave mail on server checkbox 69 
Open mailbox checkbox 94 
replying to all recipients 2 1 
Screen and Print font and size 

controls 1 7 0 
Send on check checkbox 6 7 
Show toolbar checkbox 146 
Trash attachments with messages checkbox 

(Macintosh) 89 
Word wrap option 168 
See also settings and options 

shortcut keys. See keyboard shortcuts 
shortcuts (Windows) 

creating Eudora 6 
for multiple users 9 

Show toolbar checkbox 146 
signatures 

about 49 
creating and using 50 
custom 51 
editing 52 
selecting 57 

Signatures menu 51, 57 
Skip messages over X K checkbox 7 0 
SMTP server 

as default Finger server 1 56 
entering information for 7, 166, 168 
setting for Eudora Pro 1 0 

software for Eudora Light and Eudora Pro 3 
Sort 95, 96 
sorting messages 

in mailboxes 9 5 
methods for 9 6 

spaces 
converting to tabs 3 8 
in nicknames 13 6 

spam filters 118 
special mail transfer options 71 
spell checking 3 9-41 

for Macintosh 3 9 
options for 41 
toolbar button for 148 
for Windows 40 

Spell Checking settings panel 
(Windows) 183 
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Index 

starting point 
with multiple mailboxes 

(Macintosh) 1 2 8 
resetting before retrying searches 

(Macintosh) 131 
setting for searches (Macintosh) 126 

stationery messages 2 7-2 9 
styled text 1 7 4 
Styled Text settings panel 181 
Subject line 

creating messages and 18 
entering a 34 
replying to messages and 1 9 

Summaries only checkbox 13 0 
switching between messages 8 3 

T 
table of contents files 1 0 6 
tabs 

converting to spaces 3 8 
options for in body of message 58, 168 

Tabs in Body button 58 
text 

editing 37 
entering 36 
formatting 4 2 
justifying 47 
pasting quotations in 3 6 
removing styled 1 7 4 
selecting and navigating through 3 5 
selecting color for (Macintosh) 1 7 0 
tips and tricks for finding 13 1 
wrapping and unwrapping 3 7 
See also finding text; fonts 

Text as Attachment button 58 
text flles 3 6 
To line 

creating messages and 18 
replying to messages and 19 

toolbar 145-154 
buttons 
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adding 149, 150 
changing functions for 154 
default 148 
deleting 1 53 
ideas for 1 5 1 

toolbar, buttons (continued) 
moving 152 

introducing the 14 5 
menus for outgoing message 57 

settings 14 7 
for Macintosh 1 7 0. I 7 1 
for Windows 1 7 0 

turning on and off 146 
Tool bar Button Creation dialog box 149, 

153 
Toolbar settings panel (Macintosh) 146, 

147,171 
Transfer menu 9 8 
transferring messages to mailboxes 86, 98 
Trash attachments with messages checkbox 

(Macintosh) 8 9 
Trash mailbox 1 09 
Turbo Redirect 2 6 
Turbo Redirect To menu (Macintosh) 26 
turning toolbar on and off 146 

u 
unread message indicator 94 
Unwrap Selection 3 7 
URls 

in messages 84 
selecting Ph server 1 57 

using filters 1 1 8 
Uuencode encoding format 56 

v 
VCR buttons (Macintosh) 126, 131 
voice messages 59 

w 
warnings 1 7 4 
Web sites 

downloading Eudora from 3 
for Eudora help 13 
online directories 1 61 
Qualcomm 12 

Whole word checkbox (Macintosh) 119 



Windows 
adding button to tool bar 15 0 
changing preferences for spell 

checking 41 
choosing stationery for messages in 2 8 
compacting mailboxes 1 06 
configuring Eudora for two people 9 
creating 

mailbox without transferring 
messages 1 00 

pane interface 8 3 
deleting attachments 8 9. 1 6 7 
encoding formats for 56 
Getting Started settings panel 164 
hardware and software requirements for 2 
installing Eudora for 5 
launching Eudora from 6 
message plug-ins for 38 
moving attachments for 88 
Personal Info settings panel 165 
reorganizing mailboxes and mailbox 

folders 104 
searching for text in multiple 

mailboxes 1 2 9 
selecting previously used Ph servers 

from 157 
setting toolbar options in 1 7 0 
spell checking 40 

Index 

Word Services window (Macintosh) 39 
Word Wrap button 58 
Word wrap option 168 
Wrap Selection 3 7 
wrapping and unwrapping text 3 7, 3 8 
writing messages 3 1-60 

addressing 3 2 
adjusting font colors, sizes, and 

styles 44--46 
attaching files 54, 55 
buttons for outgoing message tool bar 58 
changing 

fonts for 43 
indents 48 
justification of 4 7 

editing text 3 7 
encrypting with PGP plug-in 60 
entering 

a subject 34 
text 36 

formatting text for 4 2 
menus for outgoing message tool bar 57 
Pure Voice plug-in 59 
selecting attachment formats 56 
spell checking 3 9-41 
text selection and navigation 3 5 
using signatures 49-5 2 
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Keyboard Shortcuts 

Mac keyboard shortcuts Text formatting shortcuts 

Eudora has numerous keyboard shortcuts, l<?mdtB,, Ma1ce selected teJ(t_b~l~ 

listed below. However, you access many other lcmd}:-1 Make selected text:ittilit:·. 

less common functions by holding down ICmdtT . Make· selected text plaiJ:l · . 
Option or Shift and choosing a menu item or ICmd)-U · Make.selected.text undetlined 
clicking a button. Choose Shortcuts from the 

Message shortcuts Guide menu to see a list of them. Shortcuts 
unique to Eudora Pro are ·shaded. ICmd~D Delete 

Macintosh standard shortcuts ICmd~E Send or Queue current 

ICmd~. Stop current action 
message 

I Cmd H Option 1-E Change Queueing 
ICmd~O Open 

ICmd~N New Message 
ICmd~P Print 

ICmd~R Reply 
ICmdHShift~P Print Selection 

ICmdHShift~R Reply Quoting Selection 
ICmd~Q Quit 

ICmd~S Save Sending and receiving shortcuts 

I Cmd H Option ~S Save All ICmd~- Send Queued Messages 

ICmd~W dose I Ctnd HOption ~- Send Messages. SpedaJJr· 

I Cmd H Option~ W dose All ICmd~M Check Mail 

X ICmd~Z Undo ICmdHOption~M Check.~Sp~y _ ~-
- - - --- - - . - .. n 

Copying and pasting shortcuts Mailbox shortcuts ~ 

~ 
ICmd~A Select All ICmd~O Open the Out mailbox • ·o 
ICmd~C Copy ICmd~l Open the In mailbox ,. _,.. 

I Cmd H Option ~C Copy & Unwrap Address Book shortcuts 
a 

"' I Cmd H Shift ~c Copy Without Styles ICmdl-. Finish Address Book Entry 
:1: 
0 

I Cmd H Option H Shifti-C Copy Without Styles I Cmd H Option~, Finish & Expand Address = n &Unwrap Book Entry c: 
ICmd~V Paste ICmd~K Make Address Book Entry iii 
ICmdHShlft~V Paste Without Styles . ICmdHShift~K Make Address Book Entry 

ICmd~' Paste As Quotation from selection 

ICmd~X Cut ICmd~L Open Address Book window 

Finding and searching shortcuts Miscellaneous shortcuts 

ICmd~F Opens Find window ICmdt-6- CheckSpeJ1ing 

ICmd~G Find Again ICmd~\ Send to Back (a window) 

ICmd~= Enter Selection ICmd~H Attach Document 
(in Find window) ICmd~J Filter Messages 

ICmd~; Search Again ICmd~Y Open Directory Services 
window 



Keyboard Shortcuts 

Windows keyboard shortcuts 
Eudora has numerous keyboard shortcuts, listed 
below. However, you access many other less 
common functions by holding down Shift and 
choosing a menu item or clicking a button. For 
more information, choose Topics from the Help 
menu, then double-dick Modifiers or Shortcuts 
in the Reference section. Shortcuts unique to 
Eudora Pro are $h,a~~ 

Windows standard shortcuts 
I Ctrl ~0 Open Text File 

- .. . 

I Ctrl ~ P Print 

I Ctrl ~Q Quit 

I Ctrl ~S Save 

I Ctrl H Shift ~S Save All 

I Ctrl ~ W Close 

I Ctrl H Shift~ W dose All 
0 •o-•R <000 -~-- -- - ----

1 Ctrl ~z Undo 

Copying and p~~ng ~h~l!~~~ 
ICtri)-A 

ICtrll-C 

I Ctrl H Shift ~c 

lctrl ~v 

Select All 

Copy 

Copy & Unwrap 

Paste 

~~~~1l.i~~~I-Y. _ =---~~~~~~w~~~~~~~~~:~~:.~. -~~ 
ICtrl ~· Paste As Quotation 

ICirlHSbmP n~;;.~~!~ 
lctrl ~X Cut 

Sending and receiving shortcuts 
-- - -- -·- --- -~-- --- ·-- ·- ·---..'--~--- --~ ---

1 Ctrl ~M Check Mail 

tCtrl H.shlftl-M __ :~~-}~~,~~rr~~~~ :~:_1 
I Ctrl ~ T Send Queued Messages 

l~t_Bshi~~T ~-- .~~~~~~~~~,~--~ 
Mailbox shortcuts 
I Ctrl ~0 Open the _Out m~b_?~ _ 

I Ctrl ~ 1 Open the In mailbox 
- -- -- . 

Finding shortcuts 

l~t~I}F. .. ________ ~~-~~d ~~-<?~ 
lF~!J1~~}~ Find~g~--- _______ _ 
(~}[:f3 J/1 Ctrl ~= Enter Selection 

· · ·· -- (in Find window) 
- -·- --~----· -~----- ----·-

lctrl ~; Find Next Message 

Message shortcuts 
lctrl ~D 

ICtrll-E 

Delete 

Send or Queue current 
message 

lctrl HShlft~E Change Queueing 

ICtrl ~N New Message 

I~HSIIHI~llf. =~~~ 
lctrl ~R Reply 

L.ltt_ .. J-~. _-M~~~~p~§~~~Ji~ 
Text formatting shortcuts 
let@-B _-:~~~~~~~-- .. -

[~~~E!:; .:. c ...•...•... :~~-~~~~~~fc~:::.-:··: 
!-~~~i~li(: ,,_~ls~~l~~~~ 
Window management shortcuts 

- .. - ···- ·~ --- -¥-•---- -·~- --·-·· ·-·--·-¥·-

lS_h~~H~~ _I Tile Horizontal 

I ~~~~t~ ~-I Cascade 

~ Send to Back 

Address Book shortcuts 
letrl ~. 
-- -·· - -
I Ctrl H Shift~. 

Finish Address Book Entry 

Finish & Expand Address 
Book Entry 

I Ctrl ~K Make Address Book Entry 

I Ctrl ~L Open Address Book window 

Miscellaneous shortcuts 
lOtti~h~--- : . -.. 'qiE~fi-.S~~·~, - - ·--- -

I Ctrl ~H Attach Document 

I Ctri_H Filter Messages 

I Ctrl ~ Y Open Directory Services 
window 
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